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About this Guide 
This guide will assist you in setting up PrintSmith™. The recommendations in this guide 
represent one of many correct ways to set up and use PrintSmith. 

Most of the setup process depends on your pricing theories and methods. PrintSmith 
supports many pricing methods that can help you price to your marketplace. The goal of 
this guide is to help you set up PrintSmith for use in your business. 

PrintSmith setup takes approximately 40 hours. You can improve this time with automated 
input of your customer names, addresses, account balances, and other information. If you 
have your customer information in a computer database, EFI may be able to import that 
data for you with a tab-delimited ASCII file of that information. Call EFI for pricing and 
turnaround time. 

You should plan on several 3-4 hour setup sessions and the completion of at least one 
major task per session. 

The tasks that you must accomplish are: 

• Set up users so they can use the system (see page 15). 

• Set system defaults such as preferences (see page 27). 

• Define pricing—charges, press definitions, copier/digital definitions, and stocks 
(see page 105). 

• Enter customer information (see page 219). 

• Go “live” with PrintSmith. 
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Contact Information 
You can contact PrintSmith Customer Support in any of the following ways.  

Phone 

North America 

888.731.2618 
480.538.5800 
Monday - Friday 7 A.M. - 5 P.M. US Mountain Standard Time 

UK 

0800 783 2737 
Monday - Friday 8 A.M. - 5 P.M. UK Time 

EMEA 

+49 2102 745 4500 
Monday - Friday 9 A.M. - 6 P.M. Central European Time 

Fax 

480.538.5804 (North America) 

E-Mail 

North America 

Printsmith.service@efi.com 

EMEA 

Europe_support@efi.com 

Additional Sources 
For information about See 

Installing PrintSmith PrintSmith Installation and Upgrade Guide 
Credit card processing in PrintSmith PrintSmith Secure Credit Card Processing Guide 
All PrintSmith features PrintSmith Reference Guide 
PrintSmith Site PrintSmith Site Administrator Guide 

Installing PrintSmith 
PrintSmith installation should take just a few minutes. For information, see the PrintSmith 
Installation and Upgrade Guide. This manual assumes that PrintSmith is already installed. 

mailto:Printsmith.service@efi.com�
mailto:Europe_support@efi.com�
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If You Are Using Windows Vista 
If you are running PrintSmith on Windows Vista, you must complete some additional tasks  
and understand how Vista uses a virtual folder, as described in the PrintSmith Installation 
and Upgrade Guide. Be sure you understand how the PrintSmith folder is handled under 
Vista. 

Creating Shortcuts/Aliases 
There should only be one PrintSmith application on your hard disk. If you would like to 
start PrintSmith from another place on your computer, create an alias (on the Macintosh) 
or a shortcut (in Windows). 

Use these procedures to put aliases or shortcuts wherever you find it convenient. To start 
PrintSmith, simply double-click the application, the alias of the application, or the shortcut 
to the application.  

Caution  Never move the application from the PrintSmith folder. If you need or want it 
elsewhere, always create an alias or shortcut. 

Creating a Macintosh alias 
1. Select the PrintSmith application by clicking it once. 

2. On the File menu, click Make Alias. A file with the same name as the PrintSmith 
application is created with the word alias after the name. Also note that the name 
of the file is in italics. 

3. Drag the alias icon where you want it: Desktop, Apple Menu Items, or Launcher. 
(Avoid placing the alias in the Startup folder.) 

Creating a Windows shortcut 
1. In the PrintSmith folder, right-click the PrintSmith application (PrintSmith.exe) and 

choose Create Shortcut. 

2. Drag the shortcut icon to the location you want, for example, your desktop. 

3. (Optional) Edit the name of the shortcut. 

Tip During PrintSmith installation, PrintSmith is added to the Windows Start menu: 
Start > Programs > PrintSmith. 
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Starting PrintSmith 
1. Double-click the PrintSmith Application  icon in the PrintSmith folder or 

double-click your PrintSmith alias or shortcut (if you created one). Following a 
splash screen, the PrintSmith Log In window opens. 

 
Note  If you receive a message about PrintSmith shutting down in some 

number of days, either the hardware security key is not installed 
properly, or you are using beta or demo software.  

2. Leave the User Name and Password fields blank. PrintSmith ships with a 
disabled security system. Initially, you are not required to enter a user name and 
password. As part of the setup, you enable the security system, restricting the 
ability to access PrintSmith without entering a user name and password. (For 
more information, see “Users and Access to PrintSmith” starting on page 15.) 

3. Click OK to start PrintSmith. The PrintSmith menus are displayed at the top of 
the window. 
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The QuickAccess Panel also opens. This panel gives you access to key PrintSmith 
features without having to choose commands from menus. For more information, see 
page 22. 

 
Note You may get a message about the last time you performed a daily closeout. 

Click OK to acknowledge the message. 
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Users and Access to PrintSmith 
 

In this chapter 

System Administrator 16 
System Security and User Definitions 17 
System Security and Access Groups 19 
QuickAccess Panel 22 
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System Administrator 
As system administrator, you control access to PrintSmith for all users.  

PrintSmith is shipped with a blank NO NAME user ID so that you (or anyone else) can 
start using the system without entering a user ID or password when asked for login 
information. This NO NAME user ID gives full access to the system. While this is useful 
when setting up the system, EFI strongly recommends that you establish some security 
measures before you go live so that only the system administrator has full access to the 
system while other users have the access permissions they need to perform their work. 

Note Security is important if you are processing credit cards. For more information, 
see the PrintSmith Secure Credit Card Processing Guide. 

In addition to the NO NAME user ID, PrintSmith is shipped with a System user ID which is 
designed to be used by the system administrator. Typically, you would change your 
administrative password (EFI provides an initial password), prevent anyone else from 
using the NO NAME user ID, and then set up all your users with user IDs and passwords 
and the access permissions you want them to have. 

To set up yourself as the system administrator 
1. Start PrintSmith.  

2. When the Log In window opens, enter System in the User Name field and 
Manager in the Password field and click OK. 

3. Select Admin > Change Password and change the Manager password to one 
of your choice. Be sure to store the password in a safe place. The password is 
encrypted, and EFI has no way to find out what it is. 

Note For added security, make yourself use a robust password. For more 
information, see the explanation of Use robust password rules under 
“System Security and User Definitions” starting on page 17. 

4. To prevent anyone else from using the NO NAME user ID to access the system 
with full administrative privileges, select Admin > User Definitions, click <NO 
NAME> in the list at the top of the window, select the Disable user name check 
box, and click OK. (For more information about user definitions, see the section 
that follows.) 
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System Security and User Definitions 
Once you have set up yourself as system administrator, you must set up user names and 
passwords for all your users. You can also specify the kinds of access to PrintSmith a 
particular user has. 

On the Admin menu, click User Definitions. 
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The user who is currently logged in is shown with a bullet to the left of the name. The 
system administrator (there can be only one) is shown in red with a diamond next to the 
name. The list is in alphabetical order. 

Although any user can be given access to the User Definitions command, only the 
system administrator has full use of the command. Specifically, only the system 
administrator can change user definitions that belong to the System Admin access group 
and only the system administrator can assign users to the System Admin access group. 
Unless you are the system administrator, you cannot change anything in your own user 
definition. Also, the system administrator password can only be changed using Admin > 
Change Password. This ensures that you know the old system password before you 
change it to a new one. 

User Name Enter the name of the user. The user will need to provide this name when 
logging into PrintSmith. If you leave the User Name (and password) blank, the 
user can just click OK to log into PrintSmith without having to enter a user name 
and password. PrintSmith is originally shipped with a NO NAME ID belonging to 
the System Admin access group. This effectively disables the security system. 
Be sure to disable this NO NAME ID (by selecting the Disable user name check 
box) to prevent unauthorized system administrative access to PrintSmith.  

Disable user 
name 

Select this check box to prevent the user from logging in altogether. 

Access 
Group 
 

Select an access group for the user. This controls which PrintSmith commands 
are available to members of that group. You define access groups with Admin > 
Security Setup (as described on page 19). Two access groups are pre-defined: 
System Admin, which always has all commands, and Minimum, which has 
only those commands needed to get in and out of PrintSmith (Log In and Quit). 
These two groups cannot be changed in any way. 

Access 
Level 

This field used to be the principal security feature of PrintSmith. It was retained 
to support existing access levels on customer accounts. 

Set User’s 
Password 

Click this button to set a password for a new user or change the password of an 
existing user. Passwords are never displayed. Users should then change their 
passwords with Admin > Change Password. 

Force 
password 
change at 
signon 

Select this check box to force the user to change the password at login. You 
may want to do this to enforce security. (Once the user changes his or her 
password, this check box is cleared automatically.) 

Use robust 
password 
rules 

Select this check box to force the user to enter a “strong” password, which: 
- Must be at least 7 characters long and include both alphabetic characters and 
numbers.  

- Must be changed every 90 days. 

- Cannot match the previous four passwords used. (360 days must pass before 
you can reuse a password.) 

- Is automatically disabled after 90 days of no activity. 

QuickAccess 
Panel 
 

Select an existing QuickAccess Panel to assign to the user, or select New  to 
open the Configure QuickAccess window and create a new one. For more 
information, see “QuickAccess Panel” on page 22. 
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Configure 
QuickAccess 

Click this button to open the Configure QuickAccess window. 

Not allowed 
to override 

Select this check box to prevent the user from changing anything that would be 
considered an override or from removing an existing override. 

Can override 
credit limit 

Select this check box to allow the user to override the credit limit when charging 
items to Accounts Receivable in the Cash Register and to change the credit limit 
and discount percentage on the Credit Control tab in the Customer window. 
This setting also allows the user to post “paid outs” in POS and discount 
invoices. EFI recommends you restrict this feature to managers. 

Lock sales 
rep names 

Select this check box to ensure that the sales representative name assigned to 
an account or document is under management control. When Lock sales rep 
names is selected, a user can assign a sales rep to accounts and documents 
only if the field is empty, and cannot change the assignment after that. 

Can refund 
on credit 
cards 

Select this check box to allow the user to perform refunds on credit card 
transactions. For information about credit card refunds, see the PrintSmith 
Secure Credit Card Processing Guide. 

Not allowed 
to return 
cash 

Select this check box to prevent the user from cashing checks in the Cash 
Register. A transaction is rejected if the amount of change exceeds the total 
amount of cash. 

Show user 
name on Log 
In window 

Select this check box to display the user’s name in the list of users in the Log In 
window. 

Can edit 
QuickAccess 
Panel 

Select this check box to allow the user to edit the QuickAccess Panel. 

 

System Security and Access Groups 
Access groups control which PrintSmith commands members of a group can use. 
Although most of these commands correspond directly to commands on menus, many 
have no direct menu equivalents, such as preferences.  

Two access groups are pre-defined: System Admin, which allows access to all 
PrintSmith commands, and Minimum, which allows access only to those commands 
needed to get in and out of PrintSmith (Log In and Quit). You cannot change these two 
groups in any way. 

Typically, you will want to set up access groups so that users who perform particular tasks 
can perform their jobs using PrintSmith. Once the access groups are set up, you assign 
them to specific users in the User Definitions window (see “System Security and User 
Definitions” on page 17). 

Note You can change security settings only on a PrintSmith Master, not a workstation. 
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To edit or create an access group 
1. On the Admin menu click Security Setup. 

 

 

 

 

 
2. In the Access Groups field, select the group you want to work with or click New 

to create a new group. 

3. If necessary, click a column heading to sort the list by that column. For example, 
it is usually easier to review and edit the list of commands if they are sorted by 
Menu. (You can also change the width of columns by dragging the separators 
between the columns.) 

4. Click the Enabled column to add or remove check marks from individual 
commands. Commands without check marks are not available to members of the 
group. As you make changes, items are displayed in italics.  

Checked items 
available to all 
members of 
access group. 

Locked items 
cannot be 
changed. 

Indent 
indicates 
command 
not on a 
menu. 
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Note Items you cannot change have a lock icon next to them. All items in the 
Minimum and System Admin group are locked. These pre-defined 
groups cannot be changed. 

5. Choose File > Save to save your changes.  

Note the following when working with access groups: 

• Since any access group – including the System Admin group – can be copied 
using File > Save As, EFI strongly recommends that you restrict Save As to 
members of the System Admin group. 

• You can click Rename to change the name of an access group. Groups created 
during a conversion process may have cryptic names that you want to make 
more logical and obvious. 

If you have more access groups than you need, you can click Delete to delete the 
selected access group. Any users who are members of the deleted group are 
automatically assigned to the Minimum group, which effectively prevents them from doing 
anything in PrintSmith. Edit the user definitions to assign the users to a different access 
group. (See page 17.) 



EFI PrintSmith |  Setup Guide 

 

 
Page 22 

QuickAccess Panel 
The QuickAccess Panel opens when you log into PrintSmith, or when no other windows 
are open. The default QuickAccess Panel includes buttons to provide easy access to 
several of the most commonly-used features in PrintSmith. You can edit the default 
QuickAccess Panel, or customize it for individual users. (You can also give users 
permission (in the User Definitions window) to edit their own QuickAccess Panel.) 

 
Tips  In the QuickAccess Panel, select the Don’t show again on sign on check box 

to prevent the QuickAccess Panel from opening each time you log in. Select the 
Hide QuickAccess Panel when other windows are shown check box to hide 
the QuickAccess Panel when you open another window.  

 Choose Help > QuickAccess Panel or press F8 to open the QuickAccess Panel 
at any time. 

To configure the default QuickAccess Panel 
1. Choose Admin > Configure QuickAccess. The Configure QuickAccess window 

opens with Default shown as the Panel Name. 

The grid in the left pane represents the current layout of the command buttons on 
QuickAccess Panel. You can arrange the buttons on the grid to suit your needs. 
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The pane on the right lists the commands that you can add to the grid. (Notice 
that not all commands can be added.) 

 
2. To modify the QuickAccess Panel: 

• Drag existing commands to rearrange them on the grid.  

• Add new commands by dragging them from the right-hand pane of menus 
and commands to the grid.  

• Add an icon to a new command by dragging it from the icon area and 
dropping it directly on the command. 

• Delete a command by selecting it in the grid and pressing Delete on the 
keyboard.  

• Under Show on buttons, indicate whether you want to include icons, text, 
or shortcut keys on the command buttons. Also change the button size if 
necessary. 

3. Click Test to view your changes and then make any necessary changes. 

Drag a 
command 

from the right 
pane to the 

grid. 

Drag an icon 
and drop on 
a command 

button. 

Click to 
preview new 

layout. 
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4. If you want to return to the original default layout supplied by EFI, click Factory 
Defaults; to return to the last saved version, click Revert. 

5. If you want the changes to apply to the default QuickAccess Panel, just click File. 
If you want to save the changes as a new QuickAccess Panel, enter a new name 
in the Panel Name field and click File. 

Note If a new feature is added to your system, for example, PrintSmith Scheduling, 
workstation users can access its commands through the QuickAccess Panel only 
after an update from the Master. 

To assign a QuickAccess Panel to a user  
1. On the Admin menu, click User Definitions. 

 
2. Click a user in the User Name list.  

3. In the QuickAccess Panel field, select the panel you want to assign to the 
selected user. 
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4. To allow the user to edit the QuickAccess Panel, select the Can edit 
QuickAccess Panel check box. 

5. Click OK. 

Tip While in the User Definitions window you can also create a new QuickAccess 
Panel by selecting New in the QuickAccess Panel field, providing a name for 
the panel, and then customizing it as described earlier. Use a descriptive name 
for the panel, for example, Production if the panel is for members of the 
production group. 

 You can also edit the selected QuickAccess Panel by clicking Configure 
QuickAccess. 
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About Preferences 
Preferences control many aspects of your PrintSmith system. For example, you can set 
preferences for pricing, quantities for price lists, paper markups, and international settings. 
EFI recommends that you review all of the preference settings before you start using 
PrintSmith. Not all preferences are applicable to your business, but you should consider 
each preference and its effects on your PrintSmith system. You can change preferences 
at any time. 

Note  Some preferences are global while others are local. Local settings are unique to 
a particular computer. In a standalone PrintSmith system or on the PrintSmith 
Master computer in a multi-user system, all preferences are local. Workstations 
in a multi-user system have a combination of local preferences and global 
preferences that they obtain from the Master. Usually, a Workstation obtains 
some global security preferences when it starts up and others whenever the 
pricing system is updated.  

On the Admin menu, click Preferences. The Preferences window opens. 

Preferences are grouped into four areas: System, POS, Estimator, and Accounting.  

In each panel in the Preferences window, save your settings by clicking OK. (Click Cancel 
to restore the previous settings without saving your settings.) 
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System Preferences 
System preferences establish system-level rules, for example, about behavior, company 
information, numbers, and international settings. 

Appearance 
Use the Appearance preferences panel to control font usage and other aspects of the 
overall appearance of PrintSmith. 

 
You can customize some of the general appearance of PrintSmith by selecting fonts and 
colors. In some countries, you may want to use fonts other than the standards in order to 
provide characters or alphabets that are not supported by the underlying operating 
system. 

Note To reset the Appearance panel to its initial settings, hold down the Alt/Option and 
Shift keys when clicking Appearance under Pref List. 

Follow these guidelines to understand what you can do safely in the Appearance panel: 

• Change the prompts for some edit fields to a different color. 

• Change any of the fonts to a different font of the same size. 
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Do not do the following: 

• Change a small font so it is bigger than a larger one (the same size is 
acceptable). 

• Make fonts much larger, for example, change Small Font to 18 points. 

• Make dramatic changes to fonts while other windows are open. 

Behavior 
Use the Behavior preferences panel to control some aspects of PrintSmith’s behavior. For 
example, you can eliminate some warning messages after you have used PrintSmith for a 
while and no longer need certain reminders. You can also take advantage of line-item 
taxation, which lets you tax charges on an invoice independently.  
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Eliminate some 
warning 
messages 
 

Warning messages that are useful when first using PrintSmith may become 
unnecessary in time. Select this check box to eliminate the following most 
common messages: 
• Warnings at startup about dates and daily closeouts. 
• Warning that documents and job tickets were already printed. 
• Warning that a document is locked. 
• Message asking if you want to print job tickets for invoice level charges 

(they are always printed). 

Only post 
invoices marked 
ready 

Select this check box so that only invoices that are marked Ready for pick 
up/delivery in the Location window (in the Pending Documents window) can be 
picked up. 

Initialize printer 
before each use 

Select this check box to reset the printer settings between items being printed. 
If this check box is cleared, the printer settings remain as they were for the last 
item printed.  

Note This check box applies only to Windows. 

Enable Pricing 
system Import / 
Export features 

Select this check box to share press, copier/digital, and charge definitions 
among PrintSmith systems by exporting and importing them. When this check 
box is selected, the Press Definitions window, Copier/Digital Definitions 
window, and Charge Definitions window include an Export button so you can 
export a selected definition or all definitions. The File menu includes an Import 
command so you can import the exported definitions on another PrintSmith 
system. (The Import command is added to the File menu when you restart 
PrintSmith after selecting the Enable Pricing system Import/Export features 
check box.) For more information about sharing definitions, see “Sharing 
charge definitions among PrintSmith systems” on page 154. 

Activate user 
event logging, all 
workstations 

Leave this check box selected to log certain actions that users perform or 
events that take place. This type of tracking can be useful for security reasons, 
especially if you accept credit cards in PrintSmith. (For more information, see 
the PrintSmith Secure Credit Card Processing Guide.) When the Activate user 
event logging, all workstations check box is selected, events such as the 
following are tracked: logins, failed login, logouts, password changes, failed 
password changes, users created, users deleted, credit cards stored for 
contacts, and credit cards taken through PrintSmith. You can view the 
information in the user event log by clicking User Events in the System Monitor 
window (Admin > System Monitor). 
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Enable automatic 
logout 
 

Select this check box so that users are automatically logged out under certain 
conditions. When the Enable automatic logout check box is selected, you can 
select the Seconds of inactivity to trigger check box to set an inactivity timer. 
Then enter the number of seconds for the timer to run. If the timer expires 
without any activity on the part of a user (even moving the mouse), the user is 
automatically logged out, and the Login window opens. The default value is 600 
seconds (10 minutes) of inactivity. You can change it to anything greater than 4 
seconds.  
In addition, regardless of the Seconds of inactivity to trigger you specify 
here, any user with a robust password is automatically logged out after 10 
minutes of inactivity (or less if your automatic logout setting is for less than 10 
minutes). 
You can also select the Trigger after Posting check box to trigger an 
automatic logout after a transaction is posted. This solves the problem of users 
walking away from a Workstation after posting a transaction and leaving 
PrintSmith running. It also helps to ensure that each counter person logs in with 
his or her own user login ID for each transaction. 

Show invoices 
with firm due 
date of “today” 
at login 

Select this check box so that the Work In Progress report opens when you log 
in and when pending items exist that have firm due dates that are the same as 
today’s date. All pending items with firm due dates are displayed in 
chronological order. 

Enable line-item 
taxes 

Select this check box if you want the ability to tax individual charges in invoices 
– on a line-item basis. For an overview of line-item taxation, see page 100. 

Enable automatic 
quit 

Select this check box so that the system automatically shuts down at a certain 
time to ensure that backups are always complete. On Windows, many backup 
programs are unable to back up all files if PrintSmith is running.  

Time of day to 
quit 

Enter the time of day the system should shut down. Before the shutdown, all 
users are notified of the impending shut down and given time to save their 
work. 

Shut down 
notification 
message 
 

Enter the text of the message you want sent when PrintSmith shuts down. The 
standard text includes the two characters ^0 which are replaced by the shut 
down time entered in the Time of day to quit field.  

Note Shut down notification is a local preference. 
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Company  
Use the Company preferences panel to enter your company information. PrintSmith uses 
some of this information as the remittance address when generating statements, as well 
as in the “from” address in the delivery ticket. 

 
Note Company is a global preference that is established at the Master only. 
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Business Calendar 
Use the Business Calendar preferences panel to specify a fiscal year or a calendar year, 
as well as set work days. 

 

Fiscal year starts 
first day of 

Select the month your fiscal year starts.  
 

Current Range Shows the range for the fiscal year based on the month you selected. 

Work days Select the work days in your organization. The work days are displayed in 
black. 

First Day of Work 
Week 

Select the first day of the work week for your organization. (This has future 
localization implications.) 

Future dates 
exclude days that 
company is closed 

Select this check box so that job time estimates are based only on work 
days. 
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Network Setup 
Use the Network Setup preferences panel to connect or disconnect Workstations from the 
PrintSmith network. For more information about networking, see the PrintSmith Installation 
and Upgrade Guide.  

 

TCP/IP Port By default, this is the same number as your PrintSmith serial number. If you 
receive a message at startup about a port conflict, change the port number 
here. Port numbers can be in the range of 1 through 65535.  An edited port 
number is displayed in underlined italic.  

TCP/IP Address Enter the TCP/IP address. For the PrintSmith Master, this must be a static 
address. Each PrintSmith Workstation must have a unique address. 

Workstation ID In a multi-user system, enter an ID to uniquely identify the Workstation. The 
number can be anything you want as long as it is unique. This ID is used to 
identify a workstation in the user event log, which you can view with Admin > 
System Monitor. The ID can also be used to assign templates to particular 
Workstations. For more information, see “Templates tab” on page 239. 
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Disable networking  Select this option in a standalone environment. In a multi-user environment, 
this prevents Workstations from connecting to the PrintSmith Master.  

Enable networking 
using TCP/IP 

Select this option to connect Workstations to the PrintSmith Master.  
Any Windows computer with TCP/IP set up correctly can use this type of 
connection. 
Any Macintosh computer with Open Transport 1.1.1 or greater can use this 
type of connection. (MacTCP is not compatible with this, and is not 
supported.) 

Note Network setup is a local preference. 

Numbers 
Use the Numbers preferences panel to control the formatting and precision of all 
numerical amounts in the system.  

 

Always 
round 
down 
and 
Round 
tax up 
are 
usually 
cleared. 
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Each format contains instructions that tell PrintSmith how to display a number. Each 
character of the format represents some part of a number:  

• # tells PrintSmith to put a digit in that position if it is not a leading or trailing zero. 
For example, 1.5 in the format ###.### would be 1.5. 

• 0 tells PrintSmith to always place a digit in that position and to put a zero if there 
is no other digit. For example, 1.5 in the format 000.000 would be 001.500.  

• A decimal point (.) tells PrintSmith to display at least one digit before and one 
after the decimal point.  

• % indicates a percentage. For example, .15 in the format ##.###% would be 
15.0%. 

• A comma (,) indicates a thousands marker. 

• A minus (-) sign can be placed after a number to identify a negative number with 
a trailing minus sign. 

• Text in single quotes can be placed anywhere in the format, for example, 
'$'###.###. 

Each type of number (for example, integer or percentage) can have up to three parts 
separated by semi-colons (;).The first part is for positive numbers, the second for negative 
numbers, and the third for zero. You only need to specify the negative number format and 
zero format if you want some special formatting not provided by the positive number. For 
example, if you wanted PrintSmith to display “free” or “no charge” instead of a zero, you 
would need to specify a negative number format and a zero format. Often you can just 
specify a positive number and let PrintSmith handle negative numbers and zero using the 
same format. In this example, you could leave out the negative and zero portions of the 
format because it is essentially the same. (The only difference is the placement of the 
negative size, and that is in the “standard” position for the US.)  

###,###,###.00;-###,###,###.00;0.00 

Caution Be careful when changing formats so that you do not prevent PrintSmith from 
interpreting and displaying the numbers you enter correctly. In particular, make 
sure there are enough digits to display all the digits in the largest number you 
might enter or encounter. There is no harm in putting in more digits than you 
will ever use. 

The first group of fields (Integers through Short Percent) in the Numbers panel represent 
the formats used for particular types of numbers. Although difficult to specify exactly, 
these numbers are used as follows:  

Integers The format used for numbers without decimal places. 
Percentages The format used for most percentages except in the costing system, which uses 

Short Percent (see below). 

Amount The format  used for currency amounts. 
Tax Rate The format used for tax rates. 

Rate The format  used for rates specified as currency. 
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Factor The format  used for multipliers such as markup rates. 

Invoice The format  used for currency amounts in documents. 

Short 
Percent 

The format  used for percentages in the costing system. 

Round to  The number of decimal places to round. 

Always 
round down 

If selected, PrintSmith always throws away fractional results. For example, 1.259 
would be changed to 1.25. Use this method only when the accepted business 
practice is always to round down. 

Round tax 
up 
 

Generally, this check box should be cleared. The only case where EFI 
recommends selecting the Round tax up check box is in the state of Florida which 
has a sales taxing system that uses a table to look up actual tax amounts instead 
of calculating with a formula. The closest PrintSmith could get to matching their 
system by formula exactly (based on the unofficial recommendation of the State of 
Florida tax departments) is to round up all taxes. 
Round tax up can also be set in individual tax tables. When you upgrade from 
PrintSmith 8.0, the setting of the Round tax up check box in your existing tax 
tables defaults to your Round tax up preference setting. When you create new tax 
tables, however, you must set Round tax up for each table. For more information, 
see page 95. 

Common 
currency 
symbols 

Click a button (for example, Pound or Euro) to include a currency symbol.  

Note  Numbers is a global preference that is established at the Master only. 
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Alternate Currency 
Use the Alternate Currency preferences panel to set up and use another currency system. 
This panel primarily supports the European Union’s currency standard, the Euro, and 
affects invoices, estimates, statements and receipts printed with the receipt printer. Unless 
you are in the European Union, you probably do not need to make any changes to the 
default values in this panel. 

 
 

Use 
alternate 
currency 
system 
 

Select this check box so that all receipts and amounts on invoices, estimates, and 
statements include the base currency amount and the alternate currency amount. 
For receipts, the alternate amount is always printed below the base currency. For 
documents, you can place the alternate currency in a separate column or use the 
same method as the receipt printer. 

Format 
 

Specify the format of the alternate currency. In the example above, the Euro symbol 
(‘e’) was added to the beginning of the format. 

Note The Euro symbol is enclosed in single quotes (‘e’). As long as the symbol 
is enclosed by single quotes, it can be placed anywhere in the Format 
field. 

Conversion 
Factor 

Enter the exchange rate as a multiplier. The base currency amount is multiplied by 
the conversion factor to generate the alternate currency amount. 

  

Enter the  
conversion factor 
to ensure your  
system is 
reporting 
published  
conversion rates. 
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Round to 
 

If the base currency varies widely from the alternate currency (a very large 
exchange rate), you may want to change rounding for the alternate currency. To do 
so, enter the number of decimal places to round to. A negative number rounds up 
from the decimal point. For example, -2 rounds to the nearest 100 units.  

Always 
round down 
 

Select this check box to always round down the alternate currency (excess digits are 
removed and replaced with a zero). For example, if you round to 2 decimal places, 
1.991 and 1.999 both normally round to 1.99. If the Always round down check box 
is cleared, they round to 1.99 and 2.00, respectively. 

Note Alternate Currency is a global preference that is established at the Master only. 

International 
Use the International preferences panel if you are located in a country other than the 
United States of America.  

 
 

Use 
international 

Select this check box to take into account diacritical marks and other language 
specific constructs and glyphs when sorting text. Although more accurate, this 
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(slower) text 
sorting 

sorting method is much slower and should only be used when needed. 
 

Use Chile Tax 
ID verification 
 

In order for PrintSmith to be used in Chile, it must verify tax numbers, which are 
required on all invoices. Select the Use Chile Tax ID verification check box to 
enforce a specific format for the resale ID and perform a special modulo 
verification. PrintSmith reports the results of the resale number entry as a good or 
bad modulo. 

Note  Use Chile Tax ID verification is a global preference that is established 
at the Master only. 

Disable text 
styles 
 

In order to support languages such as Portuguese, Polish, Japanese, Chinese, 
and Korean, where text styles such as bold and italics can render text unreadable 
(especially in smaller fonts), you can disable all text styling in PrintSmith. Select 
the Disable text styles check box so that all text styling instructions (such as bold 
and italics) are ignored, as are user defined font settings.  

Note Disable text styles is a global preference that is established at the 
Master only. 

Use Australian 
invoice 
rounding 

Select this check box to round cash transactions to the nearest nickel. Checks 
and credit card charges remain in pennies. 
 

Disable non-
taxable 
options for 
invoices, jobs, 
charges 

Select this check box to disable the Taxable check box in the Invoice, Estimate, 
and Charge windows. This preference is not intended for domestic use. 
 

Ink Weight 
(singular) 

Enter the label you want to use for the weight a single unit of ink, for example, Kg.  

Ink Weight 
(plural) 

Enter the label you want to use for the weight multiple units of ink, for example, 
Kgs. 

Authorize the 
decrypt of CC 
to ADMIN 
users 

This field is no longer used. 
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Product Activation 
Use the Product Activation preferences panel to activate optional PrintSmith add-ons like 
integrated credit card processing and PrintSmith Tracker by entering activation codes. 

Note The Activate Full Export Capabilities field is for exporting data if you are 
upgrading to PrintSmith Vision. 
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Integration 
Use the Integration preferences panel to provide information related to integrations with 
PrintSmith. 

The PrintNet Integrator (PNI) is required for many EFI integrations, for example, for 
PrintSmith Site. The JDF Connector is required for integration with a Fiery®. 

 

PNI 
 

In the PrintNet Integrator IP Address field, enter the IP address of the 
computer on which the PrintNet Integrator (PNI) was installed for your 
organization. (This should be the internal IP address, not the external static IP 
address.) For information about installing the PNI, see the PrintNet Integrator 
Installation and User Guide. 
Click Check Connection to verify the connection. 

Note  Do not include the port number in the field. 
If applicable, select the PrintNet Integrator is version 4.5 or later check box. 
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JDF 
Connector  

Either add the IP address of the computer where you installed the Fiery JDF 
Connector to the Fiery Connector URL field (replacing the #s) or select the Use 
the JDF Connector URL from the PNI check box.  
Depending on your locale and the character sets your Fiery supports, select or 
clear the JDF Connector supports non-ASCII characters check box. 

Note         ASCII is a coding system for standard English characters. If you print 
accented characters (such as ñ or í, which are not found in English), 
they are considered non-ASCII, so you should select the JDF 
Connector supports non-ASCII characters check box. 

Note  You must restart PrintSmith for the PNI and JDF Connector settings to take 
effect.  

Palm Tracker 
Use the Palm Tracker preferences panel if you use the Symbol Palm Pilot with integrated 
bar code scanner for updating the locations of jobs in PrintSmith. You must install the 
Palm Desktop (or at least the HotSync manager portion) on a PrintSmith Master or 
Workstation computer. You could also install it on a computer without PrintSmith, as long 
as this location is available on the desktop of a computer with PrintSmith. 

Note Although PrintSmith Palm Tracker was discontinued, it is still supported. 

 
This panel specifies the location of the HotSync files and the frequency with which you 
want PrintSmith to check for changes. Once a schedule is set, it is automatic; any time 
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you perform a HotSync, the scanned data is loaded into the location you specify, 
PrintSmith reads it automatically and updates the pending list with the new location 
information. 

Use Palm 
Pilot 
tracking 

Select this check box so that PrintSmith checks for HotSync data. (This check 
box does not affect whether you can use your Palm units.)  

Palm user 
path 

Specify the location that PrintSmith checks for HotSync Data. (Set this after you 
install the Palm Desktop software.) 

Browse Click Browse to locate the HotSync application. PrintSmith uses this location to 
find HotSync data used to update job locations. 

Polling 
interval 
 

Enter the time (in seconds) that PrintSmith should wait before checking for 
HotSync data. EFI recommends 60 seconds as the minimum value. A lower 
number can seriously degrade network responsiveness and overall system 
performance. 

Create 
Location File 
 

If you want your Palm units to display the location of the job, you need to 
transfer the location information to each of them. Click Create Location File to 
prepare a file and set it up to be transferred to each Palm unit the next time a 
HotSync is performed. 

Check for 
Palm Data 
 

PrintSmith checks for Palm data at the polling interval you have specified. Click 
this button if you want to check for new data immediately regardless of polling 
interval. 
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Address Formatting 
Use the Address Formatting panel to control the format of addresses. 

 
The information in this panel is stored in the Country table, and can be modified to some 
degree in Table Editor.  

Use to add, 
change, and 
delete countries 

 
All the 
defined 
countries 

Sample of 
the 
selected 
format  

 

Country used 
when Country 
field is empty 
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Each country has an address layout, which you can control when you add or edit a 
country.  

 
Each row represents a possible address line. Each column represents address elements 
that can be placed on each line. Between the columns is a field where you can enter up to 
two characters of separator text such as a space or a comma with a space. If you do not 
enter any separator between address elements on the same line, there will not be any 
separation. 

Each field for an address element is optional. You need only specify the ones you want 
used in the address format, but you can only specify each address element once. 
Separators are only used when there is at least one adjacent element being used.  
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Backup Manager  
Use the Backup Manager preferences panel to perform automatic or on-demand product 
backups while PrintSmith is running. You can set backups to occur automatically when 
certain events occur in PrintSmith, for example, before or after closeouts. 

EFI recommends that you back up your PrintSmith data to a hard drive on your PrintSmith 
computer or network and then back up that drive or folder to a tape or CD. 

To perform backups 
1. Select Admin > Preferences > System > Backup Manager. The Backup 

Manager panel opens. 

2. Select the Enable Automatic Backup Manager check box. 

 
3. Click Browse to specify a drive and folder where the backed up information 

should be saved. PrintSmith automatically adds a PS_Backup subfolder to the 
folder you specify. 
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4. To back up at a particular time of day, in the Time of day to back up field, enter 
the time you want the backup to take place and include AM or PM (military time 
is automatically converted). 

Note Backups can also take place automatically when certain events occur. 
See step 9. 

5. Select Full Backup or Custom Backup. EFI recommends that you always 
perform a full backup. If, however, you select Custom Backup, at a minimum 
you must select Data folder, Prices folder, and PS Setup file (which contains 
your security information). 

6. In the Number of backups to keep field enter the number of backups PrintSmith 
should save before it starts deleting them. 

7. In the Warning Before Backup field, enter the amount of time (in seconds) 
before a scheduled backup is due to occur that a warning is sent out to any 
connected Workstations and the countdown dialog is displayed. The default is 
600 seconds (10 minutes). 

8. In the Workstation Grace/Lockout field, enter the amount of time (in seconds) 
that Workstations are locked out and have to request more time for completing 
their work before a backup occurs. The default is 600 seconds (10 minutes). 

9. Under Backup Events, select the check boxes of those events that should 
trigger a backup, for example, After Closeout or Before Monthly Closeout. 

10. Click OK. 

To perform an immediate backup 
• In the Backup Manager preferences panel, click Perform Backup Now and click 

OK. 

When a backup occurs, PrintSmith must be running, but no activity is permitted. Users are 
warned before a backup is due to start and are given a grace period to complete their 
work (see steps 7 and 8 above). If, however, a user has an open document that was not 
saved, the backup will not occur until the user clicks Save, Don't Save, or Cancel. The 
backup then happens immediately. 

Notes  Information about the next scheduled backup and last backup performed is 
displayed at the bottom of the Backup Manager preferences panel. 

 Always contact PrintSmith Support before attempting to restore your PrintSmith 
data. 
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Point of Sale (POS) Preferences 
This section describes the preferences that affect POS, or Point of Sale, features in 
PrintSmith.  

Receipt 
Use the Receipt preferences panel to set the header and footer messages and receipt 
numbering and tax options for the optional receipt printer. 

 

Header Enter the text that you want to print at the beginning of each receipt. 
Footer Enter the text that you want to print at the end of each receipt. 

Serial 
numbers on 
receipts 
starting at 

Select this check box to include a serial number on the receipt. The field to the 
right of this check box shows the serial number last used to print a receipt. If you 
change the number, a new sequence of numbers begins. 

Hide tax in 
line items 
 

Select this check box to include the tax in the price. Select this check box only if 
you are setting up the entire system to include tax as part of the price instead of 
showing tax separately. 

Note Hide tax in line items is a global preference that is established at the 
Master only. 
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Cash Drawer 
Use the Cash Drawer preferences panel to enable the optional receipt printer or cash 
drawer. You can set these preferences locally at each computer.  

 
Tip If the cash drawer and receipt printer are connected to a Workstation, EFI 

recommends you select the Keep settings local check box so the settings do 
not change during a pricing update. 

Receipt Printer If you are using a receipt printer, select the type of printer you are using, for 
example, USB Serial Printer or Named Graphic Printer.  

Printer Select the printer you are using as a receipt printer. The available selections 
depend on what you selected in the Receipt Printer field.  

Font Click this button if you want to change the font that is used on the receipt 
printer. 
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Enable Cash 
Drawer 
 

Select this check box to tell PrintSmith that a cash drawer is connected to the 
computer or receipt printer. If you specified a receipt printer, PrintSmith 
assumes that the cash drawer is plugged into the receipt printer and that the 
receipt printer has the necessary circuitry to supply power and open the cash 
drawer. 
If you have a stand-alone cash drawer, it must be plugged into an electrical 
outlet. Your computer usually cannot supply any electrical power to it. This type 
of cash drawer is called an “intelligent” drawer because it opens in response to 
a simple ASCII code. It is quite different (and usually more expensive) than 
drawers that plug into a receipt printer. 
If you do not want the cash drawer to open or do not have one installed, you 
can clear the Enable Cash Drawer check box. Unlike the receipt printer, which 
can also be disabled from the Cash Register window, this is the only place 
where you can disable the cash drawer. 

Use Master’s 
Drawer 
 

Select this check box on a Workstation to tell PrintSmith to open a cash drawer 
connected to the PrintSmith Master. Any locally installed cash drawer is 
ignored. This has no effect on receipt printers. You can have a cash drawer on 
one Workstation and have other Workstations use the drawer attached to the 
PrintSmith Master by clearing the Use Master’s Drawer check box on the 
computers with their own cash drawer. 

Print Receipts 
 

Select this check box if you want to print receipts. Receipt printers are local 
devices so this is a local setting that you can maintain by selecting the Keep 
settings local check box. Be sure to clear both check boxes if no receipt printer 
or cash drawer is connected to the computer. If a different type of device is 
connected to the port, your computer could get stuck waiting for the drawer or 
the receipt printer to respond. 

Print (2) for 
Credit Cards 

Select this check box if you want to print two copies of receipts for credit card 
transactions (one for the customer and one for your records).  

Print (2) for 
Cash 

Select this check box if you want to print two copies of receipts for cash 
transactions (one for the customer and one for your records).  

Keep settings 
local 
 

Select this check box to keep the cash register settings local to this computer 
without having them change each time prices are updated.  

Note  If you selected the Use Master’s Drawer check box, be sure to select 
the Keep settings local check box so you do not have to change the 
settings each time you update prices. 

Print Invoices 
 

Select this check box to print the invoice when you pick it up. (A similar choice 
exists in the Cash Register window.)  

Lock Settings 
 

Select this check box to prevent a user from changing the settings of the Print 
Receipt and Print Invoices check boxes from the Cash Register window. They 
are then set to match the Cash Drawer panel preferences and cannot be 
changed. 

ASCII Code to 
open Drawer 
 

PrintSmith sends a code to open the cash drawer. For most cash drawers it is 
the BELL character, which is ASCII code 7. Change this only if you know that 
your cash drawer needs a different code. 
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Blanks lines 
before Receipt 
 

To minimize the waste of paper on the receipt printer, specify how many blank 
lines should be printed before the receipt so that you do not have to feed the 
receipt manually before tearing it off.  

Blanks lines 
after Receipt 

To minimize the waste of paper on the receipt printer, specify how many blank 
lines should be printed after the receipt.  

Receipt Start 
Code 
 

Codes in this field are sent to the receipt printer at the start of each receipt 
before anything is printed. Do not change this setting unless you have a full 
understanding of these codes. For more information, see the description of 
Receipt End Code below. 

Receipt End 
Code 
 

This code is sent at the very end of printing the receipt. This code and the 
Receipt Start Code affect printers that have built-in receipt cutters. Unless you 
fully understand what a different code will do to your receipt printer, do not 
change these settings.  
Support for a thermal receipt printer with an automatic cutter is available in a 
Mac ADV, Mac USB, Win USB, and Win Serial version. In addition to being very 
fast, the printer has several options for paper advancement and cutting as 
defined by the following cut codes that you can enter in the Receipt End Code 
field if using this thermal printer. Enter one of the following codes only if you 
have a thermal receipt printer.  
1B6400 - Cuts the paper fully. 
1B6401 - Cuts the paper leaving one point uncut. 
1B6402 - Cuts the paper fully after feeding the paper to the cutting position. 
When print start position detect is ON, feeds the paper to the next print start 
position first, feeds the paper to the cutting position, then cuts the paper fully. 
1B6403 - Cuts the paper fully after feeding the paper to the cutting position. 
When print start position detect is ON, feeds the paper to the next print start 
position first, feeds the paper to the cutting position, then cuts the paper leaving 
one point uncut. 

Note  The Receipt Start Code and Receipt End Code settings are ignored 
for USB printers. 

Communication 
settings 
 

For standard cash drawers and receipt printers, the default communication 
settings (Baud Rate through Data Size) that PrintSmith provides are correct 
and should be left alone. If you purchased a cash drawer and receipt printer on 
your own, you may need to change some of these settings. Consult the 
documentation that came with the hardware to find the correct values and use 
the Test button to make sure they work. 

Note  These settings are ignored for USB printers. 

Test 
 

Anytime you change settings in this panel, click Test to print a sample receipt. If 
the cash drawer is enabled, it will open. If both a cash drawer and a receipt 
printer are attached, both must be enabled, or the cash drawer will not open. If 
the Use Master’s Drawer check box is selected on a Workstation, the drawer 
on the PrintSmith Master will open. A sample receipt will be printed only if the 
receipt printer is enabled and the Print Receipts check box is selected. 

Note  You cannot test the ability to print invoices from this window. 
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Cash Register 
Use the Cash Register preferences panel to control the tax status, title, sales category, 
rate, tax table, and tax code for each button in the Cash register window. If your business 
does a lot of small transactions, you should configure the cash register to match the types 
of transactions for which you do not need to create invoices. (For information about using 
the Cash Register in PrintSmith, see the PrintSmith Reference Guide.) 

 

Tax 
 

Select this check box to indicate that transactions created with this button are 
taxable. You can still decide, on a case-by-case basis, which transactions are 
taxable. 

Title 
 

Enter the label of each button in the Cash Register window. While it is a good idea 
to use a title that is similar to the sales category, you do not have to do so. Keep 
the button titles as short as possible as the buttons have very little room for text. 

Sales 
Category 

Select the sales category for cash register transactions created with this button.   
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Rate 
 

Enter the default rate for the button. When you click the button in the Cash 
Register window, PrintSmith automatically sets the unit price to this rate.  

Tax Table Select the tax table you want to associate with the button in the Cash Register 
window. Use Parent Tax Table is the default, meaning the tax table assigned to 
the customer account is used. 

Tax Code Select the tax code you want to use. (Tax codes are stored in the Tax Codes 
table, and can be maintained with Table Editor.) 

Note  Cash Register is a global preference that is established at the Master only. 
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Pending List 
Use the Pending List preferences panel to customize the appearance of the pending list 
as it is displayed in the Pending Documents window. You can experiment with these 
settings as much as you want, but they are only updated when the Pending Documents 
window is re-opened. Before changing these settings, be sure to close the Pending 
Documents window. 

 

Column 
setup 

You can change the order in which the pending columns are listed: 
• Change the column order in the list by dragging items. 
• Click the Visible column to change items from visible to not visible. 

Show 
Document 
type in 
number 

Select this check box to include E# as part of the document number for 
estimates. If this check box is cleared, the only way to determine the document 
type is to show the type icon or note the color of the item. Invoices are shown in 
blue unless the Color post due entries check box is selected.   

Always 
include past 
due 
documents 
in filter 

Select this check box to show past due jobs in various filters. 

  

Drag column titles 
to change their 
order and click  
the Visible 
column to 
indicate whether 
or not they are 
displayed. 
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Color past 
due entries 
 

Select this check box to display all late documents in the selected color. A 
document is late if the wanted by date and time have expired, unless marked 
ready for pick up or delivery. 

Past Due 
Color 

Click this button to change the color for displaying past due items. 

Ready for 
Pickup Color 

Click this button to change the color for displaying items ready for pickup. 

Invoice 
Color 
 

Click this button to change the color for displaying invoices on the pending list. 
(Before you change the invoice color, be sure the Pending Documents window 
is closed.)  

Estimate 
Color 
 

Click this button to change the color for displaying estimates on the pending list. 
(Before you change the estimate color, be sure the Pending Documents window 
is closed.) 

List Font Click this button to change the font for the pending list window. 

Header Font Click this button to change the font of the column titles in the pending list 
window. 

Note  Pending List is a local preference, meaning that in a multi-user system, every 
computer can have a different-looking pending list. 
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Estimator Preferences 
This group of preferences controls how the Estimator manages sizes, defines product 
codes, organizes stock listings, displays quantities, and so on. 

Estimator Behavior 
Use the Estimator Behavior preferences panel to control the way the Estimator acts. For 
example, you can control whether a source document is closed after copying or whether 
the paper calculator opens automatically for all printing, copying, and blank jobs. 

 

Close source document 
after copying 

Select this check box if you want to close the original document 
after it is copied so you can work with the newly created document 
right away.  

Enter Stock Cost in 
Estimator 
 

Select this check box if you want the job window to include fields for 
the stock cost and units when using the special order and customer 
stock pricing methods. If the check box is cleared, the stock cost 
and units fields are not shown in the Special Order job window. 
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Can change address on 
ALL documents 
 

When you select an account, the customer name and address fields 
are editable so that you can enter the customer information. Select 
this check box if you want the ability to change the customer name 
and address on all documents. When the document is filed, the 
pending list displays the actual company name from the selected 
account. When it is printed, the invoice address displays the 
information you entered or changed. 
To use this feature effectively, set up your documents to display two 
addresses: invoice and statement. The invoice address in the 
document becomes a shipping address and the statement address 
in the customer account is used as the billing address. If statements 
are sent to a third address, create another customer account with 
the correct statement address and use it as a master billing account 
for statement generation and posting payments. 

Auto show Paper 
Calculator on new jobs 

Select this check box if you want the Paper Calculator to open after 
the stock is selected when the job method is printing, copying, blank 
stock, or list. 

Always use Stock’s 
Parent Size 
 

Select this check box to lock the Parent Size field on jobs where 
stock is selected from the stock database. Generally, EFI 
recommends selecting this check box to prevent the stock parent 
size from being changed without the cost of the stock being 
changed. 
Although PrintSmith handles changes to the parent size as an 
override, it makes sense to use the defined stock size if one is 
available for stock ordering. Otherwise, you could end up with a 
stock order report with multiple sizes for the same stock number. 

Calculate Re-order date 
on invoice copy 
 

Select this check box so that when you create a new invoice from 
an invoice in history, PrintSmith looks for an invoice from history 
that is identical to this new invoice. PrintSmith calculates a date 
based upon the time elapsed between the new invoice and the 
invoice from history. This date is placed in the reorder field on the 
new invoice. Typically, this date is used to reorder every 30 days, 
60 days, 90 days, and so on. 

Validate sales rep Select this check box to notify the user when a document with a 
sales rep that was removed from the system is copied to a new 
document. The user is then prompted to select a sales 
representative. 

Leave Folded size 
empty on new jobs 

Select this check box to omit the folded size from a job. If the check 
box is cleared, the folded size defaults to the finish size. 

Do not perform Costing 
during invoice POST 

Generally, leave this check box cleared to provide for automatic 
costing at pickup. If you select the check box, only costed 
documents have costing information. Costing can always be 
updated or changed on any document. 

Auto show Charges on 
new jobs 

Select this check box so the Charges window automatically opens 
after you tab off of the description field the second time. This feature 
is designed for new users who may forget to view the charges. 
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Show (pre 7.1) single 
pass work and turn 
option 

Select this check box to show the single pass work and turn option. 

Never use preset press 
on stock changes 
 

Select this check box never to use the preset press in stock 
definitions on stock changes. (The press for printing will not change 
to the default press when you change the stock.) 

Add fixed waste for 
each pass (Affects 
historic documents) 

Select this check box to add fixed waste for each pass by 
multiplying the fixed waste by the number of passes. (This affects 
historical documents.) 

Add fixed waste for 
each color (Affects 
historic documents) 

Select this check box to add fixed waste on either side of the sheet 
for each color. (This affects historical documents.) 

Calculate INK by 
Impressions, includes 
waste. (Affects history) 

Select this check box to calculate ink by impressions with waste 
included. (This affects historical documents.) 

Use the History title for 
new document title 

Select this check box so that a changed title in account history is 
used in new documents. 

Normal due date (days) 
 

Enter the number of days from the date of the order that PrintSmith 
should use to calculate an automatic due date based on this 
number. This feature is also valuable as an automatic follow-up 
date for estimates. Note that if you enter 5 days in this field, and the 
5th day is a Saturday, PrintSmith sets the due date to the following 
Monday. 

Note  Normal due date is a global preference. 
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Estimator Printing 
Use the Estimator Printing preferences panel to determine if an invoice is closed after the 
job tickets are printed, what the default invoice and estimate are, and how the payment 
due date is calculated. 

 

Close 
Invoice after 
printing job 
tickets 

Select this check box to close the invoice window after the Tickets button is 
clicked to print job tickets. 

Close 
Invoices and 
Estimates 
after printing 

Select this check box to close an invoice or estimate after printing. If you want a 
document to remain open after printing it, clear this check box. 

Default 
Invoice 

Select a document format to use when printing an invoice. If the customer 
account assigned to the document has a default format selection, the customer 
setting overrides this system setting. 

Default 
Estimate 
 

Select a document format to use when printing an estimate. If the customer 
assigned to the document has a default format selection, the customer setting 
overrides this system setting. 

Note Default Invoice and Default Estimate are local preferences to 
accommodate different print drivers, printers, and platforms. 
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Payment 
Due Date 
 

In the Number of days due before field, enter the number of days PrintSmith 
should use to calculate a due date for invoices that are picked up and posted 
through the cash register if the customer account does not have a value in the 
Due days from posting field (on the Credit Control tab in the Customer 
window). The number of days you enter here is added to current date. If you do 
not enter a value in the Number of days before due field, the system uses 30 
days in its calculations. Also select the type of date you want PrintSmith to use 
in its calculations, for example, From pickup date or From ordered date. The 
due date is included under the amount due in the totals section of the invoice if 
the Show payment due date check box is selected in the Footer document 
preferences. For information about document preferences, see the PrintSmith 
Reference Guide. 

Paper Calculator 
Use the Paper Calculator preferences panel in conjunction with pricing methods that 
require stock. Here you can enter default settings for using the Paper Calculator. These 
defaults can be overridden when working in the Paper Calculator itself. 
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Grip Edge / 
Gap 
 

This is the amount of space required on one feed edge of the run sheet for the 
press to pick up the paper. You may be able to ignore this due to the placement 
of the image on the page. As a result, select this check box whenever it is 
needed. The size of the grip edge usually comes from the press definition. 
Otherwise, PrintSmith uses the Paper Calculator preference. The grip edge/gap 
can be changed for an individual job in the Paper Calculator window. 

Folio Edge 
 

This is the amount of space reserved on an edge of the run sheet for a booklet 
maker. Use it when folding signatures to offset the imposed image leaving one 
edge of the folded signature overhanging the other. You specify the standard 
size of the folio edge in this panel, but you can change it for any job in the Paper 
Calculator window. 

Color Bar  You can add a color bar to the cut diagram. Use the Color Bar field to specify 
the width of the color bar. You can control the edge used for the color bar even if 
you do not need to change the space for a gripper edge. After a job is filed, the 
settings default back to the Paper Calculator preferences. 

Note This is the only place you can set the width of the color bar; you 
cannot adjust it in the Paper Calculator. 

White Space 
 

White space is the unused part of the run sheet when the image area is smaller 
than the run size.  

Gutter 
 

The gutter is the space between multiple images on a sheet. The first value is 
the vertical gutter; the second is the horizontal gutter. A gutter is most often 
used to add space in a folded piece. 

Bleed 
 

A bleed is a specification that requires an oversize run sheet so that the ink can 
run off the edge of the final sheet. A bleed generally increases the number of 
cuts, since the bleed must be trimmed off each finished sheet in addition to the 
cuts needed to separate each image. You can specify the required bleed 
differently for each edge. 

Default 
Press Cutoff 

This is the maximum value that can be accepted as the cutoff length for a 
printed sheet. This value is used if the press cutoff and stock cutoff definitions 
are not known. Because the units are also unknown, EFI recommends that you 
enter a large value in this field. 

Back Trim, 
Parent 
 

If you plan to trim the edges from all four sizes of the parent sheet, select the 
Back Trim, Parent check box. This adds four cuts to the parent cut and centers 
the run sheet on the parent sheet. 

Trim Four 
Sides 
 

Select the Trim Four Sides check box if you plan to trim the edges from all four 
sides of the run sheet. Frequently, on large format presses, the entire image is 
centered on the plate in order to obtain the best ink coverage. After printing, the 
press sheet is trimmed down to remove the edges and ensure that the sheet is 
square before any other finishing is performed. 
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Work and 
Tumble 
 

Select this check box to change the cut out diagram for tumbling by showing two 
gripper edges and by changing the label of the Work & Turn option in the Job 
window to Work & Tumble. Should the other job specifications support Work & 
Tumble, that feature is manually selected in the Job window. 
Except for a possible change in the number of sheets out due to the additional 
gripper edge, no other change to pricing is made as a result of changing to 
Work & Tumble. If the other job specifications support Work & Turn, in the job 
window, you can change the way the job is estimated in the Job window from 
Sheetwise to Work & Tumble (or Work & Turn if this selection is unavailable.) 

Run to 
Finish Grain 

Neither. Grain direction is ignored and a best fit strategy is utilized without 
considering the possibility of rotating any sheets. 
Match Grain. Grain direction is matched by forcing the calculation to base the 
sheets out in the order in which length and width are specified. Sheets are never 
rotated to improve the number of sheets out. 
Swing / Combination. Uses a best fit strategy where sheets may be rotated in 
differing alignments to maximize the number of sheets that may be cut out. 

Print 
Options 

Change the selections under Print Options if you do not want the cut diagram 
attached to the job ticket, or you want to change what is on the cut diagram. By 
default, these check boxes are selected: 
• Print Parent to Run Section 
• Print Run to Finish Section 
• Attach to Job Ticket 
These check boxes are also selected when you upgrade from a previous 
PrintSmith version, as this is what was normally printed on the job ticket. Print 
Parent to Finish Section is another option now available to you. 
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Job Ticket 
Use the Job Ticket preferences panel to control aspects of your job tickets. For example, 
you can use the old style, use the standard style, or customize your job ticket. You can 
also decide what to include on job tickets and set fonts if you purchased a bar code 
reader. 

To customize your job ticket, you must have purchased the optional Report Writer. You 
use Report Writer to perform the customization. 

 

Custom 
Style 
 

This assumes that a custom ticket was already developed. One of the standard 
Report Writer reports is a customizable job ticket that is almost exactly the same 
as the Standard Style ticket. To use this as your job ticket, click Custom Style 
and then select the Job Ticket report (Job Ticket.rpt). 

Show 
Amounts on 
ticket 

Select this check box to include prices on the job ticket. When this check box is 
cleared, no prices are included on the standard job ticket. 

Add 
Tracking Bar 
Codes 
 

If using the optional bar code reader, select this check box to print the bar code 
on the standard job ticket. Also specify the font by clicking Set Bar Code Font. 
The optional bar code tracking system allows you to update the status or 
location of every job in your shop. 

Show 
customer 
ext. 
reference 
number 

Select this check box to include the external reference number in the job ticket 
header. An external reference number might be an artwork file, an old account 
number, or any number entered in the customer account. 
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Charge 
Description 
 

Show Name - When selected, shows the name of the charge on the job ticket. 
Show Description - When selected, shows the description of the charge on the 
job ticket. Users can easily change the description. 
Show Both If Different - When selected, shows both the name and description 
of the charge if they are different. 

Note Charge Description is a global preference that is established at the 
Master only. It affects only old style and standard style job tickets. 

Set Bar 
Code Font 

If you selected the Add Tracking Bar Codes check box, click this button to set 
the font of the bar codes printed on the job ticket. 

Print Bar 
Codes 

If you selected the Add Tracking Bar Codes check box, click this button to print 
a bar code sheet with the bar codes for the corresponding production locations. 
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Quantity Breaks 
Use the Quantity Breaks preferences panel to set up quantity breaks for price lists. 
Quantity breaks are a very effective marketing tool. The quantities are used to generate 
price lists on screen and for printing. You can generate a price list for any job with up to 40 
quantities. You can present the price list based on price per each or price per thousand. 
Either way, a price list with quantity breaks is a highly effective tool to “up-sell” the 
customer by quoting a lower price per unit.  

Enter the quantities you want to use for price breaks. Numbers preceded by – (minus 
sign) have a divisional line above them in the price list. A zero in any field ends the list. 

 
Note  Quantity Breaks is a global preference that is established at the Master only. 
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Markups 
Use the Markups preferences panel to set variables used in the estimating system. The 
outside services and merchandise markups are used for the related pricing methods.  

Markups are based on stepped cost amounts. The first amount covers costs from zero to 
the specified cost, and the last amount covers anything above the last specified cost. 

 
Note  Markups is a global preference that is established at the Master only. 
 

 

This markup 
applies to Total 
Cost from 0.00 to 
25.00 

This markup 
applies to Total 
Cost above 
800.00 
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Stocks and Sizes 
Use the Stocks and Sizes preferences panel to specify settings for in stock, special order, 
and customer stock, as well as blank stock markup and formatting instructions. 

 

Quantity Enter the default quantity breaks for each default markup used for sheet stock. 
You can override the quantity breaks for an individual stock in the Stock 
Definitions window. For information about stock definitions, see page 199. 

Markup 
 

Enter the default markup used for a stock quantity unless you specifically 
override the markup for an individual stock. A markup has a greater effect on 
high priced stocks than low priced stocks.  

Stock 
weight, 
name and 
finish 

For details, see “Stock weight, name and finish” on page 71. 

Stock 
points, name 
and finish 

For details, see “Stock points, name and finish” on page 71. 
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Stock 
microns, 
name and 
finish 

For details, see “Stock microns, name and finish” on page 72. 

Stock plies, 
name and 
finish 

For details, see “Stock plies, name and finish”  on page 72. 

Stock 
millimeters, 
name and 
finish 

For details, see  “Stock millimeters, name and finish” on page 73. 

Chain of 
Custody 

Select the chain of custody information about the stock that you want to include 
on job tickets and invoices: Include Certified options, Include Management 
type, and/or Include Recycle %. The sample shows what will be included on a 
job ticket or invoice. By default, the information is enclosed in parentheses, but 
you can specify different characters in the Open and Close fields. For example, 
to include chain of custody information in square brackets, enter [ in the Open 
field and ] in the Close field.  
In addition to selecting what you want to include under Chain of Custody, you 
must include ^3 in the format string in the appropriate Stock field, for example, 
Stock weight, name and finish. When the format string includes ^3, the  type 
of information you selected under Chain of Custody is included on your job 
tickets and invoices. 

Blank Stock 
Pricing 
 

Set your markups for selling blank stock using the blank pricing method. These 
quantities are included in each new stock definition. A change here, however, 
only affects new stock definitions and not existing definitions. You can either 
update existing definitions manually (one by one) to include the new defaults or 
globally by using Pricing > Change Prices. This command updates the markup 
and resets the quantity breaks when the Re-calculate blank stock prices 
check box is selected in the Change Prices window and the Auto Calculate 
Blank Stock check box is selected in the Stock Definitions window for a 
particular stock. 

Customer 
Stock 

Enter the default stock cost, quantity, and markup for customer-provided stock. 
These defaults can be overridden when entering a job in the Estimator. Select 
the Markup Only (no stock cost) check box to include a markup for customer-
provided stock without charging for the stock itself. 

Size Table to 
Use 
 

Select the size table that you want to use. You can customize size tables with 
Table Editor (Admin > Table Editor).  
Note  This is a global preference that is established at the Master only. 
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Stock weight, name and finish 

The Stock weight, name and finish field lets you format the way the stock weight, name, 
and finish are displayed. This field is based on a concept of a block of text with 
placeholders for the name, weight, and finish. These placeholders are replaced with the 
actual weight, name, or finish when the stock is displayed: 

• ^0 is the weight of the stock 

• ^1 is the name of the stock 

• ^2 is the finish of the stock 

• ^3 is chain of custody information (what is included depends on your selections 
under Chain of Custody and what the stock definition includes) 

You have complete control over the contents of the text block. Click the question mark at 
the end of the field to see a list of sample formats. Select one of the samples to insert the 
text format into the field. 

For example, for 50-pound offset stock, using a weight, pound sign, name, and chain of 
custody information, the format and result would be as follows: 

Format:  ^0# ^1 ^3 
Result:  50# Offset (chain of custody) 

Other possibilities include: 

Format:  ^1 ^0# ^2 
Result:  Offset 50# Vellum 

OR Format:  ^0gsm ^1 
Result:  50gsm Offset 

The resulting format is used on invoices, estimates, and stock order reports. 

Stock points, name and finish 

The Stock points, name and finish field lets you format the way the stock name and 
weight are displayed for stocks defined by points. This field is based on a concept of a 
block of text with placeholders for name, weight, and finish. These placeholders are 
replaced with the actual weight, name, or finish when the stock is displayed: 

• ^0 is the point size of the stock 

• ^1 is the name of the stock 

• ^2 is the finish of the stock 

• ^3 is chain of custody information (what is included depends on your selections 
under Chain of Custody and what the stock definition includes) 

You have complete control over the contents of the text block. Click the question mark at 
the end of the field to see a list of sample formats. Select one of the samples to insert the 
text format into the field. 
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Stock microns, name and finish  

The Stock microns, name and finish field lets you format the way the stock name and 
size are displayed for stocks defined by microns, where: 

• ^0 is the size of the stock in microns 

• ^1 is the name of the stock 

• ^2 is the finish of the stock 

• ^3 is chain of custody information (what is included depends on your selections 
under Chain of Custody and what the stock definition includes) 

You have complete control over the contents of the text block. Click the question mark at 
the end of the field to see a list of sample formats. Select one of the samples to insert the 
text format into the field. 

You do not need to enter a value for each parameter, and you can use the parameters in 
any order. Examples of micron stock: 

Format:  ^0 μ ^1 
Result:  45 μ Holographic 

Format:  ^1 ^2 ^0 μ ^3 
Result:  Poster Matte 150 μ (chain of custody) 

Stock plies, name and finish  

The Stock plies, name and finish field lets you format the way the stock name and 
weight are displayed for stocks defined by plies, where: 

• ^0 is the ply of the stock 

• ^1 is the name of the stock 

• ^2 is the finish of the stock 

• ^3 is chain of custody information (what is included depends on your selections 
under Chain of Custody and what the stock definition includes) 

You have complete control over the contents of the text block. Click the question mark at 
the end of the field to see a list of sample formats. Select one of the samples to insert the 
text format into the field. 

You do not need to enter a value for each parameter, and you can use the parameters in 
any order. Examples of stock defined by plies: 

Format:  ^0ply ^1 
Result:  2ply Acid-Free 

Format:  ^0ply ^2 ^1 ^3 
Result:  4ply Smooth Posterboard (chain of custody) 
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Stock millimeters, name and finish  

The Stock millimeters, name and finish field lets you format the way the stock name 
and size are displayed for stocks defined in millimeters, where: 

• ^0 is the size of the stock in millimeters 

• ^1 is the name of the stock 

• ^2 is the finish of the stock 

• ^3 is chain of custody information (what is included depends on your selections 
under Chain of Custody and what the stock definition includes) 

You have complete control over the contents of the text block. Click the question mark at 
the end of the field to see a list of sample formats. Select one of the samples to insert the 
text format into the field. 

You do not need to enter a value for each parameter, and you can use the parameters in 
any order. Example of stock in millimeters: 

Format:  ^0mm ^1 ^2 
Result:  20 mm Poster matte 



EFI PrintSmith |  Setup Guide 

 

 
Page 74 

Stock Definitions  
Use the Stock Definitions preferences panel to customize the PrintSmith Stock Picker 
window where you search for and select a paper stock. (See page 199.) 

 

Visible Click this column to make a column visible or invisible in the Stock Picker 
window. A bullet in the Visible column indicates that the column will be 
displayed in the Stock Picker window.  

Column Title Lists the columns that can be included in your Stock Picker window.  

Font 
Appearance 

Select the font size of the items in the Stock Picker window. 
 

Two-Stage 
Clear Search 

Select the Two-Stage Clear Search check box if you want all fields except for 
the Group field cleared the first time you click Clear Search in the Stock Picker 
window. This is useful if you are searching for several similar items. Click Clear 
Search a second time if you want to clear the Group field also. For more 
information about the Stock Picker window, see page 199. 

Tip You can rearrange the order of the columns by dragging them. 

Bulleted items 
are displayed in 
the Stock 
Picker. 

Change the font 
size in the Stock 
Picker. 

Change the way 
you clear 
searches. 
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Pricing Method 
Use the Pricing Method preferences panel to change the name and default sales category 
of a job pricing method. The pricing method calculations remain the same, however. For 
example, you could change the title of the first method to “whatever” and set the sales 
category to “other” but the method still calculates pricing based on a combination of press 
and stock definitions, and is unchangeable. 

 

Use Enable or disable any pricing method by selecting or clearing the Use check box 
for the method.   
The last five pricing methods are labeled Merch. You can use these for special 
pricing situations, for example, if you want to set up a special sales category for 
some types of brokered work or for other types of services like Mailing (as shown 
in the figure above). These five methods follow the same data entry methods as 
merchandise pricing.  

Title 
 

The title of each pricing method is used as the button label in the Pricing Method 
selection window. The actual width of the button title in that window varies 
somewhat so you should check the Pricing Method window for legibility any time 
you change one of these labels. 

Abbreviation Enter an abbreviation for methods where space may be tight, for example, the 
column headers in the Copier/Digital Definition window. So, for example, you can 
enter LF as an abbreviation for Large Format. 

  

Options 
can be 
turned 
off/on 

Select to 
use a 
pricing 
method 

Estimator 
column has 
pricing method 
descriptions 
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B T F N 
 

Select or clear the B, T, F, or N check boxes to enable or disable the Brokered, 
Taxable, Finished, and Notes options for each pricing method.  

Sales 
Category 
 

The sales categories in this window are largely ignored by the Estimator except 
for Outside Services, Merchandise, Lines & Inches, and the last five Merch 
(user defined) pricing methods. 
You can set up sales categories for printing, copying, and list pricing, but the 
actual sales category is determined by the press or copier/digital definition used in 
the job. The sales category for multipart jobs is used only when you specify 
overs/unders on the entire multipart job. 

Estimator This column displays the pricing method description or functionality. You cannot 
change this. 

Note  Pricing Method is a global preference established at the Master only. 
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Accounting Preferences 
Accounting preferences establish customer default credit limits, aging periods, sales 
categories, general ledger profiles, credit card configuration, order number formats, and 
journal entry defaults. 

Credit/Defaults 
Use the Credit/Defaults preferences panel to establish credit and other defaults.  

 

Credit Limit Enter the maximum amount any customer can charge to his/her account. 0 
means there is no system-wide credit limit. A customer’s individual credit 
limit takes precedence over the system limit you define here. Generally, set 
the system credit limit to your standard limit and then enter different credit 
limits on accounts that require them.  

Tip Credit limits unique to a customer account are set on the Credit 
Control tab of the Customer window. 

Finance Charge Enter the rate to calculate finance charges if an account does not have its 
own finance charge rate. The charge is applied each time you generate 
statements and select the Calculate Finance Charge option. Set the 
finance charge as a monthly charge, for example, 1.5% per month is 18% 
annually. 
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Inactive Period The inactive period controls when an account is marked inactive. This 
feature is very useful for keeping in touch with good customers. Set 
Inactive Period to the number of calendar days of inactivity you would like 
to track. Then select the Mark inactive accounts check box on the 
Accounting tab in the Account Aging window (AR > Account Aging). The 
accounts are then marked inactive when you run an aging report. 

Remove drafts 
from deposit 
ticket 

If you have money wired to you, or you accept bank drafts, select this check 
box to reflect the deposit more accurately. The bank drafts are then not 
printed on the deposit ticket, but are still recorded and saved. If you clear 
this check box and then re-print a deposit ticket, the draft data is included 
again. 

Default sales rep 
for new accounts 

Select the default sales representative for new accounts.  
 

Default shipping 
for new accounts 
 

Select the default shipping method for new accounts.  
 

Note Credit/default are global preferences established at the Master only. 
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Aging Periods 
Use the Aging Periods preferences panel to set your standard aging periods and the 
notices placed on statements for accounts that are past due. You can set up aging periods 
that differ from the standard 30-, 60-, or 90-day aging periods to better suit your business. 
For example, you may want your periods to be 45, 60, or 90 days to provide your 
customers with a bit more time to pay without unduly delaying action on slow-paying 
accounts. Add appropriate messages for each aging period. These messages can be 
included on statements for customers if you select the Show reminders check box on the 
Output tab in the Generate Statements window. 

 
Note  Aging periods are global preferences that are established at the Master only. 
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Sales Categories 
Use the Sales Categories preferences panel to customize your sales categories. 
PrintSmith has 40 customizable sales categories that are used in other parts of the 
system, for example, in charge, press, and copier/digital definitions, as well as in daily 
closeouts to categorize transactions. PrintSmith always tracks sales categories by field 
number or position. If you change the name of a sales category, all sales for that category 
remain in the original numeric position. Select categories carefully and leave room for 
future expansion. Once sales are recorded in a category, they stay in that numbered 
category. 

 

Name Enter the name you want to use for a category to suit your business. For 
example, define the sales category for each cash register button, pricing 
method, press definition, copier/digital definition, and charge definition. 

Note        Do not include any of the following characters in a name: “ ; ( ^ / 
! ”. Also avoid using a hyphen as the first character because it 
disables the item, preventing it from being selected. 

Sales categories 17 through 20 are shown as Other Sales in the daily 
sales report. Sales category 20, labeled Interest, is used by the statement 
generator to track finance charges separately. 
The final sales category, Shipping, is a built-in sales category that cannot 
be changed. Estimator uses it when shipping charges are manually 
entered. You can also use it for any charges used to add shipping charges 
to a document. 
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GL Acct If you plan to connect PrintSmith to an external general ledger package, 
enter the number of the general ledger account  for each sales category. 

Note  Sales Categories is a global preference that is established at the Master only. 

GL Profiles 
Use the GL Profiles preferences panel to define a link to the accounting package you use, 
as well as to define specific GL account numbers that relate to this accounting package.  

 
Note The Cash Over/(Short) and Paid Out accounts are typically special cases that 

are most likely to be posted to an expense or income account.  

Link to: 
 

Select the accounting package that you use. Currently, supported packages 
include MYOB, Peachtree Accounting, QuickBooks, MultiLedger, SAGE 
Accounting, Simply Accounting, BusinessWorks, Great Plains Import Manager, 
SAGE Line 50, and Peachtree CSV. The information that is exported from 
PrintSmith as an .IIF file when a closeout is performed comes from the fields 
described below. (For information about closeouts, see the PrintSmith Reference 
Guide.) 

Shipping 
Collected 
 

This total comes from revenue attributed to the shipping sales category. A 
separate shipping line item is included in the Sales Breakdown section of the Daily 
Sales Report. 

Actual Bank 
Deposit 

This total comes from the Actual Deposit field in the Miscellaneous section of the 
Daily Sales Report. You enter this total into PrintSmith during the daily closeout. 

Un-deposited 
Receipts 
 

This total comes from the On Hold field in the Balance Cash Drawer window that 
is part of the daily closeout. An item on hold could be a customer check you put 
on hold for 24 hours. 

Select your 
accounting 
system from 
a list of 
supported 
packages. 
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Discounts 
 

This total comes from revenue attributed to the discounts sales category. A 
Discount/ Markups line item is included in the Sales Breakdown section of the 
Daily Sales Report. 

Sales Tax 
 

This consists of the Taxable Sales and Tax on Sales fields in the Sales 
Breakdown section of the Daily Sales Summary report. 

Total AR 
Receipts 

This total comes from the A/R column in the Receipts Summary section of the 
Daily Sales Summary report. 

Deposits on 
Invoices 

This total comes from the Deposits Received line in the Receipts Summary 
section of the Daily Sales Summary report. 

New Charges 
to AR 

This number comes from the New Charges line in the Receipts Summary section 
of the Daily Sales Summary report.. 

Cash 
Over/(Short) 
 

Listed in the Miscellaneous section of the Daily Sales Summary report, this is the 
difference between what PrintSmith tells you the deposit should be and the actual 
total you have entered. 

Paid Out 
 

This total is listed in the Miscellaneous section of the Daily Sales Summary report 
and reflects cash paid out of the cash drawer, usually for miscellaneous items like 
gas, postage, and so on. 

Refund 
Checks 
 

This reflects any refund checks indicated in the Post Payment window. This 
control account for handling refund checks is required for maintaining proper 
balances in external accounting systems. When a refund check is issued in 
PrintSmith, it increases the AR Balance and customer account balance by the 
amount of the refund, but it does not adjust the “cash” account in the balance 
sheet because this adjustment should take place when the check is actually 
written. Everything balances in PrintSmith and in the journal entry because the 
refund is offset against receipts. 
When you actually write the check in the external accounting system, however, it 
typically reduces the cash balance in the checking account, even though the 
refund check has already done this. The result is a double-posting to cash in the 
external system. 
Use the Refund Checks control account to specify an asset account to use as a 
clearing account. The amount of the refund checks will be added back into cash 
and offset against the clearing account. When you actually write the refund check, 
post it against the clearing account and everything will be in balance.  
If you do not want to use the clearing account method, another solution to this 
problem is to set the Refund Checks control account to be the same as the 
Actual Bank Deposit account, and they will cancel each other out. 

Note  GL Profiles are global preferences that is established at the Master only. 
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Credit Card Info 
Use the Credit Card Info preferences panel to set up credit cards as a payment method in 
PrintSmith and to activate credit card processing through USA ePay.  
Important The Credit Card Info preferences panel is an essential part of setting up the 

integration with USA ePay for secure credit card processing. For information 
about this panel and other aspects of processing credit cards, read and 
follow the instructions in the PrintSmith Secure Credit Card Processing 
Guide.   

 
Note  Credit Card Info is a global preference that is established at the Master only. 
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Order Number Format 
Use the Order Number Format preferences panel to specify the prefixes and/or suffixes 
that you want to use with invoice and estimate numbers. For example, your company may 
follow a convention where all estimates begin with a location or store number so this 
would be your prefix for estimates. 

To include prefixes and suffixes on documents, you must select the Print custom order 
number check box in the Page document preferences (Admin > Document Preferences 
> Page). 

 
Under Invoice and/or Estimate, set the following fields: 

Prefix Enter the characters (up to six) that you want before an invoice or estimate number. 
The characters can be alphabetic or numeric in any combination. The results are 
displayed next to Sample. 

Suffix Enter the characters (up to six) that you want after an invoice or estimate number.  
The characters can be alphabetic or numeric in any combination. The results are 
displayed next to Sample. 
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Allow Prefix 
modification 

Select this check box to allow users to change the prefix. 

Allow Suffix 
modification 

Select this check box to allow users to change the suffix. 

Note  Order Number Format is a global preference that is established at the Master 
only. 

Journal Entries 
The appearance of journal entries depends on a document preference. Use the Journal 
Entries preferences panel to select this document preference. For information about 
document preferences, see the PrintSmith Reference Guide.   

 

Print 
Document 

Select this check box if you want the Print Document check box selected by 
default in the Journal Entry window. (EFI recommends that you do this.) 

Journal 
Document 
Preference 

Select the document preference that you want to use for printing journal entries. 

Note  Journal Entries is a global preference that is established at the Master only. 
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Table Editor 
 

In this chapter 

About PrintSmith Tables 88 
Reviewing and Editing Tables 88 
Defining Table Properties 89 
PrintSmith Tables 90 
Understanding Size Tables 93 
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About PrintSmith Tables 
Tables provide the ability to customize important parts of the PrintSmith user interface and 
expand other capabilities in an easy-to-understand manner. Tables are most commonly 
used in quick-fill fields and fields where you select an item from a list. Table Editor lets you 
manage the contents of these tables and control how they are used. 

Note A quick-fill field is one in which you can start typing, and PrintSmith starts 
providing matches based on what you typed. For example, if you type sa, 
PrintSmith will list any items that begin with sa. You can then select the one you 
want. 

Reviewing and Editing Tables 
1. On the Admin menu, click Table Editor. The Untitled Table window opens. 

2. In the Tables field, select a table, for example, Job Title. The title bar of the 
window then includes the name of the table. 
 

 
The lower part of the window shows the contents of the selected table. The data 
depends on the type of table you are viewing, but shares some features: 

• Each table can contain at least 100 lines (also known as table elements); 
some tables can have as many as 25,000 lines. 

• All tables have an ID column. Each item in a table has a unique, non-
editable, sequentially assigned ID, which permanently identifies the item. 
This ID is important because it is often stored in other parts of the PrintSmith 
system instead of the text in the Name column. Not only is this more 

Title bar of 
window 

identifies 
selected table. 

 

Data in 
table. 
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efficient, it also allows a change to an item to be instantly reflected 
everywhere it is used. 

3. Do any of the following while viewing a table: 

• Sort the information in a table by clicking a column header.  

• Drag items to position them exactly as you want. This feature is very useful 
for quick-fill fields because elements at the top are preferred over items at 
the bottom of a table. 

• Navigate among fields by using Tab, Return, or an up or down arrow key 

• Change information by clicking a field (such as the name of an item) and 
making your changes. 

• Add new items by clicking the Name column after the last item in the table 
and entering the new name. (You can then drag the item to another part of 
the list.) 

• Delete an item by clicking its ID number in the ID column and clicking Delete 
Entry or pressing the Delete or Backspace (Windows) key. 

• Define the properties of the table. See “Defining Table Properties” below. 

4. Select File > Save to save your changes. 

Defining Table Properties 
The properties of a table include the table ID (a unique identifier for the entire table), the 
table type, the table title, a setting indicating whether the table can be used, and settings 
that control how the table is used. 

1. On the Admin menu, click Table Editor. The Untitled Table window opens. 

2. Select a table in the Tables field and click Properties. The Table Properties 
window opens. 
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3. Make your changes and click OK. For a description of the fields in the window, 
see below. 

ID 
 

Shows the unique ID of the table. For the most part you can ignore table IDs. 
They serve as a constant internal reference since you can change the name of 
any table. 

Disable 
Table 
 

Select this check box if you do not want the table to be used. (This applies to 
tables that are used for quick-fill fields or popup lists.) In this case all the fields 
that use the table are changed to standard edit fields. Table driven dropdown 
lists cannot be disabled. 

Enable Size 
Translation 
 

This applies only to Sizes tables that can be selected as the active size table. 
Select this check box to allow size translation for this table if and when it is the 
active size table. 

Title 
 

The title of a table can be up to 48 characters long. You can change the title of 
any table. Mostly this only affects how the table is listed in Table Editor, but in 
some tables the title is also used as the label for a field. For example, the title of 
the Sales Rep table is also the label for all the fields that use this table - even if 
the table is disabled. 

Number of 
Entries 

Shows he number of entries in the table. Tables can hold a minimum of 100 
entries; some can hold up to 25,000 entries. 

Table Status 
 

Select the status of a table: 
Editable. Most tables are marked as editable meaning you can add or remove 
items in the table.  
Locked. A locked table does not allow additional entries to be added or its 
status to be altered. Existing items in the table can still be changed. The Phone 
Tags table is an example of a locked table. There are only four numbers that 
can be tagged, so the table has four entries and is locked. 
Add Edit Command. This status adds an Edit command to the bottom of all 
lists that use this table. When you click Edit, Table Editor opens in a special 
mode just for editing that table. 
Add from Input. This status is useful only for popup lists and quick-fill fields. It 
tells the system to add a new item to the table if the user types an entry into the 
field, and the entry is not already in the table. PrintSmith asks before adding the 
item to a list. Normally, Add from Input is the best setting for a quick-fill field if 
you want it to “learn” from user input. 
Add from Input and Edit. This status combines both an Edit command and the 
ability to add items based on user input. 

Sort By 
 

Select the way the table is sorted. The selections here are identical to those 
available by clicking the column headers in the Table Editor window. 

PrintSmith Tables 
PrintSmith has three basic types of tables: keyed tables, size tables, and standard tables. 

• Keyed tables have a Key column where additional data can be entered. 

• Size tables have a Size column (middle column) that expects sheet sizes. 
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• Standard tables are composed of an ID and Title only. The middle column is left 
blank. 

The following is an alphabetical list of all the PrintSmith tables. (These are the initial 
names of the tables as supplied by EFI.) 

   

ID Name Usage 

14 Basic Sizes Size table, but not usable as an active size table. Shows the basic 
size for each of the paper types in the United States. 

15 Business Type Popup list used for marketing purposes. 

30 City Quick-fill table for addresses. 

19 Common Interest Quick-fill table for contacts/prospects. 

27 Contact Name Prefixes Quick-fill table for contacts. 

28 Contact Name Suffixes Quick-fill table for contacts. 

35 Country Quick-fill table for contacts. Also used to control addresses that are 
formatted in each country. Do not add entries to the Country table 
with Table Editor; use the Address Formatting preferences to do this. 
(See page 46.) 

60 CTP Substrate  Quick-fill table for using a computer-to-plate (CTP) device with the 
Fiery for charge definitions. 

59 Driver Popup list to add the in-house delivery truck driver name to your 
delivery tickets. 

6 Generic Colors Quick-fill table for Stock Picker window. 

42 Hold State Quick-fill table for Pending Documents window and Account Info 
window. 

39 Ink Color Quick-fill table for ink colors in job window. 

32 Job Title Quick-fill table for contact editor. 

17 Lead Source Marketing tables used on the Marketing tab in the Customer and 
Contact windows. 

26 Mailer Type Quick-fill table for addresses/contacts/prospects. 

16 Marketing Date Labels Marketing tables used as labels for dates on the Marketing tab in the 
Customer and Contact windows. 

36 Phone Tags Labels for phone number fields for contacts. 

57 Production Copiers Popup list for the Machine Name field in the Copier/Digital Definitions 
window. These names are also used in the employee production filter 
to determine which jobs are seen in the Tracker Console. 

41 Production Dates Dates of production by production location. This list is used in the 
production data window. 

58 Production Exceptions Popup list for the Exception code field in the Stop Tracker Step 
window.  

54 Production Facilities Table used by the Tracker Module. The default production facility is In 
House.  
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ID Name Usage 

50 Production Locations Names of processes that indicate the stage of a job in the overall 
production process. These can be customized based on your internal 
referencing system.  

56 Production Presses Popup list for the Machine Name field in the Press Definitions 
window. Press names are also used in the employee production filter 
to determine which jobs are seen in the Tracker Console. 

52 Production Priority Priorities based on your internal language and referencing system for 
indicating which jobs should take precedence. These can be assigned 
to a job in the Tracker Production window. 

53 Production Stations The computer terminal where PrintSmith is running. Supports the 
Tracker Module. 

40 Products Product list used for jobs. 

37 Report Categories A list in Report Manager for categorizing reports. 

33 Sales Rep  A list that is used everywhere a sales rep is entered.  

34 Ship Via A list of shipping methods. Fields that use this list do not allow users 
to enter data - it must come from the list. 

3 Sizes – Metric CM Size table of metric paper sizes in centimeters. 

4 Sizes – Metric IN Size table of metric paper sizes in inches. 

2 Sizes – Metric MM Size table of metric paper sizes in millimeters. 

1 Sizes – United States Size table of US sizes plus metric sizes in inches. 

20 Sport Interest Quick-fill table for contacts/prospects. 

29 State Quick-fill table for addresses. 

8 Stock Colors Quick-fill table for job and stock definitions. 

7 Stock Finish Quick-fill table for Stock Picker and stock definitions. 

64 Stock Forest 
Management 

Types of forest management related to chain of custody of stock, for 
example, Green Seal Certified or FSC Pure.  

9 Stock Grade Quick-fill table of stock grades for Stock Picker and stock definitions. 

10 Stock Group Quick-fill table of stock groups for Stock Picker and stock definitions. 

63 Tax Codes Table of tax codes. 

61 Tax Tables Table of tax names (jurisdictions). 

62 Tax Tables Elements Elements in a tax table, for example, City or State. These make it 
possible to show separate line items for different taxes on an estimate 
or invoice, for example, city versus state tax. 

25 Type of Work Quick-fill table for contacts and prospects. 

19-26 User 1- User 8 Marketing tables used in fields on the Marketing tab in the Customer 
and Contact windows. 

38 Vendor Quick-fill table of vendors for stock definitions. 

65 WEB Locations Status labels available on site corresponding to PrintSmith locations. 
For information, see the PrintSmith Site Administrator Guide. 
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ID Name Usage 

31 Zip Quick-fill table of zip codes for addresses. 
   

Understanding Size Tables  
PrintSmith can include many sizes - the list can hold 32,000 definitions. While this is 
particularly helpful in metric-based systems (for example, A4, A3, and SRA2), it also has 
many uses in an Imperial-based system. 

For each size you can provide some text that explains the size, for example, #9 envelope 
for a size of 3.875 x 8.875. 

The size you enter must be in the same units as the base system. For example, if the 
base system is metric-based in millimeters, all your sizes must be millimeters by 
millimeters. When the Enable Size Translation check box is selected (in the table 
properties), users can enter the size either by size or description.  

 
This is helpful for sizes like business cards that may not be easily remembered. 
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Sales Tax or Value Added Tax (VAT) 
 

In this chapter 

Overview 96 
Defining the Default Sales Tax 96 
Creating Tax Tables for Different Tax Jurisdictions 99 
Line-Item Taxation 100 
Using Tax Codes to Differentiate Same Tax Rate 100 
Addressing International and Other Tax Issues 101 
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Overview 
In order to properly calculate and report your sales taxes, you need to define your tax 
rates within PrintSmith. If you do not charge and collect sales tax, you should review the 
settings to ensure they are set to collect no tax (zero). 

The sections that follow cover: 

• Defining your default (standard) sales tax  

• Creating new tax tables to handle multiple tax jurisdictions 

• Addressing international and other tax issues 

Defining the Default Sales Tax 
The default tax table is often the only tax table you need to set up. If, however, your 
business uses multiple tax jurisdictions, or is international, you need to account for these 
different taxes by setting up additional tax tables. In this situation, the default tax table 
should be set up for your most commonly-used sales tax. 

Note If you upgraded from PrintSmith 8.0, the two-character abbreviations for your tax 
tables were used for both the abbreviation and the name in 8.1, except for the 
default tax table which is named Default, but has no abbreviation. You will 
probably want to make the names of your tax tables more descriptive. 

1. On the Pricing menu, click Sales Tax. The Sales Tax window opens with no tax 
table displayed, but the Default tax table is listed at the bottom of the window. All 
taxable invoices and customers use the default tax table rate unless another tax 
table is assigned to an account, invoice, or estimate. 

Tip  Any tax table can be your default tax table; just click the Default column 
next to the tax table you want to be the default table. A bullet identifies 
the default table. You can also name the default tax table whatever you 
want, although Default as the name can help to identify the purpose of 
the table.   

2. Click the Default table (at the bottom of the window) to display its contents.  
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3. Enter up to 12 tax elements to calculate the Effective Tax Rate. For example, 

you may need to account for a city tax in addition to a state tax. Each tax element 
consists of Description and Tax Rate fields as well as Ship and Show fields to 
control whether the tax element is included in taxes on shipping and/or on an 
invoice or estimate. Double-click the Description and Tax Rate columns to enter 
or edit information in those columns. (The number that identifies each tax 
element is only important when you select the Tax on Tax check box, and are 
therefore applying tax to the previous tax element.) 

Description 
fields explain 
tax elements, 
which you can 
Show  on 
estimates and 
invoices. 

 

Effective Tax 
Rate is 
calculated 
using Tax 
Rate line 
items. 

 

After making 
changes, 
click to save. 

Bullet identifies 
the default tax 
table (which does 
not have to be 
named Default). 
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Notes Use Table Editor (page 87) to define the names of the elements in the 
Tax Tables Elements table. 

  If you upgraded from PrintSmith 8.0, a special Single Item Tax 
Element was created with an ID of 1. You can use this with any tax 
table that has no breakdown. PrintSmith also uses this element if the 
upgrade determines that a different tax rate (for example, in a historical 
invoice) was used other than that specified in the current tax table. 

  Consider using tax elements to add a small charge for chemicals and 
materials used, the same way an automobile company charges for 
small miscellaneous materials. Also consider collecting a charitable 
donation on each sale.  

  If you hold down Option/Alt while clicking the Show column, all the 
fields in the column change to the opposite state automatically. 

4. Select the Tax Shipping check box if the shipping amount entered in the 
Document Totals field of an invoice should be taxed. When the Tax Shipping 
check box is selected, you can select the Separate Shipping check box to 
specify the tax elements that should be applied against shipping. This type of 
taxation is common in certain countries, for example, Canada. For more 
information, see “Tax on shipping” on page 103. 

5. Select the Tax on Tax check box if your tax district taxes other taxes. Normally, 
PrintSmith adds the rates in the tax table together to come up with the effective 
tax rate. If you select the Tax on Tax check box, PrintSmith calculates each of 
the tax rates. For example, if the first rate is 6% and the second rate is 5%, the 
effective rate is 11.3% (PrintSmith adds 0.3%, which is 5% of 6%, the first rate). 

6. Select the Build tax in price check box if you want to hide the tax in the price for 
items and never show it separately.  

7. Select the Round tax up check box if you want to round up all the tax rates in 
the table. Generally, this check box should be cleared. The only case where EFI 
recommends selecting the Round tax up check box is in the state of Florida 
which has a sales taxing system that uses a table to look up actual tax amounts 
instead of calculating with a formula. The closest PrintSmith could get to 
matching their system by formula exactly (based on the unofficial 
recommendation of the State of Florida tax departments) is to round up all taxes. 

Note If you upgraded from PrintSmith 8.0, the setting of the Round tax up 
check box defaults to the setting of Round tax up in the Numbers 
preferences panel (Admin > Preferences > System > Numbers; see 
page 36). In any new tax tables that you create, Round tax up is 
cleared by default. 

8. Verify the Effective Tax Rate. This rate is calculated based on the tax elements 
you entered. If this rate is not correct, adjust the tax elements. 

Tip If you make changes, but want to return to the original settings, click Revert. 
9. If necessary, set the Minimum Taxable Amount. 
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10. Click Save to save your changes.  

11. Click Close. 

Note If you make a change to a tax table that affects the calculation of taxes, 
PrintSmith creates a new version of the tax table (leaving the original intact). 

 If you no longer want to use a particular tax table, select the Disable check box 
when the details of the tax table are displayed. You cannot disable the default tax 
table, however. 

Creating Tax Tables for Different Tax Jurisdictions 
If you have to account for more than one tax structure in your business, you must create 
additional tax tables. Also, if a customer has special tax requirements, create a special tax 
table and assign it to that account. You can also change the assigned tax table on any 
invoice or estimate to reflect special requirements.  

Note  The number of tax tables is limited to around 40 depending on other files added 
to the Prices folder. 

Example: A California business has taxable and non-taxable customers. Some 
taxable customers have different tax rates due to their government status or other 
special circumstances. The business is based in Los Angeles, and when it delivers 
jobs to customers in Orange County, a different rate must be charged. To use 
different tax rates, add an OC (Orange County) tax table and assign it to customers in 
Orange County. This tax table is also available to assign to an invoice or estimate for 
walk-in customers who reside in Orange County. 

To add a new tax table 
1. In the Sales Tax window, click New. 

 
2. In the Tax Table field, enter a name for your table. 

3. In the Abbreviation field, enter a two (2) character identifier for the new tax 
table. (This ID is used in reports and must be unique.)  

4. Enter the necessary tax information as described in “Defining the Default Sales 
Tax” above. 

5. Click Save. The new tax table is listed at the bottom of the Sales Tax window. 

Click to create a 
new tax table. 
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Note After you save a new tax table, you can change its name by double-clicking the 
name in the Tax Table column in the list at the bottom of the Sales Tax window. 
To change the abbreviation, however, you must use Table Editor to edit the Tax 
Tables table. For information about Table Editor, see page 87. 

Once the new tax table is created, assign it to each customer who uses this tax rate. To 
do this, select the tax table in the Tax Table field on the Settings tab in the Customer 
window (see page 229). 

In many places in PrintSmith you will see Tax Table set to Use Parent Tax Table. This 
means that the tax table assigned to the customer account is used, unless this was 
overridden in the invoice, parent job, or cash register.  

Line-Item Taxation 
You may find it useful to tax charges on an invoice independently – on a line item basis. 
To take advantage of line item taxation, you must select the Enable line-item taxes 
check box in the Behavior preferences panel (see page 30). 

When defining a charge, you can attach a specific tax  table to the charge in the Preset 
Info window. You can change this later when you add the charge to a job or invoice. 

When you edit a job, you can select a tax table to apply against the job (or against any of 
its charges or parts of a multi-part job) that have Tax Table set to Use Parent Tax Table. 
You can also specify a Tax Code as necessary. 

Similarly, in the Document Totals window for an invoice, you can select a tax table to 
apply against the invoice (and any of its charges or jobs) that have Tax Table set to Use 
Parent Tax Table. Each invoice can have up to five associated tax tables.  

In the Cash Register, each department button can be associated with a specific tax table 
and tax code. (See page 54.) As with an invoice, a cash register posting can have up to 
five tax tables defined. 

The PrintSmith Reference Guide provides more information about the effects of line item 
taxation in various parts of the system.  

Using Tax Codes to Differentiate Same Tax Rate 
If you find that you have several taxes that use the same rate but are for different 
institutions, counties, or other organizations, consider assigning tax codes in customer 
accounts and documents to track the different groups. Tax codes are stored in the Tax 
Codes table, which you can maintain with Table Editor. 

Example: You have three counties in your state that collect 8% tax. Create one tax 
table at 8% but enter different tax codes for the three counties for each customer and 
document. Different codes result in a report that shows the amount of sales tax 
collected for the 8% rate and subtotal for each tax code. You specify a tax code on 
the Settings tab in the Customer window. For more information, see page 229. 
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Addressing International and Other Tax Issues 
Because PrintSmith is used throughout the world, there are many options to calculate, 
report, and display taxes. International customers may require tax on tax and variable tax 
rates. Some Canadian customers need to calculate PST and then add GST on top of that 
tax. Chile also has special tax verification procedures. You must account for all these 
different tax situations. 

Using a tax rate of zero 
EFI does not recommend that you set up tax tables with tax rates of 0% to handle tax 
exempt accounts or documents. Instead, use the No Tax check box in the document 
totals area of the document totals (double-click an invoice totals box to open this) or select 
the Tax Exempt check box on the Settings tab in the Customer window. If, however, you 
want to track a certain category of sales, you can use a tax table or tax code, which is 
assigned in the customer account or on individual documents. 

Note  If you set up a 0% tax rate, the amounts are still considered taxable although no 
tax is calculated. This approach complicates the figuring of sales tax, as these 
sales are considered taxable with a zero rate tax. 

Including more than one tax rate on a document 
When you want to include more than one tax rate in a document, click the Show column 
in the Sales Tax window for each tax element you want to include. The Show column also 
applies to receipts printed with the optional receipt printer. Any additional taxes that do not 
have Show selected are grouped together in the standard tax amount. 

Multiple tax lines are computed for each document when the document is printed, and are 
not saved with the document. This means if you print an old locked document and the tax 
rate is different from when the document was last printed, the tax amounts for each line 
will not be correct, although the total amount of tax will be. 

Showing taxes with different names 
The page document preferences (Admin > Document Preferences > Page) includes a 
Print tax name from table check box. Select this check box to print the name of the table 
and descriptions from the tax table on the document where tax is normally displayed. 

Printing the tax rate on documents 
To include the tax rate percentage in a document, enter the tax rate as part of the 
description in the Sales Tax window, for example, VT 6%. 



EFI PrintSmith |  Setup Guide 

 

 
Page 102 

Hiding taxes in prices 
If you decide to hide tax, make sure you have only one tax table. Also do the following: 

1. In the Sales Tax window, select the Build tax in price check box so that prices 
are consistently shown with tax included.  

2. Choose Admin > Document Preferences. 

3. Click Page and select the Remove tax line check box. 

4. Click Body and select the Hide tax in line items check box. 

5. Click OK. 

6.  Choose Admin > Preferences > POS > Receipt. 

7. Select the Hide tax in line items check box so the receipt printer also hides tax 
in prices when it prints receipts. 

8. Click OK. 



Sales Tax or Value Added Tax (VAT) 

 

 
Page 103 

Tax on shipping 
If you need to tax shipping charges (which is common in Canada), you can specify which 
tax elements should be used to calculate the tax on shipping. When both the Tax 
Shipping and Separate Shipping check boxes are selected in the Sales Tax window, 
you can click the Ship column to select those tax elements that should be applied against 
shipping. (Click again to remove the tax element from the calculation.)  

Tip If you hold down Option/Alt while clicking the Ship column, all the fields in the 
column change to the opposite state automatically. 

If you clear the Separate Shipping check box, but Tax Shipping is selected, all tax 
elements are used to calculate taxes on shipping. 

 
  

Click to include 
or remove tax 
element from 
shipping tax 
calculation. 
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During this part of PrintSmith setup, you start to enter and modify your pricing information. 
Once this information is entered, you can test your pricing assumptions and make any 
necessary modifications. 

Charge Definitions 
Charge definitions are an extremely important part of the pricing system. PrintSmith 
supports ten different groups of charges, known as commands. The number of charges 
within each command is essentially unlimited (a combination of 4,000,000,000 charges 
and categories).  

The shipped version of PrintSmith includes six charge commands: Pre Press, Bindery,  
Merchandise, Mailing Services, Markups/Discounts, and Production. You can rename 
these to better describe your business. Four user-defined commands are also available 
for your use. 

The names of the commands give you an idea of their intended use. They can be used to 
price items such as plates, negatives, bindery, typesetting, special markups, rubber 
stamps, shipping charges – anything you sell in your business. Charges are defined as 
items usually associated with a printing or duplicating job, but can stand alone if 
necessary. You can place any charge definition under any of the commands. EFI 
recommends you group them as follows: 

• Pre Press. Any charge related to preparing a job for production should reside in 
Pre Press. Items like film, plates, typesetting, desk top publishing, and art work 
belong here.  

• Bindery. Charges associated with finishing a job and operations such as post 
press cutting, folding, scoring, drilling, stitching, padding, gathering, book 
assembly, packaging, and even shipping belong in Bindery. 

• Merchandise. Work that is always brokered out, especially if you have price lists 
from the vendor, belongs in Merchandise. Thermography, business cards, 
invitations, blueprints, letterpress work, and office supplies are examples of 
merchandise. 

• Mailing Services.  Charges related to mailing the final product(s) belong in 
Mailing Services.  

• Production. Charges related to production, for example, ink and prepress 
cutting, and so on, can be grouped under Production.  

• Markups/Discounts. Charges that reflect markups and discounts belong here. 

The most important and frequently used charge commands are Pre Press and Bindery. 
They can be attached to jobs, although they can just as easily be used alone. The 
remaining commands are designed more for invoice level charges although they can be 
attached to jobs as well. 

Charges are organized by command, category, and charge. This section explains how to 
create, manage, and organize categories and charge definitions and how to set up charge 
definitions to generate the correct price. 
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Understanding the Charge Definitions window 
All charges are managed in the Charge Definitions window. To open this window, select 
Pricing > Charge Definitions. 

The Charge Definitions window contains all charge definitions and any custom definitions. 
Commands, categories, and charges are organized in a hierarchical list in the left pane. 
You can expand and collapse this list at your convenience. Buttons for working with 
charge definitions are displayed across the top of the window. The right pane displays 
information about the selected charge.  

 
You can control the categories within each command (for example, Pre Press or 
Bindery); the charges in each category; how each charge calculates a price; how the 
charge is presented to the user in the Estimator; and even the name of the command.  

Hierarchical 
list of 
charges and 
categories. 

 

Red icon 
indicates no 
costing was 
defined. 
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The Charge Definitions window includes a toolbar of buttons. 

 

Button Description 
New When a category is selected in the list of charges, click this button to create a new 

category in the same command. When a charge is selected, click this button to 
create a new charge in the same category. 

File Click this button to save the changes you made. 

Duplicate Click this button to copy a category or charge. 
Revert 
 

Click this button to restore the information in the Charge Definitions window to the 
way it was when it was last filed (saved). 

Find Click this button to open the Find Charge window so you can locate a particular 
charge by specifying various criteria. 

Export The Export button is available only if the Enable pricing system Import/Export 
features check box is selected in the Behavior preferences panel (Admin > System 
> Behavior). Click this button to export the selected charge. If you click and hold the 
button you can select Export Selection or Export All. For more information, see 
“Sharing charge definitions among PrintSmith systems” on page 154. 

Preset Info Click this button to open the Preset Info window for the selected charge. For more 
information about how this window is used, see “Selecting a quantity type” on page 
126 and “Defining preset information” on page 146. 

Costing Click this button to open the costing window for the selected charge. For more 
information, see “Defining costing rules for charges” on page 148. 

Managing commands 
Renaming charge commands 

1. In the Charge Definitions window, click the command you want to rename, for 
example, Merchandise. The information on the right side of the window is 
replaced with a Command field. 

 
2. Enter a new name in the Command field. The change is reflected in the list on 

the left. 
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Notes  Avoid using punctuation marks in the name. In particular do not use “;”, 
“^”, “!”, “/”, or “(”. Also do not start the name with a left parenthesis or a 
hyphen.  

  EFI recommends that you not change the names of the Pre Press or 
Bindery commands as the corresponding buttons in the job window 
cannot change to match the new commands. This will be confusing. 

3. Click File to save the renamed command. (After renaming a command, you must 
save the change before you can continue to work in the Charge Definitions 
window. If you do not save the new name, the hierarchical list reverts back to the 
original name.) 

Hiding or showing a charge command in the job task list 
By default, all the defined charge commands are displayed in the job task list. If you do not 
want a command displayed: 

1. In the Charge Definitions window, click a charge command in the left pane. The 
Command field and Add command to job task list check box are displayed as 
shown above.  

2. Select or clear the Add command to job task list check box as necessary. 

3. Click File to save the change. The charge command is now displayed in the Job 
window if the check box was selected or is hidden if the check box was cleared. 

Defining a custom charge command 
Four user-definable charge commands are available. These are labeled <EMPTY 7>,  
< EMPTY 8>, < EMPTY 9>, and < EMPTY 10>. Each can be used to create a charge 
command. By default, these commands are not displayed in the job task list.  

1. In the Charge Definitions window, click one of the four custom charge commands 
in the left pane. The Command field and Add command to job task list check 
box are displayed as shown above. 

2. In the Command field, enter the name you want to use for the command.  

3. Select the Add command to job task list check box if you want the command 
included in the job task list.   

4. Click File. The newly-named command is displayed in the left pane. 

You can now add categories to your custom charge command. See “Creating a new 
category” below.  
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Managing categories 
When setting up your categories, make it as easy as possible to locate the charge you 
need. For example, have separate categories for cutting and folding but not for numbering 
and numbering with colored inks. 

When organizing categories for Pre Press and Bindery, list the categories in the same 
order as they are used (collating, binding, boxing, and delivery). Visually, the category list 
can then serve as a mental checklist. Another option is to alphabetize the category list. 

For the other commands, place frequently-used categories at the top of the list so they are 
easier to select, especially from the keyboard. When you select a category in the 
Estimator, 16 items are displayed at one time. For optimum results, make the most 
common categories the first 16 items in the list. 

Try to avoid having too many categories that contain only one or two charges. For 
example, put all folding charges together in one folding category rather than have a 
category for each type of folding. 

Organizing categories 
To organize your categories, just drag a category where you want it in the list.  

Note  Changes to the organization of the list are not visible in the Estimator until you 
save your changes and close the Charge Definitions window. 

Creating a new category 
1. In the Charge Definitions window, click the command where you want to create 

the category. (You may need to double-click to open the list of categories under 
the command.) 

2. Click New on the toolbar. The new item is displayed in the list of categories with 
a right pointing arrow and is labeled <untitled>. A Command field and a 
Category Title field are displayed in the right pane. (You cannot change the 
command name here.) 

 
3. In the Category Title field, enter a name for the new category.  

Note  Avoid using punctuation marks in the name. In particular do not use “;”, 
“^”, “!”, “/”, or “(”. Also do not start the name with a left parenthesis or a 
hyphen. 

4. Click File to save the change. 

5. If necessary, drag the category to change its place in the list.   

Renaming charge categories 
1. In the Charge Definitions window, click the category that you want to rename.  A 

Command field and a Category Title field are displayed in the right pane as 
shown above. 
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2. In the Category Title field, enter a new name for the category. 

3. Click File. After renaming a category, you must save it in order to continue 
working in the Charge Definitions window. If you do not save the new name, the 
category reverts to the original name. 

Duplicating categories 
You can duplicate a category in two ways. 

Either 

• Hold down the Option or Alt key and drag the category to a new location either in 
the same command or in a different command.  

Or 

1. Click the category that you want to copy.   

2. Click Duplicate on the toolbar. 

3. Click Yes to confirm that you are duplicating the category. 

Deleting categories 
You can delete entire categories.  

1. Click the category that you want to delete. 

2. Click Delete on the toolbar. A confirmation message appears.  

3. Click Yes to confirm the deletion. A message informs you about the number of 
charges that are affected by the deletion. 

4. Click OK. The category is deleted, and is no longer displayed in the list. 

Managing charge definitions 
Charge definitions are the individual charges that reside in a particular Category. Charge 
definitions are used in pricing, and include information that is required for pricing, such as 
rates, price lists, and minimum charges. 

There are three basic types of charge definitions: 

• Definitions that contain all the information needed to generate a price. 

• Definitions that require additional information from the user. 

• Definitions that use the job or document to which they are attached for pricing 
information. This type of charge is often referred to as “job aware” because it 
knows how to extract information from jobs to generate a price. Markups, cutting 
charges, and ink charge methods are job aware based methods. Generally, EFI 
recommends using job aware charges whenever possible because if you change 
the specifications on a job, all job aware charges immediately reflect this change, 
preventing many errors. 
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Organizing charges 
You can organize your charges just as you organize categories – drag a charge where 
you want it in the list. Like categories, you can drag a charge to a different command. 
Alternatively, drag a charge to the category list and drop it below the category to which 
you want to add the charge. In this case, the charge is added to the end of the list. 

Creating a new charge 
The following steps summarize the process for creating a charge. Subsequent sections of 
this manual provide additional information.  

1. In the Charge Definitions window, select an existing charge in the category in 
which you want to include the charge.  

2. Click New on the toolbar. A copy is made of the selected charge. 

3. In the Name field, enter a name for the newly created charge. 

4. In the Method field, select a charge method. See “Selecting the charge method” 
on page 112.  

5. Add the remaining information for the charge as appropriate. The fields you must 
complete depend on the charge method you select, as described in the sections 
that cover different types of charges and the choices available to you.  

6. Click File to save the charge. You can now drag the charge to where you want it 
in the list.   

Selecting the charge method  
The charge method has a major impact on how the charge is used, and affects all the 
other settings in the charge definition. It is therefore best to select the method first. Each 
method is designed to handle certain types of pricing situations. Most charge definitions in 
Pre Press and Bindery use one of the job aware methods—Job Aware, Fold, Markup, 
Cutting Charge, or Ink Charge. Most charge definitions in other commands use Always 
Ask. The table that follows defines the various charge methods. 

Method Definition 
  

Job Aware The Job Aware method is strongly recommended for any item for which the price 
depends on a quantity in the job to which the charge is attached. Job aware charges 
ensure the price is always correct: when a quantity in the job changes, the prices for all 
job aware charges are automatically updated. 

Markup The Markup method is similar to Job Aware and can be used when you want to mark 
up all or part of a job or an entire invoice. Anything you price by multiplying a total by a 
factor is a candidate for a markup charge. For example, to add a rush charge of 20% 
to the price of a job or invoice, a markup charge would be the ideal way to handle it. 

Flat Rate The Flat Rate method is used for items where the price never varies. For example, 
use this method if you always charge $5 for delivery. 

Always Ask The Always Ask method can be used for any charge definition, but is best suited for 
charges where the quantity is not known beforehand. You can, however, preset a 
common quantity to facilitate data entry. 
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Method Definition 

Price List The Price List method is similar to Always Ask except the price is always taken from 
a price list (which must be created and attached to the charge) based on a quantity 
that you enter. 

Rate List The Rate List method is identical to Price List except the rate for the charge is taken 
from an attached rate list. This rate is then multiplied by the quantity you enter to 
generate the price. 

Cutting Charge A Cutting Charge is a special job aware pricing method designed strictly for cutting 
charges. It makes use of the parent, run, and finish sizes in the job to which it is 
attached and takes an intelligent count of the number of cuts. For prepress cutting 
charges, you must also select the Cuts are PrePress check box. 

Ink Charge The Ink Charge method helps to estimate ink requirements and charges for ink. This 
method is a job aware type of charge with special fields and capabilities best suited for 
calculations based on coverage for a particular job. Ink Charge can be used for any 
charge that is based on square inches (or square feet). 

Shipping Charge The Shipping Charge method makes it possible to specify the shipping addresses of 
a job and price based on the weight of a job. Job level charges use the weight of a 
single job and invoice level charges use the weight of all jobs on an invoice. Shipping 
charges attached to the control job in a multipart job include the weight of all parts of 
the job in the calculation. You can override the weight in the actual shipping charge on 
a document if necessary. 

Linear  The Linear method calculates pricing based on the linear edge (perimeter) of a sheet. 
You can select which edge(s) you want to use. 

Fold A Fold charge is the same as a Job Aware charge except that you can associate a 
fold style with the charge. EFI supplies the fold styles, and you select the style you 
want when creating the fold charge. In a job that uses a charge based on the folding 
method, you will see the folding diagram. In addition, the paper cutting diagram that is 
printed with the job ticket includes the fold style. 

Square Area The Square Area method calculates pricing based on the square area of the run or 
finish size and assumes 100% coverage. 

  

 

Defining job aware charges 
When a charge is based on the Job Aware method, it is priced using information from the 
job to which it is attached. There are many types of charges where the quantities in the job 
are important.  

Examples: A folding charge is dependent on the number of sheets to be folded. 
Sheet information is available from the job if the charge is attached to it. Other 
examples are plates (number of colors and sheets), film, cutting, ink, and so on. 

Most pre press or bindery operations depend on one of the quantities in the job: folding, 
drilling, scoring, gathering, binding, and even boxing—with the notable exception of 
typesetting, which is rarely directly dependent on the quantities in the job. If you have 
standard rates per page (especially if they vary with the quantity), however, then you could 
use the Job Aware method to define typesetting charges.  
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Aside from specifying the Quantity, Sales Cat, Product Code, Fixed Spoilage, and 
other criteria for job aware charges, you must also: 

• Define which quantities are used to calculate the prices and how the quantities 
are used. 

• Indicate whether or not the charge is a Bindery Operation. 

Selecting values to be used in calculating price 

Under Select values in job to be used in calculating price, you can choose one or 
more (or no) additional factors to be considered in determining the charge: 

• Select either Ordered or Press quantities, or neither (N/A).  

• Multiply by Colors or Sides, or neither (N/A).  

• Multiply by Sheets (number of originals specified in the jobs) or Signatures (the 
number of different run sheets or sheets/up), or neither (N/A). 

• Select x Up to multiply by the number of sheets (up) produced from the run size, 
/ Up to divide by the number of sheets (up) produced from the run size, or neither 
(N/A). 

Bindery 
operation 
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Marking as a Bindery Operation 

The Bindery Operation feature provides an alternate calculation method that generates 
better results for most bindery operations, especially when large numbers of originals and 
relatively small ordered quantities are involved. The difference in the price generated by 
PrintSmith can be significant. 

Examples: 

A cutting operation has the price specified as $1.00 for each cut in sets of 500 and 
with 1 cut to each set. The first job it is being applied to is a copying job with 10 
copies of 100 originals. A second job has 500 copies of 100 originals. 

With the Bindery Operation check box selected, the price would be calculated as: 

 

Note that the generated price was the same even though in the first case 1,000 
sheets were cut and in the second 50,000 sheets were cut. The price is the same 
because cutting was first figured for the 10 copies and then multiplied by the number 
of originals. This means that 10 copies was the actual size of the set because each 
original is priced separately. 

In the second job, the number of copies and the number of sets were identical, with 
still one set per original. Since the number of originals was identical so was the price. 
Any number of copies up to 500 results in the exact same price. At 501, the price 
would double because there would be two sets for each original. 

With the Bindery Operation check box selected, the price would be calculated as: 

 

The two methods are identical when the quantity ordered (or impressions) is any 
multiple of the set size. The difference between the two methods is most apparent 
when the number ordered is less than the set size and there are multiple originals. If 
In Sets is 1 or not used, the Bindery Operation check box has no effect. 
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In general, the Bindery Operation check box should be cleared for pre press charges or 
any charge where the operation must be performed separately on each original. The 
check box should be selected for most bindery operations where more than one original 
can be processed at once (like folding or cutting). 

Defining markup charges 
Markup is also a job aware method since markup charges use other parts of a document 
to generate their price. Quantity, however, is always set to No Quantity because 
PrintSmith uses various document or job totals automatically based on the type of markup 
and the quantity is therefore not under direct user control. 

 
Markups use the same basic formula as all other charges. The quantity is the marked up 
amount. PrintSmith always supplies this quantity and multiplies it by the rate. You never 
see the rate listed, and cannot change it. A rate of 0 does nothing, a rate of 0.1 is a 10% 
markup, and a rate of -0.1 is a 10% discount. 

When customizing a markup charge, only the rate is used. You can also use the 
Minimum Charge field to define a minimum markup. The Setup and Material rates are 
ignored if you select them. You should not use In Sets for markups. 

You have a choice of four different types of markups from which to choose: Job Price, 
Charges, Entire Job, and Invoice. The type selected determines what amount is to be 
marked up using the rate contained in the charge definition (or an attached markup price 
list).  

Types of 
markup. 
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Entire Job, Job Price, and Charges markups rely on information in the job and must be 
attached to a job in order to generate a price. Invoice markups must be attached to a 
document in order to generate a price. You cannot attach a charge to a job if the charge is 
an invoice markup. Likewise, you cannot add job level markup charges as an invoice level 
charge. 

Markup types 

Job Price – This marks up only the job price (which includes production charges, but not 
pre press or bindery). 

Charges – This marks up only the charges on the job that belong to the same command 
(Pre Press or Bindery). This type of markup in Pre Press marks up all the pre press 
charges while a markup of this type in Bindery marks up all the bindery charges. 

Entire Job – This marks up the entire job price including all pre press and bindery 
charges. 

Invoice – This marks up everything in a document including markups for individual jobs 
and charges, but not including other invoice level markups, the customer discount, or 
shipping charges entered in the Document Totals window. 

You can add more than one markup to a job or document. 

Example: You could add a rush charge markup and a bid discount to the same job or 
document. Multiple markups of the same type do not interfere with one another. They 
are independent. Rush charge and bid discount both use the same amount. The bid 
discount does not discount the rush charge and the rush charge does not mark up the 
bid discount. 

Note  In addition to, or in place of, the rate, you can set up a price list for a markup that 
acts as a variable discount. In this case, the amount being marked up is used to 
look up the markup rate in the price list - a dollar-based variable discount.  
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Defining flat rate charges 
Flat rate charges are useful for items where the rate always remains the same. 

 
Flat rate charges are, by definition, fixed fees. If, for example, you charged a flat $5.00 for 
delivering an order, you could define it as a flat rate charge. You can define a Setup rate, 
Material rate, and Minimum Charge. It is best just to enter the price in the rate. You 
should not use sets with this pricing method as PrintSmith ignores them. 

If you select the Adjustable Rate check box, you can define a flat rate charge that allows 
you to change the rate instead of overriding the price. This method of changing the rate is 
recommended since a price override prevents PrintSmith from automatically updating the 
price if the document is recalculated. The rate is therefore not updated for these charges 
when a document is recalculated. 

Note  The adjustable rate feature allows users who do not have authority to perform 
overrides to enter a price directly. 
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Defining always ask charges 
Use the Always Ask pricing method for the majority of charges that do not require or 
cannot use job quantities. You supply the quantity when the charge is selected in the 
Estimator. 

 
If a charge does not need to be job aware, you can set it up using the Always Ask pricing 
method. As implied by the name, PrintSmith asks for the quantity. Decide what type of 
quantity to use (Number of Sets, Quantity, Time, No Quantity, or No. Sets and Setup). 
EFI recommends selecting Quantity (which asks for a quantity) or Time (which asks for a 
start time and stop time). If Time is selected and both a start and stop are supplied, the 
quantity is the difference between the two times. If just one time is entered, the quantity is 
that time.  

Defining price list and rate list method charges 
The Price List and Rate List methods are virtually identical. They both rely on an 
attached price list to generate a price. The only difference is how the attached price list is 
used. 

• Price List method - The attached price list is always treated as a price list 
regardless of the pricing options selected for the price list itself. 

• Rate List method - The price list is treated as a variable rate list. Instead of 
looking up the price in the price list, the system looks up the rate and plugs it into 
the standard formula for calculating price: quantity x rate = price.  
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The pricing method in the charge takes precedence over settings in the price list itself. If 
you use a price list with this method, it is treated as a rate list. 

Defining cutting charges 
The Cutting Charge method is a special job aware pricing method designed strictly for 
cutting charges. It makes use of the parent, run, and finish sizes in the job to which it is 
attached and takes an intelligent count of the number of cuts. PrintSmith records this 
count as the number of sets. In all other respects, this charge functions just like a job 
aware charge. 

Note For prepress cutting charges, you must select the Cuts are PrePress check box. 

 
Notes The Cuts are PrePress and Ignore Cuts check boxes are displayed only when 

the Cutting Charge method is selected. 
 The number of cuts for any given size combination is an estimate, and may not 

be correct. PrintSmith does not consider a number of common situations when 
calculating cuts. Among them are stacking lifts on small jobs and restrictions due 
to the size of the cutter. Trimming bleeds can require twice as many cuts as 
normal. In addition, the cuts often require extreme precision. You may want to 
add a bleed cut charge by doubling the rate and setup, lowering the lift size 
somewhat, and accepting what PrintSmith estimates for the number of cuts. 
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Defining ink charges 
Ink Charge is a special pricing method designed to calculate the amount of ink used in a 
job. It uses the run size of the stock and a percent of coverage to estimate the number of 
pounds of ink required. 

 
Note When you select the Ink Charge method, notice that the Rate field changes to 

Price/lb. and the Sets field to Cover/lb. 
Enter the retail price for each pound of this ink and estimate the number of square inches, 
100% covered, by that pound.  

Note  For ink to be calculated correctly, you must specify stock sizes in the same unit 
of measure as Cover/lb. 

The percent of coverage and the run size of the sheet are used to determine the total 
number of square inches to be covered. When divided by the coverage per pound, the 
result is the estimated quantity of ink that is needed for the job. The formula used to 
calculate the charge is: 

 

Rate field 
changes to 
Price/lb for 
ink charges. 

 
Sets field 
changes to 
Cover/lb for  
ink charges. 
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The important fields in the ink charge pricing method are Price/lb (selling price for one 
pound of ink) and Cover/lb (the number of square inches solidly covered by a pound of 
ink).  

Your coverage will vary with the type of stock, type of ink, and press. You can obtain 
coverage figures from your vendor or from the ink packaging. For example, typically a 
pound of standard black ink covers 750,000 square inches. 

When the charge is added to a job, normally just the estimated percent of coverage on a 
page is entered. PrintSmith calculates the amount of ink. 

 
You can also enter the number of pounds of ink directly and PrintSmith calculates the 
percentage of coverage. The number of pounds of ink determines the price of the job. 

The following table can be useful in estimating the amount of coverage on a page. 

Type of Page Coverage % 
  

Light composition 15 

Normal composition 20 

Normal composition, bold paragraph heads 25 

Medium composition 35 

Heavy composition or halftones 50 

Solids 100 
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Reverses 60-90 

Process color 20-50 
  

 
Defining shipping charges 
The Shipping Charge method provides the ability to specify the shipping address of a job 
and price based on the weight of a job. Job-level charges use the weight of a single job, 
and invoice-level charges use the weight of all jobs on an invoice. Shipping charges 
attached to the control job in a multi-part job include the weight of all parts of the job in the 
calculation. You can override the weight in the actual shipping charge on a document if 
necessary. 

 
The shipping price is based on the weight multiplied by a rate. Pricing can be set up by: 

• Using the rate to multiply the calculated shipping weight. 

• Using a markup that multiplies the rate. 

Using shipping charges on a document 

When you add the shipping charge to a document, you can select the Ship Via method 
and the Ship To shipping address and override the shipping weight. 
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Shipping ticket 

When a document contains a shipping charge, a shipping job ticket page is printed that 
details the shipping charge information. 

Defining linear charges 
A Linear charge calculates pricing based on the linear edge (perimeter) of a sheet. When 
you add the charge to a job, you can select which edge(s) you want to use for pricing. 

For a linear charge, you can also specify a Base Linear Quantity, or starting point. For 
example, if you have a grommet every six inches, you also need one at the starting point. 
This field allows you to specify that starting point. 
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Defining fold charges 
A Fold charge is the same as a Job Aware charge except that you can associate a fold 
style with the charge. EFI supplies the fold styles, and you select the style you want from 
the Fold Style field when you create the fold charge. In a job that uses a charge based on 
the fold method, you will see the folding diagram. In addition, the paper cutting diagram 
that is printed with the job ticket includes the fold style. 

Tip You can manage fold styles, for example, change their names, with Admin > 
Fold Templates. 
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Defining square area charges 
The Square Area method calculates pricing based on the square area of the run or finish 
size and assumes 100% coverage. (This method is similar to the ink charge method 
except that the coverage is always 100%.) 

 
Selecting a quantity type 
The Quantity field in the Charge Definitions window can be set to a number of different 
quantity types. Not all of the types are available with each pricing method. 

A change to the quantity type affects how quantities are entered, but does not directly 
change the price. You can enter a quantity as Time or as Quantity, and the same price is 
generated. For example, you can enter two hours as time or as a quantity. It is more 
involved, however, to convert something like an hour and fifteen minutes (1:15 as time) to 
1.25 hours, which is why the time quantity is useful.  

The sections that follow illustrate each quantity type using the Preset Info window to 
demonstrate what the quantity looks like when the charge is actually used. 

Tip To open the Preset Info window, click Preset Info on the toolbar of the Charge 
Definitions window. For more information about other fields in the Preset Info 
window, see “Defining preset information” on page 146. 
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Number of sets 

Normally, the Number of Sets quantity type is only used with job aware charges. The 
price is based on basic totals from the job and then multiplied by a user-entered quantity. 

 

Example: The charge is 3¢ for each staple. A job aware charge can determine how 
many “sets” need to be stapled together if each set has a single staple. To set up a 
charge that can be used for any number of staples, set the Quantity to Number of 
Sets. In this example, a single staple is being priced. If you change Qty/Set to 2, the 
price is calculated for 2 staples by multiplying by 2. 

PrintSmith figures out the standard quantity, which gets multiplied by a user-entered 
Qty/Set. If there is a setup charge in the definition, the setup is only added once.  

A Number of Sets quantity is not normally used in always ask charges because it would 
be multiplying a user-entered quantity by a quantity that is normally a user-entered 
charge. Users cannot enter the standard quantity with the Number of Sets quantity 
method so the quantity would need to be already preset in the charge definition to work. 
Set this up by first setting the quantity type to Quantity, click Preset Info to set the 
quantity, change the quantity type to Number of Sets, and click Preset Info again to set 
the quantity to 1. EFI is unaware of any value to this type of setup; it is almost always 
easier to just use the Quantity type for always ask charges. 
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Note  Always use Preset Info with the Number of Sets quantity type to ensure the 
default quantity is 1 (or the most commonly-used quantity) so a price is 
generated when the charge is first selected. If the quantity is left set to 0, no price 
is generated until you enter a quantity. 

Quantity 

Quantity is the most common quantity type. It is appropriate for any job aware charge 
except for markups and flat rate.  

 
The quantity that you enter is multiplied by the rate for the price. If the method is set to 
Job Aware, the quantity is calculated automatically. 
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Time 

Time is useful for defining charges when the price is based on hourly rates.  

When you use a Time quantity you provide a start and stop time instead of a single value.  
Follow these guidelines when entering the time: 

• Use the format hh:mm (hours and minutes).  

• Use a colon (:) or decimal point to separate hours and minutes.  

• Note that 1.3 is interpreted as 1 hour and 3 minutes and 1.30 is 1 hours and 30 
minutes.  

If you enter both a start and stop time, the quantity is the difference between the two. If 
you enter only one time, PrintSmith assumes this is the total time. The quantity displayed 
for the job is always in decimal hours. For example, 1 hour 30 minutes is shown as 1.5 
hours. 

Note PrintSmith understands that a 9:00 start time and a 4:00 stop time means 7 
hours, but you can also use AM and PM for further clarification, or enter the time 
in a 24-hour (military) format. 
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No Quantity 

No Quantity is equivalent to using the flat rate pricing method. It is only appropriate for 
the flat rate or always ask pricing methods. 

 

No. of Sets and Setup 

Number of Sets and No of Sets and Setup are used when you want to enter a multiplier 
for the entire charge. Both function identically. The only difference is in how setup charges 
are handled. In Number of Sets, the setup charge is added only once. In No of Sets and 
Setup, the setup charge is added to each set. 

Example: No of Sets and Setup is useful for drilling charges where you require a 
single charge that can be used for any number of holes and a setup charge for each 
hole. Enter the number of holes. PrintSmith calculates the normal quantity, adds 
setup, and then multiplies this by the quantity entered for the number of sets. Always 
use Preset Info to preset at least 1 in the Qty/Set field. 0 in the Qty/Set field results in 
a price of 0.00 unless there is a setup charge. 

Specifying other options 
Many additional options are available in the Charge Definitions window for handling 
special circumstances and enforcing how a particular charge is used in the Estimator. 



Defining Pricing 

 

 
Page 131 

No overrides 
When the No overrides check box is selected in the Charge Definitions window, nobody 
can override the quantity or price in the charge. A change to the quantity is treated as an 
override in job aware charges because PrintSmith generates the quantity automatically. 

Adjustable sets 
When the Adjustable sets check box is selected in the Charge Definitions window, you 
can change the set size on charges in the Estimator. This allows you to enter the number 
of sheets per lift in a cutting charge on the estimate. This check box should be cleared 
most of the time. 

Adjustable rate 
When the Adjustable rate check box is selected in the Charge Definitions window, you 
have the flexibility of changing the rate for a charge. In this case the Rate field is displayed 
in the Preset Info window. 

 
The Adjustable rate check box also affects how charges are handled when a document 
is recalculated or copied and prices are updated. PrintSmith assumes that the Adjustable 
rate setting is used for charges where you frequently change from the defined rate, and 
just use the rate in the charge as a starting point. When a charge with an adjustable rate is 
reloaded in the Estimator, the rate is left unchanged. 

Note If you select the No overrides check box as well as the Adjustable rate check 
box, the rate is displayed but you cannot change it. 
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Adjustable material 
The Adjustable material check box in the Charge Definitions window is rarely selected 
because a material rate is extremely rare. Like Adjustable rate, it allows you to change 
the material rate in the Estimator. 

You should only specify a material rate in the unusual case where you need more than 
one rate and more than one quantity. 

Selecting the Adjustable material check box does not guarantee the material rate can be 
changed because there is room for a limited number of fields and this option has the 
lowest priority. Always use Preset Info to make sure that the Material field is present. 

Adjustable Up 
The Adjustable up check box is available when you use multiply or divide up to calculate 
charges using job aware or ink charge methods. When the Adjustable up check box is 
selected, you can change the number up within the job itself, if necessary. 

Do not discount 
When the Do not discount check box is selected, charges (such as postage or shipping 
charges) are not affected by customer and markup discounts. This type of charge is 
shown in the Invoice window with ∆ next to the price. 

Hide price only 
When the Hide price only check box is selected in the Charge Definitions window, the 
price is hidden in the invoice, but the charge description is still displayed. This is different 
from the Hide charge in printouts check box (see below), which hides both the charge 
description and the price.  

Note You can also choose to hide prices from the Update Charge window. 

Hide charge in printouts 
Not all charges need to be included in the document (invoice and estimate) printouts. To 
hide a charge (not include it in a printed document), select the Hide charge in printouts 
check box in the Charge Definitions window. Hidden charges are underlined. 

Warning If a charge definition marked as hidden is added to a document as an invoice 
level charge, it will be displayed (unless it is a markup). PrintSmith only allows 
job level charges and invoice level markups to be hidden and displays 
charges that are not allowed to be hidden because of how they are used. 
When this happens, PrintSmith warns you. 

Excluded from workflow 
When the Excluded from workflow check box is selected in the Charge Definitions 
window, the charge is not displayed in the Tracker or Scheduler windows. 
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Tracker Pre-Production 
When the Tracker Pre-Production check box is selected in the Charge Definitions 
window, work can be done on an invoice before the job is released to production. 

Ignore global price changes 

When the Ignore global price changes check box is selected in the Charge Definitions 
window, the charge is not affected by global pricing updates done in the Change Prices 
window. For example, a 10% markup charge is not affected by a price increase, which 
could result in incorrect functionality. 
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Using Cost Plus pricing 
Cost Plus pricing is based on the actual costs to purchase, set up, and maintain the 
charge, as described in the Costing window for that charge (click Costing on the toolbar 
in the Charge Definitions window). When you select Cost Plus, you can set a Markup 
value that will “float” with the costs. As a result, when the costs change, you are still 
adding the same markup and thus will always make a profit. The Sale Price per Unit field 
shows the cost plus the markup. 

The other pricing options are categorized as Piece Pricing, and are described below. 

Note If you are upgrading from a PrintSmith version prior to 8.0, all existing charges 
will default to use Piece Pricing. You must explicitly set up Cost Plus for each 
charge to take advantage of this feature. Not all pricing methods give you the 
option to use Cost Plus. 

Minimum charge and time options 
A Minimum Charge guarantees that the price generated for the charge is never below the 
minimum entered in this field.  

You can also use Minimum Time to set the shortest possible time allowed. For example, 
you may require a charge of at least 30 minutes for computer time.  

 

Entering piece pricing data 
The pricing data entry portion of most charges is identical except for cutting charges and 
ink charges. When Piece Pricing is selected in the Charge Definitions window, several 
settings affect pricing. Each check box has a field to its right. If a check box is selected, its 
corresponding field is used for pricing. (Not all the check boxes are available for all pricing 
methods.)  

 
If you clear a check box after entering a value in its associated field, the value is hidden 
but not deleted. 

Setup A setup charge is added to the standard price. It modifies the basic formula as 
follows: (quantity x rate) + setup = price. 

Rate This is the primary rate used for charges. The Rate field is used in the majority of 
charge definitions. Alternatively, you can use a rate list to define a variable rate. 
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In Sets When the rate you enter is for a quantity other than 1, you must specify the unit 
quantity. To enter a price such as 12.00 per thousand, enter 12 in the Rate field and 
1000 in the In Sets field. 

Material Occasionally, you may encounter a pricing situation where you need more than one 
rate to price an item correctly. Normally, this would only occur on a job aware charge 
where two different In Sets are needed. Otherwise, you should simply add the rates 
together and enter them in the Rate field. 

Note  Material should be used in conjunction with Rate. If there is only one rate, 
it should always be Rate. Never use Material instead of Rate. 

In Sets When the material rate you enter is for a quantity other than 1, you must specify the 
unit quantity. For example, to enter a price such as 12.00 per thousand, you need to 
enter 12 in the Material field and 1000 in the In Sets field. 

Many people communicate prices in sets (for example, folding is 12.00 per 1000), but they 
actually charge for the service on a per piece basis (for example., 0.012 each rather than 
12.00 per 1000). The difference is important. In the following table, 1001 folded would cost 
$24.00 (2 sets) if priced by the set, and 12.01 if priced per piece. You may want to price in 
units of 10 or, in some cases, of 100. 

                   Prices Using Different Set Sizes 
Quantity 
Ordered $12.00 per 1000 $1.20 per 100 $0.12 per 10 $0.012 each 

     

100 12.00 1.20 1.20 1.20 

250 12.00 3.60 3.00 3.00 

275 12.00 3.60 3.36 3.30 

1000 12.00 12.00 12.00 12.00 

1001 24.00 12.12 12.12 12.01 

1100 24.00 13.20 13.20 13.20 

2000 24.00 24.00 24.00 24.00 
     

Using price lists for added flexibility 
Price lists add much flexibility to charges. You can add a price list to any charge, even if 
the pricing method does not require one. These price lists let you set up a job aware 
charge so that the rate changes with the quantity. 

In the Charge Definitions window, you use the Price List button to attach, detach, delete, 
and create new price lists. You do not need to create a unique price list for each charge 
definition. A price list can be shared by any number of charges. 

If you are creating a price list for use by a single charge definition, EFI recommends that 
you use the name of the charge as the name of the price list. Also avoid having price lists 
with the same name because this makes it very difficult to figure out which price list to 
use. 
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Assigning price lists in the Charge Definitions window 
You can assign a price list to a specific charge: 

1. Click the charge in the list in the left pane. The selected charge is highlighted and 
the details of the charge are displayed on the right. 

2. Click Price List at the bottom of the Charge Definitions window. A window  with 
the available price lists opens. 

3. Click the price list you want to use. 

4. Click Select. The selected price list is now displayed to the right of the Price List 
button. 

Note  Remember to update the charge definition by clicking File on the toolbar in the 
Charge Definitions window.   

Creating a price list 
You can create an unlimited number of price lists. You can probably, however, operate 
with just a few since you can assign the same price list to more than one charge definition.  

Tips You can copy an existing price list and then modify it: when a price list is open, 
choose File > Save As to copy it and give it a new name.  

 It is easier to manage changes to a price list if it is only used once, but this is not 
always appropriate. For example, if you are setting up a series of charges that 
are priced the same way except that a different setup or minimum is used on 
each charge, it makes sense to use the same price list for the charges. Also, if 
you are setting up a standard discount table that is to be applied to a class of 
charges such as book binding, a single price list is much easier to manage. 

To create a price list 
1. Click Price List at the bottom of the Charge Definitions window. A window  with 

the available price lists opens. 

 
2. Click New. The Price List window opens. 

Assign selected price list. 

 

Clear assignment. 

 
Create new price 
list. 

 

Deleted 
selected 
price list. 

Close window without 
performing an action. 
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3. In the Title field, enter a name for the price list. If the price list is for a specific 

charge, EFI recommends that you use the same name as the charge. 

4. Select Amount is Currency if you want to enter a price for each quantity in the 
price list; select Amount is Percent if you want to enter a percentage for each 
quantity. (Typically, your selection here only affects the appearance of the price 
list, not on the generated price.)  

5. Select the Interpolate check box if you want PrintSmith to calculate intermediate 
prices in the ranges you specify. 

Example: You set up a book binding charge and, for each book, you want to charge 
$3.00 for 10 or fewer books, $2.75 for up to 50, $2.50 for up to 100, and $2.00 after 
that. You would set up a rate list without interpolation as follows: 
 Quantity Price 
   10 3.00 
  50 2.75 
  100 2.50 
  101 2.00 
If the Interpolate check box is selected, the rate for book jobs between 10 and 100 
changes because PrintSmith calculates intermediate rates or prices for quantities that 
fall between the price list quantities. For example, 75 books will use a rate of $2.875. 

6. If you selected Amount is Currency, select the Last Line is Add’l Quantity 
check box if you want to add an amount to adjust the price for quantities that are 
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greater than the last line in the price list. When this check box is selected, the last 
line in the price list is used when the quantity exceeds the last item.  

7. Select the Ignore global price changes check box if you do not want the charge 
to be affected by global pricing updates done in the Change Prices window. For 
example, a 10% markup charge would not be affected by a price increase, which 
could result in incorrect functionality 

8. Enter the quantities and prices or percentages: 

• Enter up to 15 (and at least 2) different quantity and price combinations. As 
the quantity increases, so should the price. 

• Enter the quantities sequentially so the smallest quantity is first in the list.  
The maximum quantity does not need to be the largest quantity you will ever 
use. When the quantity in the job is larger than the largest value in the price 
list, the last price in the list is used. 

• Use the Tab key to move between columns and Return to move to a new 
line.  

 
9. Click OK. 

The first 0 
quantity 
indicates the 
end of the 
list. 
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Types of price lists 

The following table defines the various types of price lists available. The type (A, B, C, or 
D) is just used for illustration and is referenced on the next page. 

Type Purpose Select 
   

A Add an amount to the price of the charge Amount is Currency 
Last Line is Add’l Qty 

 Determine the price of the charge Amount is Currency 
Last Line is Add’l Qty 
In the charge definition, 
clear the Rate check box. 

B Determine rate based on quantity (for example, 1 for $5, 10 
for $4 a piece, 20 for $3.50 a piece) and add it to the price 
of the charge. 

Amount is Currency 
Use as Rate List 

 Determine rate based on quantity (for example, 1 is $5, 10 
is $4 a piece, 20 is $3.50 a piece) 

Amount is Currency 
Use as Rate List 
In the charge definition, 
clear the Rate check box. 

C Function as a markup or discount table that modifies the 
price of the charge based on the quantity. 

Amount is Percent 
Use as Rate List 

D Markup or discount the price of the job to which the charge 
is attached based on the quantity of the job. This should 
only be used for job aware charges because the quantities 
in the job are needed to look up the discount rate. 

Amount is Percent 
Use as Rate List 
Production Discount 
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Using price lists with different pricing methods 

Each charge pricing method uses price lists differently in terms of the quantity used to look 
up a price and what is done with the price that is found. The table below discusses these 
issues. 

Method Uses 

Job Aware The lookup quantity depends on the charge specifications. If only material is used then 
the lookup quantity is sets x runs x originals, where sets is calculated using the 
material set count. If rate is also used, the same calculation is performed using the rate 
set count and the material is ignored. If the quantity specified in the charge definition is 
Number Of Sets or No. Sets and Setup, the number of sets also multiplies this 
amount. The most important use of price lists with job aware charges is to vary the 
price with the quantity, in effect, to provide a quantity discount. Types A, B, C, and D 
price lists are all recommended. 

Markups Lookup quantity is the job price, prep, bindery, production totals, the entire job or the 
entire amount of the invoice depending on what type of markup it is. Type B and C are 
recommended; types A and D are not. 

Flat Rate A price list should not be used with this type of charge.  

Always Ask The lookup quantity is the number of sets. The quantity is calculated using the set 
count and the user entered quantity. Types A, B, and C are recommended as needed; 
type D is not. 

Price List Forces the attached price list to type A. 

Rate List Forces the attached price list to type B. 

Cutting Charge This method is calculated exactly the same as job aware charges. The only difference 
is that Qty/Set is set to the estimated number of cuts before processing as a standard 
job aware charge. If the charge definition is in the Pre Press command, it calculates 
cuts from the parent size to the run size. If it is in the Bindery command, it calculates 
cuts from the run size to the finish size. The lookup quantity is the number of lifts per 
cut. For example, if Sheets Per Lift is 500, quantity ordered is 1000, and number of 
cuts is 3, the lookup quantity is 2 (because there are 2 lifts of 500 each). All types of 
prices lists can be used, but type B is best for variable rate cutting. 

Ink Charge The number of pounds is used for the lookup (rounded up for fractional pounds). All 
types of prices lists can be used, but type B is best for variable ink charges. 

Shipping Charge The weight of the associated job or document. 

Linear The same as Ink Charge except it calculates the linear area rather than the square 
area. 

Fold The same as Job Aware. (The only difference is that fold diagrams are included.) 

Square Area The same as Ink Charge with the number of square units used to look up the price. 
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Modifying a price list 
You can modify a price list once it is assigned to a charge. (If it is not assigned to any 
charge yet, you must assign it to one at least temporarily.) 

1. In the Charge Definitions window, click the name of the assigned price list. (The 
assigned price list is displayed to the right of the Price List button.) The Price 
List window opens. 

2. Make your changes and click OK to save them. 

Note  Keep in mind that the price list may be used by other charge definitions; any 
changes you make will affect those charges, too. 

Removing a price list from a charge 
If you no longer want a price list to be associated with a charge, you can remove it. 

1. When the charge is displayed in the Charge Definitions window, click Price List. 

2. In the window listing all the price lists, click Clear.  

3. Click File on the toolbar of the Charge Definitions window to save the change.   

Changing the selected price list 
1. When the charge is displayed in the Charge Definitions window, click Price List. 

2. In the window listing all the price lists, select a different price list and click Select.  

3. Click File on the toolbar of the Charge Definitions window to save the change.   

Changing the name of a price list 
You can change the name of a price list once it is assigned to a charge. (If it is not 
assigned to any charge yet, you must assign it to one at least temporarily.) 

Note  When you change the name of a price list, the name is automatically changed in 
all charge definitions that use the price list.   

To change the name of a price list 
1. In the Charge Definitions window, click the name of the assigned price list. (The 

assigned price list is displayed to the right of the Price List button.) The Price 
List window opens. 

2. In the Title field, enter a different name for the price list. 

3. Click OK. 
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Deleting a price list 
If you no longer want to use a price list, you can delete it.  

Caution  A price list may be used by more than one charge definition. Before deleting a 
price list, make sure it is not being used by any other charge definition. 

To delete a price list  
1. In the Charge Definitions window, click Price List.  

2. Select the price list and click Delete. 

3. Click Yes to confirm the deletion. 

Waste charts and charge definitions 
PrintSmith includes a system-wide waste chart that is used automatically unless you 
create other waste charts and assign them to your charges. Different types of charges 
may have different spoilage characteristics so you may need more than the default 
system-wide waste chart.  

Default waste chart 
When estimating printing, you need to estimate waste. The default waste chart is used 
automatically when generating a price unless you specify a different waste chart. You can 
have as many waste charts as you like but only one system default. The default waste 
chart defines the waste amount for each printing job, unless the charge or press has 
another waste chart assigned. When creating charge and press definitions you can select 
different waste charts for each charge or press. 

1. On the Pricing menu, click Waste Chart. 

 
Tip  Click a point on the graph to see the percentage of waste and numbers 

of sheets wasted.  
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2. Enter your standard (default) waste assumptions by dragging the points on the 
line or by clicking Enter Data and typing the information into the table. 

Note Set the waste assumptions for your normal waste. Do not include run up 
or fixed waste because that information is defined in press definitions.  

3. Click OK to save the data. 

Managing waste charts 
The procedures for managing waste charts are nearly identical to those for price lists. You 
create a waste chart and then assign it to a charge definition. Once a waste chart is 
assigned to a charge definition, the name of the waste chart is displayed to the right of the 
Waste Chart button. 

You can create and modify waste charts, change the waste chart assigned to a charge, 
and delete waste charts altogether. 

Creating a waste chart 
Create as many waste charts as you like. You can define a waste chart for each charge, 
but you can probably operate with just a few waste charts since you can assign the same 
waste chart to more than one charge definition. 

To create a waste chart 
1. In the Charge Definitions window, click Waste Chart. A window listing all existing 

waste charts opens. 

 
2. Click New. The Waste Chart window opens. 

Assign selected 
waste chart 

 
Clear assignment 

 

Create 
new waste 

chart 

 

Delete selected 
waste chart 

 

Close window 
without 
performing an 
action 
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3. In the Title field, enter a name for the waste chart. If you are creating a waste 
chart for a specific charge, you may want to use the name of the charge for the 
waste chart. 

Note The settings on the right side of the Waste Chart window are pre-
defined and cannot be changed. The Interpolate check box is selected 
so PrintSmith calculates intermediate values if the run length being 
looked up does not exactly match a run length in the waste chart. The 
result is a smooth curve. 

 
4. Complete the Run Length and Spoilage percentages as follows: 

• Complete all 15 rows. 

• Make sure the run length increases from top to bottom and the spoilage 
percentage decreases in small increments. That maximum run length does 
not need to be the largest you will ever run. When the quantity in the job is 
larger than the largest value in the waste chart, the last percentage in the 
chart is used. 

• Avoid decreasing the number of wasted sheets on longer runs. 

Tip To print a waste chart, choose File > Print. 
5. Click OK. 

Assigning waste charts to charge definitions  
You can assign waste charts to specific charges: 

1. Select a charge in the left pane of the Charge Definitions window.  

2. Click Waste Chart. A window opens and lists all the available waste charts. 
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3. Click a waste chart.  

4. Click Select. The name of the selected waste chart is now displayed to the right 
of the Waste Chart button. 

Modifying a waste chart 
You can modify a waste chart once it is assigned to a charge. (If it is not assigned to any 
charge yet, you must assign it to one at least temporarily.) 

1. In the Charge Definitions window, click the name of the assigned waste chart. 
(The assigned waste chart is displayed to the right of the Waste Chart button.) 
The Waste Chart window opens. 

2. Make your changes and click OK to save them. 

Note  Keep in mind that the waste chart may be used by other charge definitions; any 
changes you make will affect those charges, too. 

Changing the selected waste chart 
1. When the charge is displayed in the Charge Definitions window, click Waste 

Chart. 

2. In the window listing all the waste charts, click a different waste chart and click 
Select.  

3. Click File on the toolbar of the Charge Definitions window to save the change. 

Changing the name of a waste chart  
You can change the name of a waste chart once it is assigned to a charge. (If it is not 
assigned to any charge yet, you must assign it to one at least temporarily.) 

Note  When you change the name of a waste chart, the name is automatically changed 
in all charge definitions that use the waste chart.   

To change the name of a waste chart 
1. In the Charge Definitions window, click the name of the assigned waste chart. 

(The assigned waste chart is displayed to the right of the Waste Chart button.) 
The Waste Chart window opens. 

2. In the Title field, enter a different name for the waste chart. 

3. Click OK. 
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Defining preset information 
The Preset Info window is used for several functions such as customizing the prompts to 
describe the data to be entered more clearly, pre-loading the most common quantity on 
charges that are not job aware, selecting a tax table for a charge (if you are using line-item 
taxation), and testing pricing. 

Notes  Changes made in the Preset Info window are not permanent until you click File in 
the Charge Definitions window. 

 Do not use the Preset Info window to test pricing for job aware charges. There is 
no job to pull information from, and the charge has no source for the information 
it needs to calculate a price. 

To open the Preset Info window, click Preset Info in the toolbar of the Charge Definitions 
window. 

 
Setting options in Preset Info window 
In the Preset Info window you can indicate if pricing is finished for the charge definition, 
whether the item is taxable, if the job is brokered, and if the quantity should be displayed. 
In addition, if you are using line-item taxation, you can select a tax table for the charge if 
you do not want to use the parent tax table. (The parent tax table is the one selected for a 
customer account unless it is overridden in the invoice or parent job.)  

The Preset Info window is the only place where you can change these settings. 

• Select the Finished check box to mark charges whose pricing is not yet 
complete. In this case, ? is displayed in the document window’s Total column for 
the charge. 
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• Each line item on a document can be marked as taxable or nontaxable. Select  
the Taxable check box to preset the tax status of each charge. This check box 
should be cleared only for those items that are never taxed, since it can easily be 
changed in the Estimator.  

• Select the Brokered check box to mark jobs and charges that were sent out for 
production. In this case, B is displayed in the document window’s Total column. 
(The B is never printed on invoices or estimates.) 

• Select the Display Quantity check box when all you want on the invoice is the 
name of the charge and perhaps the price. This check box is usually selected. 

• Each charge definition has a Description and a Notes field. Select the Show 
Notes check box if you want the contents of the Notes field added to the 
description in the document. Clear the check box if the Notes field is used for 
instructions on how to use the charge or information intended for production 
personnel. 

• By default, the parent tax table is associated with the charge definition (This is 
the tax table assigned to a customer account unless it was overridden in the 
invoice or parent job.) If you are using line-item taxation, you can select a 
different tax table in the Tax Table field. For information about creating and 
managing tax tables, see “Sales Tax or Value Added Tax (VAT)” on page 95.  

Note For line-item taxation to be in effect, the Enable line item taxes check 
box must be selected in the Behavior preferences panel (Admin > 
System > Behavior). See page 30. 

Customizing labels in Preset Info window 
Another important use of the Preset Info window is to customize the labels for data entry 
fields so that they are more intuitive. PrintSmith supplies a set of generic labels for each 
data entry field. Because they are generic, they do not necessarily describe the data that 
is required of the user. Different labels can decrease the amount of time it takes to train 
people to use charges in the Estimator. For example, the meaning of Qty/Set may not be 
apparent to a user, while Staples makes it clearer what is required.  

To customize labels 
1. When a particular charge is displayed in the Charge Definitions window, click 

Preset Info. 

2. Change the labels of any fields listed in the bottom part of the window. For 
example, you may prefer % Coverage to Pct. Coverage. 

3. Click Change to save the custom labels or click Don’t Change to revert to the 
previous labels. 
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Previewing preset information as it will appear in the Estimator 
You can preview how a charge is displayed in the Estimator when it is actually used. You 
can also test the pricing. 

1. When in the Charge Definitions window, hold down the Option or Alt key when 
you click Preset Info. The Preset Info window opens in preview mode, which is 
exactly the same as the charge is shown in the Estimator. In this mode, you 
cannot edit any values. 

2. To test the pricing, enter a quantity and press Tab. The price is displayed in the 
Price field. 

Note  If you test the pricing on a job aware charge, it looks like you are 
overriding the quantity. This override is temporary. When the charge is 
saved, the override is removed. No useful purpose is served by 
overriding a job aware charge; it prevents the charge from functioning 
as designed. Use always ask charges if you need to preset a quantity 
on every job. 

Entering quantities in Preset Info window 
If a charge typically has a common quantity, you can preset that quantity so that the user 
does not need to enter it. A preset quantity does not, however prevent the user from 
entering a different quantity. 

Defining costing rules for charges 
You can define costing for a specific charge: 

1. In the Charge Definitions window, click a charge in the left pane.  

2. Click Costing on the toolbar. A window opens with the name of the charge in the 
title bar. 

PrintSmith determines the last time the charge was costed in the Estimator and 
provides that information to serve as a starting point. 

Note  If the charge was not costed, a no costing  icon is displayed to the 
left of the charge name in the left pane, No Cost is the default Costing 
Method, and Status is New. 

3. Select a Costing Method: No Cost, 100% Cost, Unit Cost, or Time and 
Materials. Certain fields and buttons become available depending on your 
selection.  

4. Complete the window as described for the different costing methods below. 
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Defining unit costing 
You can define unit costing by:  

• Entering a Setup Cost (if any).  

• Entering a Unit Cost, the cost of performing one unit of the charge.  

Using a rate table to define unit cost 

You can also use a rate table to define unit cost.  

 

To use a rate table to define unit cost 
1. In the Costing Method field, select Unit Cost. 

2. Click Rate. 

2. Click a rate table.  

3. Click Select. The selected rate table is displayed to the right of the Rate button 
and Unit Cost is automatically set to Variable. 

The Rate button 
is available when 
Unit Cost is 
selected. 
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Creating a costing rate table 

If you need a new rate table when defining unit cost, you can create the rate table.  

1. While defining the unit cost, click Rate. 

2. In the window of available rate tables, click New. An Untitled Price List window 
opens. 

 
3. Clear the Last Line is Add’l Quantity check box. 

4. Select the Use as rate list check box. The Price column is relabeled Rate. 
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5. Enter the Quantity and Rate information. 

6. In the Title field, enter a name for the rate table. 

7. Click OK. The newly created rate table is listed the next time you access the list 
of available tables. 

Defining time and materials costing 

1. In the Costing Method field, select Time and Materials. 

2. Enter the cost of Fixed Materials, which is a one-time material cost for the whole 
process. 

3. Enter the cost of Unit Materials, which is the cost of the material for performing 
one unit of the charge, for example, plate material for a plate charge. 

4. Enter the Labor Rate. 

5. Enter the Setup time in minutes. 

6. Enter the number of Pieces/Hour. Note that you can enter a fraction in this field. 

Note After you complete steps 2 through 6, the Total unit cost is displayed. This is a 
summary of the labor and material rates. If you are using Cost Plus, it is also the 
basis for calculating the Sales Price per Unit. 



EFI PrintSmith |  Setup Guide 

 

 
Page 152 

Using a costing speed table to define time and materials 

When the Costing Method is Time and Materials, the Speed button becomes available, 
and you can assign a speed table.  

To assign a speed table 
1. In the Costing Method field, select Time and Materials. 

2. Click Speed. A window opens and lists all the available speed tables. 

3. Double-click the speed table you want to use (or select the speed table and click 
Select). The name of the selected speed table is displayed to the right of the 
Speed button. 

 

The Speed button is 
available when Time 
and Materials is 
selected. 
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Modifying charges 
To modify an existing charge, select it in the left pane of the Charge Definitions window, 
modify the definition, and click File. 

Note  When you first get started, you may make frequent changes. Once PrintSmith is 
running, use caution when changing charge definitions. 

It is easier to create a new charge than to completely change how an existing charge is 
used. When PrintSmith updates charges to use current pricing in a document, it locates 
the charge definition using an internal serial number assigned to the charge when it was 
created. When the charge is located, its current definition is copied to the charge in a 
document. If you reuse an existing charge definition, PrintSmith still updates the charge 
using the current definition. This practice could cause confusion, and should be avoided. 

Example: A folding charge, originally defined at 1¢ per sheet, is changed to die 
cutting at $25.00 each. When PrintSmith updates the pricing on an invoice, it changes 
the pricing for the folding charge to die cutting. The text of the original invoice, 
however, still indicates a folding charge.  

When PrintSmith updates charges, it compares the name of the charge in the document to 
the name of the charge definition. If they do not match, PrintSmith shows both the old and 
new names, and asks if you still want to update the pricing on that charge. For this reason, 
you should try to name your charge definitions exactly as you want them to be printed on 
an invoice or job ticket. Where possible, use the Notes field to modify the charge 
description without changing the name. 

It is perfectly acceptable to change a charge definition because you changed how the 
charge generates a price. If you need a new charge, however, always add a new 
definition; never reuse an existing definition. 

Duplicating charges 
You can duplicate or copy charges several ways. The easiest method is to hold down the 
Option or Alt key and drag the charge to a new location, a different category, or even a 
different command. Change the name of the charge and click File. 

When dragging a charge to a different category, you must drag it below the category in the 
category list. If the category you are dragging to is in a different command, you can select 
the category in the destination command and then drag right into the charge list to place 
the charge exactly where you want. 
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Deleting charges 
You can delete a charge in one of these ways: 

• Select the charge and click Delete on the toolbar in the Charge Definitions 
window.  

• Select the charge and press the Delete key.  

Sharing charge definitions among PrintSmith systems 
If you have more than one PrintSmith system (perhaps at different locations or stores), 
you can set up charge definitions on one system and then export selected (or all) charge 
definitions from that system and import them into one or all of your other systems. This 
allows you to standardize your charge definitions when appropriate without having to 
recreate them on all your systems. 

If you later make changes to a charge definition you shared with other systems, you can 
export the changed definition and update the definition on the other systems. 

In order to export and import charge definitions, the Enable Pricing system 
Import/Export features check box in the Behavior preferences panel must be selected 
(Admin > Preferences > System > Behavior). When this check box is selected, the 
Charge Definitions window includes an Export button and the File menu includes an 
Import command. (After selecting the Enable Pricing system Import/Export features 
check box, you must restart PrintSmith for the File menu to include the Import command.) 

To export charge definitions 
1. To select a particular charge definition, select it in the Charge Definitions window 

and click Export. (You can also click and hold Export and then select Export 
Selection.) 

To export all the charge definitions from the current system, click and hold 
Export and select Export All. 
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2. In the File Save As dialog box, select a location for the Charges.xml file. (You 

can change the name of the file if you want.) 

3. Make the Charges.xml file available to the PrintSmith systems where you want to 
import the charge definitions. For example, copy Charges.xml to a shared 
network folder or attach it to an e-mail. 

To import charge definitions 
1. On another PrintSmith system, select File > Import. The Import XML window 

opens. 

2. Indicate whether you want to Add Records, Update Records, or Add and 
Update. For example, you may just want to add new charge definitions but leave 
existing charge definitions as they are (if you happened to customize them on the 
system). 

3. Click Browse to locate the Charges.xml file you want to import. 

4. Click Import.  
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Using charge definitions 
Using charges effectively can make a big difference in how well PrintSmith works for you. 
When working in the Estimator, you normally attach charges to either a job or a document 
(estimate or invoice). Charges attached to a job are referred to as job level charges and 
those attached to a document are referred to as invoice level charges. 

When a charge is attached to a job, it is included in the total job price when you generate 
a price list or multiple quantities on a quote. Markup charges that mark up part of a job 
must be attached to a job. Markup charges that mark up an entire invoice must be 
attached to a document. Except for the restriction on markup charges, any charge from 
any command can be attached to a job or a document. 

The level at which the charge is attached is determined by the window that is open when 
the command is selected. If a job window is open when the Charges command is 
selected on the Invoice menu, the charge is attached to the job. If a document window is 
open and no job window is open, the charge is attached to the document. If the Cash 
Register window is open and selected, the charge is added to the current cash register 
transaction as a “Quick-Est” transaction. If neither a job nor a document window is open, 
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the charge is not attached to anything. This is useful if you want to check the price on a 
charge quickly. 

On some charges, you can customize the labels for the charge. When the user sees the 
charge in the Estimator there should be no doubt what information is needed to price the 
job. For example, a drilling charge requires the user to enter the number of holes. A 
normal setup for a drilling charge shows a field named Qty/Set for the number of holes. A 
field named # of Holes is much clearer. You customize labels in the Preset Info window. 
(For details, see page 147.) 

Avoid overriding a price or rate since that prevents PrintSmith from updating the prices if 
the document is used for a repeat order. When setting up a charge definition, set it up so it 
handles an entire range of situations without requiring you to override the price. 
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Press Definitions 
Press definitions are a key component of the powerful PrintSmith estimating engine. In 
press definitions, you define the key variables of your pricing practices that influence 
profitability. 

Setting up press definitions 
Use the Press Definitions window to enter the types of presses you have and define their 
running characteristics. While you may only have a few presses in your shop, you can 
have several press definitions to accommodate different pricing characteristics of a given 
job. For example, tight registration, coated stock, and carbonless forms can all run on the 
same press, but one may run slower, take longer to set up, or require more waste. You 
can define up to 100 press definitions. 

On the Pricing menu, click Press Definitions. The Press Definitions window opens. 

The top of the window lists all the existing press definitions. The rest of the window 
displays the details of the selected press definition. 
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Tip To print a report of all press definitions, choose File > Print. The report lists each 

press definition, its labor rate, labor markup, setup times, speed table, waste 
chart, wash up charges, and attached charges. 
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The press data you enter is used by PrintSmith to estimate the amount of time needed for 
the job and the labor rate to apply. It determines the amount of setup time, the speed of 
the press and so on. 

A press definition consists of the following: 

Name  
 

Enter the name (up to 50 characters) of the press definition. The name helps 
users select the correct press for the job. Name your press definitions to 
identify their purpose, for example, Text 8.5 x 11/14 1C Normal Coverage.  

Machine ID 
 

Enter a number (1 to 255) to identify the press. This is useful if you have 
more than one press definition for each real press.  
The Machine ID is used by work in progress to sort jobs by the machine on 
which the order will run, rather than the press definition name used to price 
the job. 
For example, you may have four different press definitions for your 
Heidelberg Quick-Master but only have one actual press. If you enter the 
same Machine ID in those four definitions you can view work in progress for 
all four presses even though there is one piece of equipment. 

Machine Name 
 

Select the machine name you want. (Machine names are defined in the 
Production Presses table.) The machine name is included on the job ticket. 

Costing Press When you enter a machine name, the Costing Press check box becomes 
available. Select this check box to create a generic costing press definition 
that can apply to several similar presses that may or may not be available for 
a job. 
 
For example, a single physical press can have several press definitions 
depending on the different ways you want to run jobs on it. In the course of 
running a job, a physical press often becomes unavailable, and the job must 
be run on another press. The press operator should then use the generic 
costing press as the press on which the job was run. This costing press is 
then used to calculate costs on the final invoice. 

Output Description 
 

Enter a description of the type of output for this printing process. The output 
description is included on the job ticket. 

Production 
Location 

Select a location for the production. (Production locations are defined in the 
Production Locations table.) This field is used by PrintSmith Tracker. 

Cost Center Select a cost center. (Cost centers are used by PrintSmith Scheduler.) 

OEM Device ID Enter the ID by which the device is identified. 

Integrated Device For future use.  
Paper Style If you are upgrading from a version of PrintSmith earlier than 8.0, by default 

all of your press definitions will use Sheet-Fed as the paper style. Go 
through your list of presses and select Roll-Fed if you want to take 
advantage of the features available for that style. 

Note Also select a default sheet-fed and roll-fed press definition; 
otherwise, PrintSmith uses the first press definition of each listed 
type as the default. See “Organizing press definitions” on page 
166. 
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Max Paper Size / 
Min Paper Size 
 

(Sheet-Fed only) Enter the largest and smallest size paper that can be run 
on the press. The Estimator uses these fields to check for an improper press 
specification. You can leave these fields blank if this is not important to you. 
The Estimator still allows you to specify a press with a smaller or larger run 
size, but reminds you that the run size is larger or smaller than that allowed 
by the press. 

Max Roll Width / 
Min Roll Width 

(Roll-Fed only) Enter the minimum and maximum values for the roll width.  

Avg. 
Impressions/Hour 
 

Enter the speed at which the press usually runs. The Estimator uses this 
value to determine how long it takes to run a job. You can override this value 
for a particular job in the Production Data window for the job. If you define a 
speed table for the press, the amount entered here is ignored and replaced 
with the word variable. The speed is taken from the speed table. 

Cutoff Length (Roll-Fed only) Enter the circumference of the physical cylinder, for example, 
15 inches. 

Labor Rate  
 

Enter the cost per hour to run the press. This value is used as the cost basis 
in the costing system. 

Labor Markup  
 

Enter the markup on the labor rate when generating the production 
component of a print job price. The markup is multiplied by the labor rate to 
determine the charge for labor. This value is used as profit in the costing 
system. 

Minimum Labor  
 

Enter the minimum number of labor minutes that can be assigned to a job. 
Use this field when you want to charge a penalty for short runs on a 
particular press or establish a minimum price for using this press. 

Fixed Waste  
 

Enter the number of sheets of spoilage to add to all jobs that use this press. 
This value is in addition to waste calculated as a percentage of the run, 
which is determined by a waste chart. 

Setup (minutes) 
 

Enter the number of minutes usually required to prepare the press for the 
first run of a job. 

# Heads  
 

Enter the number of print heads (impression cylinders) on the press. This 
field determines the number of passes needed to print a number of colors 
specified in the job. 

Setup Add’l Head  
 

Enter the additional time needed to prepare each additional print head on 
multi-color runs. (PrintSmith ignores unneeded heads.) 

Setup Add’l Run  
 

(Sheet-Fed only) Enter the additional time needed to prepare for an 
additional run. This value should include the time for a plate change and run 
up. The Estimator uses this value for all passes after the first one. 

Washup Fee  Enter the amount charged for each washup. You specify the number of 
washups for each job.  

Setup Add’l 
Signatures 

For jobs with more than one signature, enter the setup time for the first color 
on signatures after the first one. 

Add’l Signatures 
Add’l Head 

For jobs with more than one signature, enter the setup time for additional 
colors on additional signatures.  
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Work and Turn 2nd 
side setup 

(Sheet-Fed only) Enter the time it takes to turn stock over, reload it in the 
press, and register the first side to the second side without changing a plate. 

Washup Minutes 
 

Enter the time it takes to do the washup of the press. 

Note Do not use Washup Fee and Washup Minutes in the same press 
definition as it will add both prices together in a job. 

If you enter a value for Washup Minutes only, the washup charge is: 
                          washup minutes x washes 

Washup time per 
fountain 

Enter the time it takes, in minutes, to do the washup of each ink fountain. If 
you enter a value for Washup Minutes and Washup time per fountain, the 
washup charge is: 

(washup minutes x passes) + 
(washes x washup time per fountain) 

Washes and passes are specified in the job. 
Speed Table  
 

Generally, the longer the press run, the closer a machine gets to its rated 
speed. Because the press speed increases on long runs, it is more efficient 
and cheaper to produce each piece. Click Speed Table to create a speed 
curve that adjusts the press speed for the length of the run. For more 
information, see “Managing speed tables” on page 169. 

Note  EFI recommends that you name speed tables in a way that 
identifies their characteristics, or example, Slow Speed. 

Waste Chart  
 

In addition to the system default waste chart, PrintSmith lets you define 
waste charts for each press. Click Waste Chart to assign a waste chart or 
create a new one. For more information, see “Waste charts” on page 174. 
If no waste chart is assigned, the press definition uses the default waste 
chart. 

Note  EFI recommends that you name waste charts in a way that 
identifies their characteristics, for example, High Waste. 

Add Charges  
 

Each press definition can have up to 10 preset charges. Click Add Charges 
to edit the preset charge list. If charges are already assigned to the press 
definition, the number of charges is displayed on the button as  (1) 
Charges… For more information, see “Adding charges to press definitions” 
on page 167. 
Whenever the press is selected, those charges are added. For example, you 
could add metal plate, ink, and cutting charges to each press, and they 
would be automatically included on all jobs estimated with that press 
definition. 

Sales Cat  
 

Select the sales category for the press. You can assign each press definition 
to a different sales category. This is useful if you want to separate certain 
types of jobs in your sales summary based on the press definition used for 
the job.  
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Perfector  
 

Select the Perfector check box for a perfector to change the method 
PrintSmith uses to calculate the number of passes in a job. On a normal 
press, an additional pass is needed for each side. On a perfector, you can 
print on both sides of the stock in a single pass. If this check box is selected, 
PrintSmith calculates additional passes only when the total number of 
passes exceeds the number of heads available. In this context, 1/1 (one 
color front and back) is the same as 2/0 (2 colors front, none on the back). 
Likewise, on a 4 head press, 4/0, 3/1 and 2/2 all price the same way. For 
more information, see “Setting up perfectors” on page 176. 

Grip Edge/Gap 
 

Enter the amount of space required on one feed edge of the run sheet for the 
press to pick up the paper. 

Target Pricing  
 

Each press definition has its own target pricing table. Click Target Pricing to 
adjust cost-based pricing for market conditions at any quantity or job type. 
You can be as specific in adjusting a price for 1/1 pricing and a quantity of 
1000, to exactly $15.15 while leaving all other prices unchanged. When your 
costs change, the price is automatically adjusted while maintaining the same 
margins and market position. For more information, see “Target pricing” on 
page 176. 

 

Use the buttons at the bottom of the Press Definitions window as follows:  

 

Add  Click this button to save a new press definition. 
Change Click this button to save changes to an existing press definition. 

Duplicate Click this button to copy the selected press definition. 

Delete  Click this button to delete the selected press definition. 
Export The Export button is available only if the Enable pricing system 

Import/Export features check box is selected in the Behavior preferences 
panel (Admin > System > Behavior). Click this button to export the selected 
press definition. If you click and hold the button you can select Export Selection 
or Export All. 

Revert Click this button to revert to the previous definition and discard any changes.  

Close Click this button to close the Press Definitions window. 

Stock Price 
List  
 

Click this button to generate a price list for any press definition. Before the price 
list is generated, you select the stock to be used with the press definition. It is 
particularly useful to tune your press definition for a particular stock without 
continually going back and forth between stock and press definitions. 

Press Price 
List  
 

Click this button to generate a price list for any press definition. This price list is 
exactly the same as the one generated from Stock Definitions except it does not 
include a stock price. Use this to generate production price lists. These price 
lists can be useful for manually calculating an approximate price for a special 
order paper. 
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Example of a press definition 
PrintSmith gives you the ability to track the sales generated from each press into a 
specific sales category. For example, the following window shows the assumptions for a 
press definition named Text 8.5 x 11/14 1C Normal Coverage.  

 
Verify the speed and waste tables by clicking their respective buttons. Change the rates to 
meet your requirements. 

Click to 
add 
charges. 

A custom 
speed 
table is 
assigned. 

 



Defining Pricing 

 

 
Page 165 

Click Charges to see which charges are attached. Add more charges or remove charges 
as necessary. You can attach 10 charges to any one press. 

The process of developing press definitions should be quick. If you define the presses 
before you enter your stocks, you can assign a press definition to the paper definition in 
the setup. 

Note  Add plate fees by attaching a pre press charge. 
PrintSmith uses press definitions to determine production costs for jobs using the printing 
pricing method. Press definitions are also used with list pricing to estimate the run time of 
a job for the Work in Progress report. 

Managing press definitions 
Selecting an existing press definition 
The top part of the Press Definitions window contains a list of the existing press 
definitions. Click a press to display its definition. To update the definition after making 
changes, click Change. 

Creating a new press definition 
When you first choose Pricing > Press Definitions, the window opens with an empty 
press definition. You add a press definition by completing the fields in the window and 
clicking Add.  

If you want to create a new press definition, and one is already displayed in the Press 
Definitions window: 

1. Choose Edit > Clear Press Definition to get a blank definition.   

2. Complete the fields in the window and click Add. 

Changing an existing press definition 
1. Locate the press in the list of presses at the top of the Press Definitions window.  

2. Click the name of the press. Its definition is displayed. 

3. Make your changes and click Change to save them.  

Copying an existing press definition 
You can copy a press definition in a number of ways: 

• In the list at the top of the window, click the press definition you want to copy and 
then click Duplicate. The new definition has the name of the original press 
definition followed by the word Copy, for example, Komori 6 Tower Copy. Edit 
the name, make any other necessary changes, and click Add. 

• Click the press definition you want to copy, hold down the Option or Alt key, and 
drag the press to a new location in the list. When you release the mouse, the 
press is copied with exactly the same name. Enter a new name, make any other 
necessary changes, and click Add.  
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• Click the press definition you want to copy and choose File > New. The press is 
copied with exactly the same name. Enter a new name, make any other 
necessary changes, and click Add.  

• Click the press definition you want to copy and choose Edit > Copy Press 
Definition or Edit > Cut Press Definition. Then choose Edit > Paste Press 
Definition. The press is copied with exactly the same name. Enter a new name, 
make any other necessary changes, and click Add.  

Tip You can move a definition to a different position in the list by dragging.  

Deleting press definitions 
When first setting up your pricing system you can safely delete any press definition. After 
you are up and running, EFI recommends more caution when you delete definitions. You 
can still delete any press definition, but you may want to keep definitions that were used 
as a preset press in a stock definition or by the estimator in a job. 

If you would like to retain a definition but no longer use it, EFI recommends moving it to 
the end of the list. When you create a press job, a press definition is selected. When the 
job is saved, the fact that this particular press was used is part of the job. When the job is 
copied to a new invoice or changed in any way, PrintSmith selects the press definition 
from the pricing system and uses it to adjust the price. PrintSmith can find the definition 
even if you changed its name or location in the press list, but not if it was deleted. When 
this occurs, PrintSmith warns you that the definition is missing and that a press needs to 
be selected. 

If you preset a press selection in a stock definition and then delete that press definition, 
PrintSmith automatically selects the default press. The user may not recognize this, and 
an incorrect price could be given to the customer. 

If, however, you make major changes to the pricing system, you may want to call attention 
to the fact that deleting some press definitions changed pricing. When you use an old job 
that was priced with the “old” pricing system, the Estimator warns you and recommends 
changing definitions. At this point, the user can select the correct press from a list. 

To delete a press definition 
1. Click the press definition in the list at the top of the Press Definitions window.  

2. Click Delete. 

3. Click Yes to confirm. 

Organizing press definitions 
To change the position of a press definition in a list, drag the definition to a different 
location in the list. Repeat this as often as you like until all of the presses are in the order 
you want.  
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Sharing press definitions among PrintSmith systems 
If you have more than one PrintSmith system (perhaps at different locations or stores), 
you can set up press definitions on one system and then export selected (or all) press 
definitions and import them into one or all of your other systems. This allows you to 
standardize your press definitions when appropriate without having to recreate them on all 
your systems. 

The procedure for exporting and importing press definitions is the same as exporting and 
importing charge definitions, except the default export file is named Presses.xml. For 
details, see “Sharing charge definitions among PrintSmith systems” on page 154. 

Adding charges to press definitions 
Charge definitions add a tremendous amount of flexibility to the PrintSmith Estimator. (For 
information about charge definitions, see page 106.) You can select any 10 charges and 
attach them to a press definition. When you select a press, these preset charges are 
automatically loaded. If you select a different press, the charges that are attached to the 
old press are discarded and the charges attached to the new press are loaded. 

To add charges to the preset charge list 
1. Click Add Charges in the Press Definitions window. The Charge Selector 

window opens. 

     
The window is divided into two sections. The top section is used for making new 
selections; the bottom section displays the current selections, and is used to 
remove preset charges from the list. The top part of the window is a hierarchical 
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list with charge commands first. Below each charge command is a list of the 
categories and within each category are the charge definitions themselves.  

2. To add a preset charge, either double-click it in the top section of the window or 
click it and then click Select. The charge definition is listed under Selected 
Charges.  

Tip Click Find to locate a particular charge. 
3. To remove a preset charge, click it under Selected Charges and click Remove.  

4. Click Close after you finish selecting charges. 

Note When you attach a charge to a press, the charge itself is not copied. The press 
definition remembers where to find the charge. As a result, if you change a 
charge definition, PrintSmith uses the latest definition when the charge is added 
to a job. 

Strategies for using preset charges 
Preset charges make it possible to generate complex quotes quickly and consistently. 
Often, this means that complex quotes can be delegated to less knowledgeable 
employees with a much greater degree of confidence. Preset charges can also serve as a 
tickler—if you preset all the most common charges for each press, the user can delete any 
that do not apply to a particular job. It is often easier to recognize elements in a job that 
should not be there, than it is to see what you forgot to add. 

For example, if you are producing many direct mail jobs, you could add a metering charge 
to a press definition for envelopes. This may even prompt the user to go back to the 
customer and ask if they want the envelopes metered, which may increase the value of 
the order. Many different strategies are possible for defining press definitions and deciding 
what, if any, charges should be preset in the press. 

A common use for preset charges is to add plates. When a press definition is selected, 
you already know what kind of plate the job requires. If you use both metal and paper 
plates on the same press, it is a simple matter of setting up press definitions to match your 
decision process. A press definition such as AB Dick - Metal or AB Dick – Tight 
Registration and another definition AB Dick - Normal might be all you need to separate 
jobs requiring metal plates from jobs requiring paper plates. If you have different presses, 
a preset plate charge with the proper sized plate eliminates a step in the estimating 
process. 

Be consistent in your use of preset charges. If only some of your press definitions have 
negatives and plates automatically attached, expect the person entering the job to 
experience some level of confusion. Pre-set plate charges on all press definitions. 

The key is to name the press definition as descriptively as possible and to attach the basic 
charges that make sense to the user. Group similar press definitions together in a well-
organized manner so the definitions make sense and make it easy for your staff to make a 
selection. 
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Managing speed tables 
Speed tables let you set up presses with realistic throughput based on the length of the 
job. Generally, the longer the press run, the closer the machine can come to its rated 
speed since there are fewer stops for adjustment on a long run once the job is running 
properly. 

PrintSmith allows you to define speed tables that you can associate with a press 
definition. When you add a speed table to a press, the press is known as a variable speed 
press because PrintSmith uses the speed table to look up the speed based on the length 
of the job. 

Two steps are required to set up a variable speed press: creating the speed table and 
assigning it to the press. 
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Once a speed table is assigned to a press definition, its name is displayed to the right of 
the Speed Table button. Click the name of the speed table to open it for editing. 

Creating a speed table 
You can create an unlimited number of speed tables, but you can probably operate with 
just a few speed tables since you can assign the same table to more than one press 
definition.  

Variable 
means 
speed is  
calculated 
based  
on job 
length. 

Name of 
selected 
speed 
table. 

Click to 
assign a 
speed 
table. 
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1. In the Press Definitions window, click Speed Table. A window opens with a list of 
all the available speed tables. 

 
2. Click New. The Speed Table window opens.   

3. In the Title field, enter a name for the speed table. Make this as descriptive as 
possible so users understand its purpose. 

With the exception of the Interpolate check box, the settings on the right side of 
the window are unavailable when you create a speed table.  

 
By default, the Interpolate check box is selected so that PrintSmith calculates 
intermediate values if the run length being looked up does not exactly match a 
run length in the table. Suppose that you had a table with a run length of 1000 
and a speed of 4000, and the next entry in the table had a run length of 2000 and 

Assign selected table. 

 
Clear assignment. 

 
Create new table. 

 
Delete selected table. 

 
Close window without 
performing an action. 
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a speed of 5000. For a run of 1500, PrintSmith would return a speed of 4500. 
1500 is exactly in the middle of 1000 and 2000 so the speed, 4500, is half the 
difference between 4000 and 5000.  

4. If necessary, clear the Interpolate check box. If it is cleared, the speed jumps to 
the next entry with no intermediate values. This setting can result in the price for 
1100 being less than the price for 1000 so EFI recommends that you leave it 
selected. 

5. Enter the run lengths and speeds as follows: 

• Specify at least 2 (and up to 15) different run length and speed 
combinations.  

• Use the Tab key to move between columns; use Enter or Return to move to 
the next line. 

• Make sure the run lengths are sequential with the smallest run length at the 
top of the list. The maximum run length does not need to be the largest one 
you will run. When the run length in the job is larger than the largest value in 
the speed table, the last speed in the table is used. 

• As the run length increases, increase the press speed, thus reducing the unit 
labor cost on longer runs.  

Note Although normally the press speed should increase at higher 
quantities, it does not have to. You could, for example, reduce the 
effective speed when the quantity reaches the point where the 
press usually has to be reloaded.  

 
6. Click OK.  
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Assigning a speed table to a press definition 
1. In the Press Definitions window, click Speed Table. A window opens and lists all 

the available speed tables.  

2. Click the speed table you want to assign and click Select. The name of the 
assigned speed table is now listed to the right of the Speed Table button. 

Modifying a speed table 
Once a speed table is assigned to a press, you can change it. If the speed table is not 
assigned to any press, you must assign it to one, at least temporarily 

1. In the Press Definitions window, click the name of the assigned speed table. The 
Speed Table window opens.  

2. Make your changes. For example, you may want to change the name of the 
speed table. 

3. Click OK. 

Note  Keep in mind that the speed table may be used by other press definitions. Any 
changes you make affect those press definitions, too, including a change to the 
name of the speed table. 

Changing the assigned speed table 
1. In the Press Definitions window, click Speed Table. A window opens and lists all 

the available speed tables.  

2. To remove the existing speed table assignment, click Clear. To assign a different 
speed table, click it and then click Select.  

Copying a speed table 
If you need a speed table similar to one that already exists, you can copy it. 

1. In the Press Definitions window, click the name of the assigned speed table. The 
Speed Table window opens. 

2. Choose File > Save As. 

3. In the Title field, enter a different name for the speed table. 

4. Click OK. 

Deleting a speed table 
Caution Keep in mind that the speed table you delete may be used by other press 

definitions. Before deleting a speed table, make sure this is not the case. 
1. In the Press Definitions window, click Speed Table. A window opens and lists all 

the available speed tables.  

2. Click the speed table you want to delete and click Delete. 

3. Click Yes to confirm. 
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Waste charts and press definitions 
Although a default system waste chart exists, each type of press may have different 
spoilage characteristics. As a result, each press definition can have its own waste chart. 

You manage waste charts and assign them to press definitions just as you do with charge 
definitions. (For information about setting up the default waste chart and managing waste 
charts, see “Waste charts and charge definitions” on page 142.) Once a waste chart is 
assigned to a press definition, the name of the waste chart is displayed to the right of the 
Waste Chart button in the Press Definitions window. 

Overview of press definitions and estimating 
The press definition is used in the printing and list pricing methods in the Estimator. A 
press is always set to a default press when you create jobs, but you have complete control 
over which press definition is used in any job and can change it at any time. When you 
select a stock from the stock list, and a press definition is designated in that stock 
definition, that press is used in the job. If no press is designated in the stock definition or 
the job is for customer stock or a special order, the default press is selected. 

One obvious use for press definitions is to describe the various machines in your shop. 
Perhaps less obvious is that the press definition is another way to describe how a 
particular stock or job is run – how hard it is to set up, how fast it can run, and so on. With 
this in mind, you could use press definitions to describe classes of jobs such as business 
cards, carbonless, and so on. The press definition is then used to describe the running 
characteristics of a particular job. You can also use press definitions to specify production 
characteristics of some copiers although copier/digital definitions are usually better suited 
for this purpose. 

Determining press production values 
Your press definitions are very important as labor is often the largest component in a 
printing job. If you use a price list from one of the commercial price list bureaus or from a 
franchise, you may not have a clear idea what your production values are. This section 
provides some guidelines for developing these factors. 

PrintSmith uses a formula to calculate the labor component of several types of jobs. For 
readability, some of the factors are abbreviated as follows: 

• aimp = 5000 average impressions/hour 

• rate = 50.00 labor rate 

• markup = 1.5 labor markup 

• setup = 12 initial setup time (minutes) 

• head = 5 setup add’l head (minutes) 

• run = 8 setup add’l run (minutes) 
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• waste = 10% quantity x waste percent x number of passes (the waste 
percentage is taken from the waste chart) 

Calculating your labor rate 
One way to calculate a reasonable labor rate is from your income statement for the last 12 
months or budget if you are just starting out. Add up all of your overhead items such as 
rent, utilities, and phone, and adjust them for any anticipated increases. Then add up all 
your payroll expenses for non-production employees, such as CSRs and accounting 
people, including a fair wage for you, and adjust the total for anticipated raises, taxes, 
benefits, and changes in work force. The markup on the base salary is usually between 
20% and 40%. This amount gives you a projected total for overhead and labor for the 
year. Divide this number by the hours available in a year, which for one shift is usually 
2,080 hours. That gives you the overhead cost per hour. You then need to assign a 
percentage of the hourly cost to each piece of billable equipment. Usually pre press and 
bindery are by the department and press and copiers are by each piece of equipment. 
You can either determine these numbers by percentage of sales or square footage of the 
equipment. 

Then, determine the hourly rate for each production employee, such as pressman, pre 
press and bindery personnel. Start with the base hourly rate for each employee. Add to 
that a markup percentage to account for vacations, holidays, sick leave, FICA matching, 
and so on. The markup is usually between 20% and 40%. 

The next step is to figure the replacement cost for each piece of billable equipment you 
have, such as presses, copiers, and bindery equipment. To do this, take the replacement 
cost divided by the depreciation years, divided by 2080. EFI recommends that you 
depreciate pre press equipment by 3 years, press by 7 years, and bindery by 10 years. 

Now, add up the overhead, labor, and equipment costs for each of the departments or 
pieces of equipment to get a total cost. 

The final step is to determine just how efficient your shop is, that is, how much of this time 
can actually be charged to customers. In a very well run and very busy shop, you may be 
able to charge 70% of these hours to customers. In a new or recently expanded business, 
it may be as low as 40%. A good figure to use is 60%. Whatever percentage you decide 
on, divide the hourly cost rate by the percentage (for example, 25.00 /.60 = $41.66). This 
total is your Budgeted Hourly Rate and is what you should be using for hourly labor 
charges. 

Once you have this number, you should only have to review it when you are 
contemplating a price increase, or if your business has changed significantly. This number 
is the only detailed calculation needed to set up press pricing in PrintSmith. PrintSmith will 
now tell you what your actual return is for each press and non-press hour. 

Tip  A quick way to find your labor rate is to multiply your average employee count by 
the number of hours you are open for business in a given period. Then divide 
your total expenses for this period by total hours and mark that up by your 
desired gross profit percentage. An even quicker way is just to take revenue for 
the period and divide by total hours. Neither method is foolproof, but both are 
useful ways of getting a “ball park” figure if you want to get started quickly. 
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Setting up perfectors 

PrintSmith does not fully support perfectors. In most cases, it estimates correctly with the 
Perfector check box selected. A 1/1 job with 2 heads is fine, but a 2/0 may not be if your 
press is not capable of running it in one pass because PrintSmith only estimates one 
pass, which is always correct for roll fed. 

Target pricing 
Over the years, thousands of printers have adapted PrintSmith to many different pricing 
systems. Many printers have a good idea of their costs and a good idea of the value of the 
printing they produce in their market. Many times, the value (what your customer is willing 
to pay) of the printing has little or no relationship to your costs. Target pricing was 
developed on the following assumptions: 

• It is a good idea to identify and track costs for producing work.  

• The price a customer is willing to pay for the work you produce may not reflect 
your costs to produce it. 

• Your pricing system should incorporate your costs and generate competitive 
prices at all quantities. 

• As your costs change, they should be reflected in your retail prices. 
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Target pricing lets you set up a pricing system that recognizes actual costs, generates 
prices based on market value at any quantity and automatically adjusts prices for changes 
in costs while still retaining a competitive orientation. This is accomplished using a target 
pricing table shown below. 

 

 

     
 

 

The target pricing table lets you see an array of prices generated by PrintSmith using your 
specifications. You can review prices for single-sided, multicolor, and process color work 
for up to 15 price points and adjust them. When you review these prices, also analyze the 
results to see how this changes your estimated profit. 

Note  When you review these prices keep in mind that what PrintSmith shows as profit 
is really just the difference between estimated costs and generated price. To the 
extent that you identified all costs in your pricing system, the profit is generally 
accurate, but actual profits can only be reasonably determined from a Profit and 
Loss Statement over a period such as a month, quarter, or year. 

If you think that the price PrintSmith generates for a particular quantity in any column is 
too high or too low, simply enter a new price. When you press Tab or Return, the table is 
recalculated and a new analysis showing your new margins is displayed. From now on, 
jobs that match those specifications result in the price you entered. For more information, 
see “How target pricing works” on page 178. Be sure you understand how this works. 

Graphs show pricing 
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Using target pricing 
To use target pricing,  

1. In the Press Definitions window, select a press definition.  

2. Add preset charges if you want and click Target Pricing. The Target Pricing 
table opens for the selected press. Before the table opens, you are asked to 
select a stock definition.  

Selecting a stock is optional. A target table based solely on production values to which the 
Estimator adds marked up stock and other charges is a very different, but valid approach. 
It is more difficult to determine pricing targets if all the necessary factors are not included 
in the price. Keep in mind that the target pricing factor generated in this table is also 
applied to the stock cost and any charges added to the job unless you select the Ignore 
Charges check box. Ignoring charges is the safest way to set up a target table because 
the factor generated by target pricing is smaller if charges are not included. If charges are 
included, the factor must be larger to account for the charge amounts because the target 
pricing adjustment does not include charges. Since only the job price is changed, reducing 
a $200 price by $50 requires a factor of 0.5 if $100 of the price is due to charges on the 
job. The factor is only 0.75 if there are no charges on the job. Either approach is correct, 
but removing those charges from the job results in much less profit or even a loss since 
the job price may have been reduced too much to account for the charges. For this 
reason, it is probably best only to include charges that are always added to every job 
using that press (or stock). 

When the target pricing table is first set up, the quantities used are the same as those in 
the system waste chart. You can change them. As long as at least the first two quantities 
in the table are non-zero, the table can be used for target pricing. You can shorten the 
table by entering a zero in any quantity. 

These quantities are used to calculate five columns of prices: 1/0, 1/1, 2/0, 2/2, 4/0. Since 
each column has 15 different prices there are a total of 75 prices calculated. Depending 
on the complexity of the press definition and the speed of the machine, it can take several 
seconds to complete all the calculations. Many of these calculations have to be redone 
whenever you change the table, so you will find this window to be one of the slowest in 
PrintSmith. (On a faster computer you are unlikely to experience a delay.) 

The target pricing table is part of the press definition and is copied when a press is copied. 
File > New resets the entire table to standard prices with no target adjustments. File > 
Revert restores the table to its last saved value. File > Save saves all changes to the 
target pricing table. (This is independent of press definition. In other words, when you 
save the target table, the change is permanent, even if you do not save the press 
definition to which the target pricing table belongs.) 

How target pricing works 
Most of the time, you will probably be working in the target view of the table. This view 
shows you the prices generated by PrintSmith. When you enter a price, you are actually 
telling PrintSmith your target price. This target is used to calculate a discount on the 
generated price, which is used by the Estimator. Using a discount accommodates 
changes to stock cost and the use of different stocks with the same press definition. 
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For example, changing a default target table price of $16.73 to $15.00 might result in a 
target factor of 0.9. If stock prices change, or you use that press with a different stock, 
PrintSmith calculates the price and, as a last step, multiplies the job price by the factor for 
the proper row and column. If the labor rate and stock prices were changed so that the 
same job yielded a price of 100.00, a target factor of 0.9 would be used to reduce the 
price to 90.00. 

Target pricing options are also controlled with the following check boxes. 

Interpolate When selected, the factor used to adjust the price on quantities which do not 
match those in the table is interpolated. The result is a smooth transition 
from one row to the next. This check box also controls how the variance and 
profit analysis graphs are presented to show how profit changes. 

Disabled  When selected, the target pricing table is not used for generating prices. 

Ignore Charges  When selected, any charges attached to the press or stock are ignored when 
calculating the target table. Use this option to adjust basic production prices 
without changing press or stock definitions. 

Use Press Count  When selected, the press count is used instead of ordered quantity. 

Ignore Wash Up 
Charges  

When selected, the target adjustment is not applied to wash up charges. 

Ignore Stock When selected, the target adjustment is not applied to stock. 
The column selected for the discount factor is determined as follows: 

Column Description Criteria 
   

1 One Pass One Side One color on the front with nothing on the back. 
2 One Pass Both Sides One color on the front and one color on the back. 

3 Multi-Pass One Side More than one color on front and none on back. 

4 Multi-Pass Both Sides More than one color on front and at least one color on the back. 
5 Process Color Four or more colors on the front 

   

The target factor is generated from the estimated price, which may include charges. 
Charges are not affected by the factor, only the job price. The more charges there are on 
a job, the larger the target pricing factor must be to adjust the entire price where you want 
it. The factor is calculated so that charges, when added to the price, equal the target price. 

Target pricing is an adjustment for market prices so that all calculations are based on the 
quantity ordered and on the number of colors, rather than passes. 

Note  Be careful with preset charges, both on stocks and presses. These have a big 
impact on the target factor. Only use charges you are confident will be 
appropriate with all potential uses of the press definition. 

A target table must have at least two entries and the quantities must be in ascending 
order. 

  



EFI PrintSmith |  Setup Guide 

 

 
Page 180 

Target prices are color coded: 

• Blue indicates a price below standard but above cost 

• Red is a price below cost 

• Black is the standard price 

• Green is above standard 
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Copier/Digital Definitions 
Copier/digital definitions account for another major pricing method. You might own only 
one copier but offer several differing pricing methods. Each definition can have its own 
formula, with a unique matrix and attached charges. As a result, PrintSmith can handle 
any pricing situation. You can enter up to 100 copier/digital pricing definitions. 

On the Pricing menu, click Copier/Digital Definitions. The Copier/Digital Definitions 
window opens. 

 
Tip To print a list of copier/digital definitions, choose File > Print when the 

Copier/Digital Definitions window is open. 
PrintSmith uses copier/digital definitions and stock definitions to determine the price for 
copier jobs. You can create up to 100 copier/digital definitions to describe the various 

Costing 
data 
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kinds of copier pricing styles in your business. For example, high speed, convenience, 
color, contract, engineering, and large format are all possible pricing styles that can be set 
up in a copier/digital definition.  

Here are the settings in the Copier/Digital Definitions window that are common to all 
copier/digital definitions. 

Name Enter a name (up to 50 characters) to identify the copier/digital definition. 

Machine Name Select a machine name. (Machine names are defined in the Production 
Presses table.) The machine name is included on the job ticket. 

ID If you use more than one definition for each actual machine, enter a number, 
from 1 to 255, to identify the machine. The Work In Progress report uses this 
ID to sort jobs by the machine on which they are produced rather than by the 
definition to price the job. 

Add Charges 
button 

Click this button to add up to 10 charges to a copier/digital definition. These 
charges are automatically added to the job when this copier is selected. 

Output Description Enter a description of the output for this printing process. This is included on 
the job ticket. 

Production 
Location 

Select a production location. (These are defined in the Production Locations 
table.) This field is used by PrintSmith Tracker. 

OEM Device ID If you are integrated with the Fiery, enter the ID by which the device is 
identified. 

Waste Chart Click this button to add a waste chart to a copier/digital definition. A waste 
chart adds running waste to the copier pricing. The procedure for working 
with waste charts is the same as for press definitions. See page 174. 

Cost Center Select a cost center. This field is used by PrintSmith Scheduler. 

Integrated Device  Select this check box if the device is integrated with the Fiery. 
Method  Select the pricing method of the copier, for example, Copies per Original or 

Flat Rate. For more information about pricing methods, see page 185. 
Printer Type Select the type of copier. You can: 

Select BW, Color, or both. For example, you may have a color copier that 
you also use as a black and white copier when needed. 
Select Large Format (LF) only. Note that some settings in the Copier/Digital 
definitions window change when the Large Format LF) check box is 
selected. 

Sales Cat  Select the sales category for tracking jobs priced with this definition. 
Use the buttons at the bottom of the Copier/Digital Definitions window as follows: 

 

Add Click this button to save a new copier/digital definition. 

Change Click this button to update the selected copier/digital definition. (The Change 
button is available only when you make a change.) 
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Duplicate Click this button to copy the selected copier/digital definition. 

Delete Click this button to delete the selected copier/digital definition. 
Export The Export button is available only if the Enable pricing system 

Import/Export features check box is selected in the Behavior preferences 
panel (Admin > System > Behavior). Click this button to export the selected 
copier/digital definition. If you click and hold the button you can select Export 
Selection or Export All. 

Revert Click this button to restore the original definition and discard any changes 
you made. 

Close Click this button to close the Copier/Digital Definitions window. 

Stock Price List 
 

Click this button to generate a price list for any copier/digital definition with a 
particular paper attached. This is particularly useful in setting up PrintSmith 
as you can “tune” your copier pricing for a particular stock without continually 
going back and forth between stock and copier definitions. 

Copier/Digital Price 
List 

Click this button to generate a price list for any copier/digital definition 
without considering stock cost. 

Default copier/digital selection in the Estimator 
You should select a default copier for each type of copier (B&W, Color, and LF); 
otherwise, PrintSmith uses the first copier of each type listed as the default. (You must 
specify the Printer Type for a copier/digital definition before you can make it the default.)  

In the list of copiers at the top of the Copier/Definitions window, click Default B&W next to 
the B&W copier you want to be the default, click Default Color next to the default color 
copier, and click Default LF next to the default large format printer. 

When you enter a copy job, PrintSmith automatically assigns a default copier unless the 
selected stock has a preset copier. You can change this, however.  

When you create a B&W, color, or large format job, you can choose from a list of 
appropriate copiers (all others will be unavailable for selection). As a result, you cannot 
accidentally select an inappropriate copier for a job. 

 
Note  Be sure to select a Printer Type for each copier/digital definition, or the copier 

will not be available as a selection for jobs.   
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Managing copier/digital definitions 
Selecting copier/digital definitions 
In the list at the top of the Copier/Digital Definitions window, click a copier to display its 
definition in the bottom section of the window. 

Creating a new copier/digital definition 
When you first choose Pricing > Copier/Digital Definitions, the window opens with an 
empty copier definition. You add a copier definition by completing the fields in the window 
and clicking Add.  

If you want to create a new copier definition, and one is already displayed in the 
Copier/Digital Definitions window: 

1. Choose Edit > Clear Definition to get a blank definition.   

2. Complete the fields in the window and click Add. 

Changing an existing copier/digital definition 
1. Locate the copier in the list of copiers at the top of the Copier/Digital Definitions 

window.  

2. Click the name of the copier. Its definition is displayed. 

3. Make your changes and click Change to save them.  

Copying an existing copier/digital definition 
You can copy a copier definition in a number of ways: 

• In the list at the top of the window, click the copier definition you want to copy 
and then click Duplicate. The new definition has the name of the original 
copier/digital definition followed by the word Copy, for example, 11 x 17 Color 
Copies Copy. Edit the name, make any other necessary changes, and click 
Add. 

• Click the copier definition you want to copy, hold down the Option or Alt key, and 
drag the copier to a new location in the list. When you release the mouse, the 
copier is copied with exactly the same name. Enter a new name, make any other 
necessary changes, and click Add.  

• Click the copier definition you want to copy and choose File > New. The copier is 
copied with exactly the same name. Enter a new name, make any other 
necessary changes, and click Add.  

• Click the copier definition you want to copy and choose Edit > Copy Definition 
or Edit > Cut Definition. Be sure to click Change and then choose Edit > Paste 
Definition. The copier is copied with exactly the same name. Enter a new name, 
make any other necessary changes, and click Add.  

Tip You can move a definition to a different position in the list by dragging.  
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Deleting copier definitions 
When first setting up your pricing system you can safely delete any copier definition. After 
you are up and running, EFI recommends more caution when you delete definitions. You 
can still delete any definition, but  if the definition was used by other parts of the pricing 
system or by the Estimator, you may want to use an alternate strategy, for example, move  
the definition to the end of the list or rename it. 

When you create a copier job, you select a copier/digital definition. When the job is saved, 
the fact that a particular copier was used is also saved. The copier/digital definition itself 
does not become part of the job. When the job is copied to a new invoice or changed in 
any way, PrintSmith uses the copier/digital definition in the pricing system to adjust the 
prices. PrintSmith can find the definition even if you changed its name or location in the 
copier list, but not if it was deleted. When this occurs, PrintSmith warns you that the 
definition is missing and that a copier must be selected. 

If you attach a copier/digital definition to a stock definition, and the copier/digital definition 
is deleted, PrintSmith automatically selects the default copier. The user may not recognize 
this, and an incorrect price could be given to the customer. 

If, however, you make major changes to the pricing system, you may want to call attention 
to the fact that deleting a copier/digital definition changed pricing. When you use an old 
job that was priced with the “old” pricing system, the Estimator warns you and 
recommends selecting a definition. 

To delete a copier/digital definition 
1. In the list at the top of the Copier/Digital Definitions window, click the copier you 

want to delete.  

2. Click Delete. 

3. Click Yes to confirm. 

Organizing copier/digital definitions 
To change the position of a copier/digital definition in the list, drag the definition to a 
different location in the list. Repeat this operation as often as you like until all of the 
copiers are in the order you want.  

Sharing copier/digital definitions among PrintSmith systems 
If you have more than one PrintSmith system (perhaps at different locations or stores), 
you can set up copier/digital definitions on one system and then export selected (or all) 
copier/digital definitions and import them into one or all of your other systems. This allows 
you to standardize your copier/digital definitions when appropriate without having to 
recreate them on all your systems. 

The procedure for exporting and importing copier/digital definitions is the same as 
exporting and importing charge definitions, except the default export file is named 
Copiers.xml. For details, see “Sharing charge definitions among PrintSmith systems” on 
page 154. 
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Copier/digital pricing methods 
Nine pricing methods are available. The pricing method that you select determines how 
copier jobs are priced for a particular copier/digital definition.  

 
These nine pricing methods represent three styles: cost plus, flat rate, and matrix pricing. 
Several variations are possible with each style. The following guidelines will help you 
choose the pricing style best suited for any pricing requirement. 

When you choose a pricing method, the Copier/Digital Definitions window changes to 
display pricing specifications for that method. Keep in mind that all of this information can  
reside in the same definition simultaneously, even if it is not being used. For example, all 
copier/digital definitions include machine specifications that are very useful in recording 
actual or estimated costs. Even if the specifications are not used to generate prices, job 
costing still uses the information. 

Note  Even if you decide not to use the cost plus pricing method, you can capture your 
costs for copying by entering machine specifications. Job costing uses this 
costing information and, if you use PrintSmith Downloader and Report Writer, 
you can perform even more extensive cost analysis on the resulting data. 

Cost plus pricing  
This pricing method generates prices based on actual costs to purchase, maintain, and 
run the machine. A markup is applied to these actual costs plus stock to produce a retail 
price. 

Flat rate pricing  
Flat rate pricing is generally used for short run situations such as convenience copies or  
for special purposes like engineering copies where you might charge by linear inches or 
square area instead of by clicks. 

Matrix pricing  
Matrix pricing encompasses the Copies and Originals, Copies per Original, and Total 
of all Copies methods. These methods are suitable any time you want the unit price to 
change based on the length of the job, and the copy range method (described under “Cost 
plus pricing” on page 186) is too limited. Each method differs in the way the matrix is used 
to derive the price. Each definition has its own unique matrix, which ranges in size from 1 
to 20 columns depending on pricing specifications. 
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Cost Plus method 
When you select Cost Plus as the Method, you can directly enter your costs for copying, 
even if you are using complicated lease/purchase/maintenance contracts. 

 

Copies/Minutes Enter the number of copies per minute produced by the copier. 

Open Days/Year Enter the number of days your business is open during the year. If you are 
normally open 5 days a week, the number is 5 x 52 or 260 days (minus any 
holidays). 

Open Hours/Day Enter the number of regularly scheduled business hours. This should include 
scheduled overtime and second shifts. 

Monthly Burden Rate Enter your overhead costs for this copier. 
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Monthly Payment Enter your monthly payment for the copier. If you own the copier, enter 0. 

Monthly Maintenance Enter your monthly maintenance charge. Most vendors have standard 
maintenance charges to which they may or may not add click charges. If you 
do your own maintenance, enter a reasonable periodic charge for your costs 
in maintaining the machine. Do not include toner or other consumables, but 
do include replacement parts if you have budgeted for them. 

Monthly Labor Enter your monthly labor rate for this copier. If you previously incorporated 
this information into other monthly rate fields in this window, you probably 
want to redistribute your figures. 

% Time in use Enter the estimated percentage of time the machine is usually in use. For 
example, if you are open for 8 hours a day and the machine is usually in use 
for 4 hours, enter 50%. 

Machine Cost Per 
Copy 

Shows the cost per copy. The formula is: 

 
 

Click Cost Enter the manufacturer’s charge per copy. 

Hourly costing rate Enter the cost per hour of running this machine. Account for any overhead 
implicit in running a job, including personnel and equipment. Use this value 
to compare with the actual job cost, and determine how much you are losing 
if the job costs more than this rate. 

Maximum 
Size/Minimum Size 

Enter the maximum size and minimum size fields for color and black and 
white media types only. 

Maximum 
Width/Minimum Width 

Enter the minimum width and maximum width for the large format media type 
only. 

Labor/copy Enter the additional charge for labor for each copy. 

Toner/Copy Enter the additional charge for toner for each copy. 
Developer/Copy Enter the additional charge for developer and other consumables for each 

copy. 
Copy Markup Enter the markup to be applied to the effective copy rate. The effective copy 

rate is the total of the machine cost per copy plus labor, toner and developer.  
 
Modifying stock calculations and second side pricing 
All other pricing methods have options for determining how stock is calculated and how 
the second side is priced. Use these options and adjust second side pricing with the cost 
plus method by temporarily changing the pricing method to Copies and Originals, 
making your selection and returning to the Cost Plus pricing method. Only the Side 2 
factor, Price 2 sided by and the Stock Price Is fields are used—all other settings are 
ignored. Be sure to designate the calculation of stock cost correctly to avoid unexpected 
pricing. Normally, marked up Stock Cost is used. 
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Note  Customer Stock cannot use copier 1, copier 2, and copier 3 because no stock 
exists. The stock cost entered in the job is used. An alternative is to create 
custom stock definitions for customer stock and disable the Customer Stock and 
Special Order buttons in the Job Selection window.  

All the Price 2 sided by selections are valid although using first side rate and using 
second side rate are identical because the rate is always the same. The click charge is 
doubled, but not the stock cost. All the other selections affect both click charges and stock 
charges. 
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Flat rate pricing 
In this method, the click charge is unaffected by quantity—one copy has the same unit 
price as a million, and 100 copies of one original is the same as one copy of 100 originals. 
This may be useful for pricing on a convenience copier, but it is difficult to be competitive 
with this type of pricing. 

 

Rate/Copy Enter the flat amount charged for each copy. 
Stock Markup If the Use Copiers/Digital  stock markup check box is selected, enter the 

markup you want to use instead of the standard stock markup. 

Use Copiers/Digital 
stock markup 

Select this check box to override the stock markup with the markup specified 
in the Stock Markup field above. 
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Side 2 Factor Enter the factor to price the second side of two-sided copies. The price for 
single copies is then multiplied by this factor. 

 

Calculating stock cost 
The stock selection and stock cost in the job are ignored when the Stock price is field is 
set to included in rate. Only the copy rate is used for pricing. 

When the Stock price is field is set to marked up Stock Cost, the cost of the stock is 
added to the rate per copy. The stock cost is marked up using the markup in the stock 
definition unless the Use Copier/Digital Stock Markup check box is selected, in which 
case the value in the Stock Markup field is used to mark up the cost of the stock. For 
special order and customer stock, the stock markup or customer stock markup is used 
respectively. 

When the Stock price is field is set to from Copier 1 in Stock Definition, from Copier 2 
in Stock Definition, or from Copier 3 in Stock Definition, the rate is taken directly from 
the stock definition and is not marked up. If the Use Copier/Digital Stock Markup check 
box is selected, the rate is marked up before it is used. 

Calculating two-sided copying 
To calculate side two, you can set the Price 2 Sided by field to one of the following: 

• using Side 2 Factor, which multiplies the side 1 price by the value in the Side 2 
Factor field 

• not changing price 

• using first side rate (which does not add in stock a second time) 

• using second side rate 

• counting as more originals 

Matrix pricing 
Matrix pricing uses a matrix table in the copier/digital definition to generate a “click” 
charge, to determine a volume based discount, to do stepped pricing, or to use a markup 
from a matrix table in addition to the machine cost per copy. 

To edit the matrix for a copier/digital definition, you first select the type of matrix you want 
to use: Matrix is copy cost, Matrix is discount table, Matrix is step table, or Matrix is 
Markup Table.  

 



EFI PrintSmith |  Setup Guide 

 

 
Page 192 

Then click Edit Matrix to open a matrix table where you can enter the values you want to 
use for pricing. 

Copier matrix types 
The type of copier matrix used depends on the pricing method you select.  

The examples below illustrate the standards. 

      Single Column             Use Side 2 Rate 

   
These two types of matrices can be used for Copies per Original and Total Of All 
Copies pricing methods. 

Copies and Originals 
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Copies and Originals Using Second Side Rate 

 
Copies per Originals and Total of all Copies use the single column version, while the 
10-column version is used for Copies and Originals. Both are available in a two-sided 
version when you select Using second side rate for Price 2-sided by. 

Note  Changing the pricing method or matrix type does not change the data in the 
matrix. If you enter data for all 10 columns for one- and two-sided copying this 
information is retained even if it is no longer used. 

Selected Method Matrix 

Copies And Originals The rate is located based on the number of copies row and the number of 
originals column. There are 10 columns (20 on a 2 sided matrix) available 
for pricing. The first column with a zero for the number of originals marks 
the last column in the matrix. 

Copies per Originals This method uses a single column pricing matrix (which may have 1 or 2 
sides). The rate is looked up in the matrix using the number of copies. The 
Originals field is not used in the lookup. 

Total Of all Copies This method also uses a single column matrix. The total number of copies  
made (ordered x sheets x sets) determines the rate in either a 1- or 2-sided 
matrix. 

Square Area And Originals This method is used to support large format pricing based on the square 
area of the original being copied. You would use this method if you develop 
a unit price for job based on the size of one piece and then multiply it by the 
number of pieces. This is a matrix pricing style. The matrix looks the same 
except that instead of Number of Copies it shows Total Square Area. 

Total Of Square Area This method supports large format pricing. A unit price based on the total 
square area of the job is multiplied by the number of units of area. For 
example, a job with 100 square units would look at 100 on the matrix and 
multiply the rate by 100 calculating the retail price. This is a matrix pricing 
style. The matrix looks the same except instead of Number of Copies it 
shows Total Square Area. 

Square Area and Copies Supports large format pricing. The rate is based on the entire square area 
of the copies produced and the number of copies. It requires that you open 
the pricing matrix to edit the sales price per square unit.  
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Selected Method Matrix 

Square Area per Copy Supports large format pricing. The rate is the square area of each copy, 
and can be looked up in the matrix using the number of copies. It requires 
that you open the pricing matrix to edit the sales price per square unit.  

 
Matrix is copy cost 
If you price copies using a cost table that varies by quantity or number of originals, and 
choose to add a premium on certain types of stock, this is the type of matrix you should 
use. 

The stock price is derived from the stock definition and is marked up using either the stock 
markup or the copier/digital definition stock markup when the Use CopierDigital stock 
markup check box is selected. 

The click charge is marked up using the copier markup. The stock charge and click charge 
are added together resulting in a final price. 

Matrix is discount table 
If you price copies by setting a standard price for each stock which then is discounted 
based on the quantity or number of originals, you should use this style. The base rate in 
the copier/digital definition is the basic click charge for a single copy of one original. 

Matrix is step table 
If you price each range of copies separately and add them up, use this step style of 
matrix. 

Example of a step table: If the first 3 entries in the table are 100 at .06, 200 at .05, and 
300 at .04, and the quantity to price is 250, it would be calculated as follows: 

100 x .06 = 6.00 
100 x .05 = 5.00 
50 x .04 = 2.00 
Total = 6.00+ 5.00 + 2.00 = 13.00 
 

This is similar to the copy range table available in the Cost Plus method except there are 
14 ranges and many more options for handling multiple originals, stock pricing and two 
sided copying. The stock charge is calculated using the same rules as copy cost matrix. 

Matrix is markup table 
Use a markup table if you want to calculate the rate based on the machine cost per copy  
and have markups based on different numbers of copies.  

Square area from run size 
This style calculates the area from the run sheet. If the Square Area and Originals, Total 
of Square Area, Square Area and Copies, or Square Are per Copy pricing method is 
used, this style can be selected. 
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Square area from finished size  
This style calculates the area from the finished sheet. If the Square Area and Originals, 
Total of Square Area, Square Area and Copies, or Square Are per Copy pricing 
method is used, this style can be selected. 

Stock price 
The stock component of the copy price is determined using the following rules: 

Stock Price Is Resulting Stock Charge 

included in rate No separate stock charge is calculated. 

marked up stock cost The cost for each sheet is marked up using the stock cost (or standard 
stock or customer markup for special order and customer stock). You 
can override this by selecting the Use Copier/Digital Stock Markup 
check box. 

from Copier 1 in stock 
definition 

Only works with “in stock” papers and adds the up charge listed in the 
copier 1 field in the stock definition, otherwise it defaults to marked up 
stock cost. This value is only marked up when the Use Copier/Digital 
Stock Markup check box is selected. 

from Copier 2 in stock 
definition 

The same as copier one except that the value taken from the stock 
definition is from the copier 2 field in the stock definition. 

from Copier 3 in stock 
definition 

The same as copier one except that the value taken from the stock 
definition is from the copier 3 field in the stock definition. 

The discount factor is looked up in the matrix and multiplied by the total of the base rate 
and the stock price. This is the click charge for this quantity. 

Using matrix-based pricing 
If the matrix is a copy cost matrix, the price per copy is calculated as follows: 

(cost x markup) + (stock cost x markup) 

If the matrix is a discount table, the price per copy is calculated as follows: 

(rate x discount factor) 

If the matrix is a markup table, the price per copy is calculated as follows:  

machine cost per copy + the markup from the matrix table 

If the matrix is a step table, the price is calculated in a complicated fashion. 

There can be as many as 15 rows and 10 columns in the matrix. They may have separate 
columns for single- and double-sided copying. Any bottom row containing 0 in the Number 
of Copies column is the last row used in the lookup. In the Copies and Originals (10 
column) matrix, the bottom column with a 0 in Number of Originals is the last column 
used. 
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Pricing for two-sided copies 

Price 2 Sided by not 
changing price 

Means there is no difference in price between one-sided and two-sided 
copying 

Price 2 Sided by using first 
side rate 

Doubles the price for clicks (but not for stock which is added only once) 
using a single-sided rate matrix. 

Price 2 Sided by using 
second side rate 

Uses a two-sided matrix. The rate looked up in the matrix is from the side 
two column on a two-sided job. This click charge is doubled and added to 
the stock charge. 

Price 2 Sided by counting 
as more originals 

Has the effect of doubling the number of originals before performing the 
lookup. This does not affect the stock charge, which is not doubled. This is 
equivalent to pricing a single-sided job as twice the amount ordered except 
for the stock charge. 100 two-sided copies are priced the same as 200 one-
sided copies with a stock charge added for 100 sheets. 

Price 2 Sided by using Side 
2 Factor 

Calculates the price for single-sided copying and multiplies it by the factor 
in the Side 2 Factor field. 

Adding charges to copier/digital definitions 
Just as with press definitions, you can add up to 10 present charges to each copier/digital 
definition. In order entry, when you select a copier, any preset charges are automatically 
added to the job. If you select a different copier, the charges attached to the old copier are 
discarded and the charges for the new copier are used. 

The process of adding charges to copier/digital definitions is the same as adding them to 
press definitions: click Add Charges in the Copier/Digital Definitions window. For more 
information, see page 167.  

Strategies for using preset charges 
The biggest advantage to using preset charges is the ability to generate complex quotes 
in a faster and more consistent manner. Often, complex quotes can be delegated to less 
knowledgeable employees with a much greater degree of confidence.  

Many different strategies exist for defining copier/digital definitions and deciding which 
charges should be preset. Be consistent in your use of preset charges. For example, 
stapling charges should be attached to all copier/digital definitions that are used for 
multiple originals. You could also set up a carbonless copier definition, which includes 
charges for padding and set up another copier definition for hand-collated carbonless jobs 
which include hand collating charges. Keep it simple and make it easy for your staff to 
use. 



Defining Pricing 

 

 
Page 197 

Example of copier/digital definition 
A popular pricing method for copies is based on a matrix of copies and originals.  

 
In this example, the copier definition is named Text 8.5 x 11 B&W Digital. It runs at 90 
Copies/Minutes, uses the pricing method Total of all Copies, and has an ID of 1 (for 
reporting work in progress).   

Sales from this copier/digital definition are recorded in sales category B&W Copy. No 
charges are attached to the definition. The matrix used is the copy cost method. 

The Copy Markup is set to 1 and the Stock Price is field is set to marked up Stock 
Cost. The second side is priced by counting as more originals.   

No 
charges 
are 
preset 
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If you click Edit Matrix, the following table opens: 

 
Here you enter your base copier rate. This is usually the base 20# bond rate. PrintSmith 
can automatically add a retail paper up charge to this matrix by looking back at the stock 
definition. Another popular method is to enter the basic click charge in this matrix and 
have PrintSmith automatically add the actual cost of the stock. Many options are available 
depending on your needs.  

Waste charts and copier/digital definitions 
Although a default system waste chart exists, each type of copier/digital definition may 
have different spoilage characteristics. As a result, each copier/digital definition can have 
its own waste chart. 

You manage waste charts and assign them to copier/digital definitions just as you do with 
charge definitions. (For information about setting up the default waste chart and managing 
waste charts, see “Waste charts and charge definitions” on page 142.) Once a waste chart 
is assigned to a copier/digital definition, the name of the waste chart is displayed to the 
right of the Waste Chart button in the Copier/Digital Definitions window. 
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Stock Definitions 
Stock definitions provide information about the papers (and other materials such as rigid 
substrates) used in your operation, for example, their cost, the size you purchase, the size 
you normally run, and the equipment on which you normally run the stock. 

There are four areas you need to review in each stock definition—the description, 
specification and pricing, pricing options, and inventory (optional).  

On the Pricing menu, click Stock Definitions. The Stock Picker window opens letting you 
search for and select a stock. 

Searching for stocks 
The top part of the Stock Picker window has fields that you can complete to search for 
stock that matches the criteria you specify. Many fields in the top part of the window have 
built-in selections. (You set up and customize these selections in Table Editor.) 

 
Stock information is displayed in a list. In addition to scrolling through the list, you can click 
any column title to sort the stocks by that column, for example, by vendor.  

Note When you open a stock definition in a multi-user system, its record is locked and 
unavailable to others.  

Click a 
column 
title to 
sort 
stocks 
by that 
column 

Filter by 
stock 
type 
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Customizing the Stock Picker window 
You can customize the Stock Picker window in the Preferences Stock Definitions panel. 
For details, see page 73.  

Printing lists of stocks 
1.  Click a particular stock in the Stock Picker window. 

2. On the File menu, click Print.  

3. The stock list that is printed is based on the Group to which the stock belongs. 
Paper is the default group. Select a stock from each group and print a listing. 

4. Review all the stock definitions and either delete them or customize them as 
described below. 

Deleting stocks 
If your company does not use certain stocks or stops using them, you can delete the 
stocks so they are not listed in the Stock Picker window. 

To delete a single stock 
1. In the Stock Picker window, click the stock you want to delete. 

2. Click Delete. 

3. Click Yes to confirm the deletion. 

To delete several stocks at once 
1. To delete a range of stocks, in the Stock Picker window, hold down Shift while 

you click the first stock in the range and then click the last stock. To delete 
several non-contiguous stocks, hold down Cmd or Ctrl as you click each stock 
you want to delete. 

2. Click Delete. 

3. Click Yes to confirm the deletion. 

To delete all stocks and start over 
If you want to delete all the stocks you entered and start over, you can delete the Stocks 
file. 

Caution  Never delete all stocks in a system that is being used, only during initial setup. 
1. Exit PrintSmith. 

2. Delete the Stocks file from the Prices folder.  

3. Restart PrintSmith. 



Defining Pricing 

 

 
Page 201 

4. On the Pricing menu, choose Stock Definitions.  

5. You will receive an error message about the missing file: “The Stock Index file is 
damaged...OK to repair the Stock Index file?” (Unless you are just getting 
started, this is a serious error, and you should contact Customer Support.) Click 
Yes to continue. You can now create a new stock list. 

Sharing stocks among PrintSmith systems 
If you have more than one PrintSmith system (perhaps at different locations or stores), 
you can set up stock definitions on one system and then export selected stock definitions 
from that system and import them into one or all of your other systems. This allows you to 
standardize your stock definitions when appropriate without having to recreate them on all 
your systems. 

If you later make changes to a stock definition you shared with other systems, you can 
export the changed definition and update the definition on the other systems. 

In order to export and import stock definitions, the Enable Pricing system Import/Export 
features check box in the Behavior preferences panel must be selected (Admin > 
Preferences > System > Behavior). When this check box is selected, the Stock Picker 
window includes an Export button and the File menu includes an Import command. (After 
selecting the Enable Pricing system Import/Export features check box, you must 
restart PrintSmith for the File menu to include the Import command.) 

To export stock definitions 
1. In the Stock Picker window, either select a single stock or select multiple stocks. 

(To select a range of stocks, hold down Shift while you click the first stock in the 
range and then click the last stock. To select several non-contiguous stocks, hold 
down Cmd or Ctrl as you click each stock you want to export.) 

 
2. Click Export.  

3. In the File Save As dialog box, select a location for the Stocks.xml file. (You can 
change the name of the file if you want.) 

4. Make the Stocks.xml file available to the PrintSmith systems where you want to 
import the stock definitions. For example, copy Stocks.xml to a shared network 
folder or attach it to an e-mail. 

To import stock definitions 
1. On another PrintSmith system, select File > Import. The Import XML window 

opens. 
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2. Indicate whether you want to Add Records, Update Records, or Add and 
Update. For example, you may just want to add new stock definitions but leave 
existing stock definitions as they are (if you happened to customize them on the 
system). 

3. Click Browse to locate the Stocks.xml file you want to import. 

4. Click Import.  

Viewing and modifying stock definitions  
To view a stock definition, select a stock in the Stock Picker window and click Select 
Stock. The Stock Definitions window opens.  

 
The top part of the window has a general description of the stock; the bottom part has 
three tabs: Specification and Pricing, Pricing Options, and Inventory. 
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Stock description 

 
The top part of the window contains the following fields, which are visible at all times in the 
Stock Definitions window. 

Group 
 

Select a way to group the stock by its overall attributes. Five groups are 
predefined: Paper, Envelopes, Carbonless, Rolls, and Other. Groups are 
set up in the Stock Group table in the Table Editor; you can change the 
names of groups and add more groups. EFI recommends that you refrain 
from changing the name and function of the five predefined groups because 
stock imports from vendors rely on these groups to some degree. If you do 
change the groups, imports from vendor catalogs still work, but the group in 
which newly imported stocks are placed may not be what you expect. 

Class The Stock Picker does not use this field. It was retained for use with the 
original Stock Lister.  

Metric 
 

Select this check box to use the metric system. The system used for 
measuring metric stocks in much simpler and more straightforward than the 
system used in the U.S. The principal difference is a common basic size 
(A0), which means that there is no need to calculate M weight, and the basic 
size is always the same. When the Metric check box is selected, the M 
weight and basic size fields are removed from the stock definition and the 
thickness measurement is changed to microns (one millionth of a meter). 

Envelope 
 

Select this for envelope stock. Doing so makes the M Weight field editable. 
Since envelopes are manufactured products, they do not have an M Weight 
from the manufacturer. 

Sheet Stock Select this for sheet stock. Different options are displayed on the tabs below. 

Roll Stock Select this for roll stock. Different options are displayed on the tabs below. 
Large Format Select this for large format stock. Different options are displayed on the tabs 

below. 
Rigid Substrate Select this for a rigid substrate material. Different options are displayed on 

the tabs below. 
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Name 
 

Enter a description of the stock. Since PrintSmith sorts the list alphabetically, 
avoid extra spaces and misspellings. Limit the name to a description since 
there are separate fields for weight, color, finish and size. Use the Stocks 
and Sizes preference panel (see page 69) to decide how to combine the 
name, weight, and finish in those cases where the stock description is 
presented as a single data element, for example, in a stock order, invoice, or 
job ticket. 
You may want to modify the names of your existing stock definitions to 
remove text that is tracked in other data fields. At a minimum, remove the 
weight and finish from the name. 

Finish 
 

Select a finish such as linen or laid. (Finishes are stored in the Stock Finish 
table where you can edit them with Table Editor.)  

Weight 
 

Enter the basic weight of a stock. This field is used to calculate the M 
Weight and Carton Weight of the stock (on the Specification and Pricing 
tab as described below). If the weight is part of the stock name, EFI strongly 
recommends removing it from the name and entering it only in this field. 

Color 
 

If you plan to import stock catalogs from vendors or order stock 
electronically, enter the full “mill” color for each stock definition. For example, 
if the mill color is Avon Brilliant White, enter that in the Color field rather 
than just White. 
Colors are stored in the Stock Color table where you maintain them with 
Table Editor. In this table, each mill color (25,000 are supported) is 
associated with a generic color. In the above example, Avon Brilliant White 
would have a generic color of White. This lets you find a stock using either 
the mill color or the generic color. 

Generic Color 
 

Enter a generic color for each stock definition. Doing so considerably 
enhances the power of the Stock Picker when you are searching for stock. 
When you select a stock that does not have a generic color assigned, 
PrintSmith checks the Stock Color table to see if there is a generic color for 
that stock color. If it finds a generic color, it automatically assigns it to the 
stock definition. If the stock color in the table does not have a generic color, 
PrintSmith asks you to select one and then updates both the Stock Color 
table and the stock definition with your selection.  

Grade 
 

Select the grade of the stock, for example, #1 Coated, #1, #2, #3, and so on. 
Grades are stored in the Stock Grade table where you maintain them with 
Table Editor. 

Coated Enter 1 for stock coated on one side or 2 for stock coated on two sides. 

Last Updated Shows the date the stock definition was last changed in any way. 

Last Price 
Change 
 

Shows the date the last change was made that affected the costs or prices of 
the stock. This could be the result of using Pricing > Change Prices or 
changing blank pricing in the Stocks and Sizes preference panel, not just 
changing the price directly in the Stock Definitions window. 
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Specification and Pricing tab 
The settings on the Specification and Pricing tab depend on the type of stock being 
defined (for example, Sheet Stock versus Roll Stock). The differences are noted below.  

Note Keep in mind that although you do not specify units when entering weights or 
lengths in PrintSmith, the values must be consistent with each other. For 
example, do not use pounds in one field and ounces in another, or mix feet and 
inches. 

Vendor 
 

Select the vendor of the stock. Vendors are stored in  Vendor table where 
you maintain them with Table Editor. If you purchase the same stock from 
multiple vendors, you should create a stock definition for each vendor. 

Stock # 
 

Enter the stock number used to order this stock from the vendor. You can 
enter a combination of up to 31 letters and numbers. 

Tip  You can search for a stock with a particular stock number. To do 
so, enter / or ? followed by the stock number while in a blank stock 
record. 

Stock Type 
(Envelope and 
Sheet Stock only) 
 

Select the type of paper: Business, Book, Cover, Index, or Tag. In non-
metric stocks, this information is critical because it determines the basic size 
of the stock, which determines the M weight, the carton weight and the CWT 
(hundred weight) price. Stock types are stored in the Basic Sizes table. 
Generally, you should not modify this table unless you are certain of the 
changes you are making. This table already includes all the common stock 
types and associated sizes. 

Basic Size 
(Envelope and 
Sheet Stock only) 

You cannot edit this field. It shows the size associated with the stock type 
you selected. This size is used to calculate both the M weight and the CWT 
price. 

Parent Size 
(Envelope, Sheet 
Stock, and Rigid 
Substrate only) 
 

Select the size of the stock you purchase from the vendor. For envelopes, 
use Table Editor to set up common text descriptions such as #10 in the 
Sizes table. This also applies to international sizes such as A2, A4, and A6. 
You can quickly enter a size from the numeric keypad by entering two 
numbers separated by /, for example, 17/28. PrintSmith automatically 
expands this to 17 x 28. 

Roll Width 
(Roll Stock and 
Large Format only) 

Enter the width of the entire roll you purchase from the vendor. 

Thickness 
 

Enter the thickness of the paper in one of these units: caliper, points, mils, 
thous, plies, microns, or millimeters. Microns and millimeters are used for 
metric stocks while the other types of units are interchangeable and are used 
for certain types of stocks as follows: 
Caliper. Caliper is the thickness of a paper measured in thousandths of an 
inch, traditionally applied to most printing papers which are between 0.001 
and 0.008 inch thick. 
Microns. A micron is one millionth of a meter and is a unit of thickness for 
metric stocks. 
Points. One point is the equivalent of 0.001 inch, traditionally used to 
indicate heavy card stock such as coated covers. For example, 12 point 
cover is 0.012 inch thick (12 points x 0.001in.) 
Thous. One thou is equal to 1/1000th of an inch. 
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Mils. One mil is equal to one thou. 
Plies. Plies are traditionally used to indicate the thickness of card or 
chipboard. A sheet of 6-ply board is 0.024 inch thick. (Multiply the ply value 
by 3 and add 6 to that result.) 
Millimeters. A millimeter is one thousandth of a meter and is a unit of 
thickness for metric stocks. 

M Weight 
(Envelope only) 
 

Shows the scale weight in pounds of 1,000 sheets of paper of a given size. 
The given size in PrintSmith is the Parent size in each stock definition. This 
parent size is compared to the basic paper size to determine the 
comparative weight or estimated M weight. For example, the calculation for 
stock with a basis weight of 20 pounds in a 17 x 22 parent sheet that has a 
basic size of 17 x 22 is as follows: 

 
Sheets/Carton 
(Envelope and 
Sheet Stock only) 

Enter the number of sheets of the parent size in a single carton. You can 
also use this field to specify the number of parent sheets in a skid. 

Rolls/Order 
(Roll Stock only) 

Enter the minimum number of rolls that you will sell at one time. As you 
cannot purchase a partial roll, this field should be either 0 (zero) or the 
number of rolls that must be purchased. 

Roll Weight 
(Roll Stock only) 
 

Enter the weight of an entire roll. 
 

Carton Weight 
(Envelope and 
Sheet Stock only) 
 

If the Stock Type is correctly selected or the stock is a metric size, and the 
basis weight is known, PrintSmith is able to calculate the M weight. The M 
weight is used to determine the weight of a carton (or skid). The formula for 
calculating the carton weight is: 

 
These two fields define the order information for a particular stock. The 
carton weight for 1,000 sheets equals the M weight. If the carton holds only 
500 sheets, the carton weight is half that amount. 
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Min. Order 
 

• For Envelope and Sheet Stock, if stock can be ordered in any 
quantity, enter 1 in this field. If the stock has a minimum order, such as 
ream wrapped stock that can only be ordered in sets of 500, enter 500 
in this field. This ensures that the stock order and job ticket properly 
reflect the amount of stock to be ordered. In addition, it allows you to 
pass on the cost for ordering more stock than absolutely needed to your 
customer. 
 
Example: In the Production Data window in the Estimator, if a job 
requires 200 sheets and the minimum order for the stock is 250, 250 is 
displayed in the Sheets Purchased field. Although the number of 
sheets purchased may be greater than needed for the job, production 
charges are based on the number of sheets used in the job, not the full 
quantity purchased. 

• For Roll Stock, enter the minimum weight of this stock that you will sell 
at one time. 

• For Large Format stock, enter the minimum length of this stock that 
you will sell. 

• For Rigid Substrate stock, enter the size of the full sheet in square 
units, for example, 864 for a 24 x 36 sheet. 

Charge Customer 
for Entire Order 
 

Select this check box to add the cost of the entire stock order to the stock 
charge for the job. This cost is marked up in the usual manner, but the 
additional sheets are not included in the charge for printing or copying. Using 
the previous example, the stock cost reflects the 250 sheet minimum 
purchase. 

Forest 
Management 

For Chain of Custody purposes, select the type of forest management used 
for this stock: FSC Mixed, FSC Pure, Green Seal Certified, or SFI 
Participant. 
Tip You can set Stocks and Sizes preferences to specify what kind of Chain 

of Custody information is included on your job tickets and invoices. See 
page 69. 

PCW Recycled % For Chain of Custody purposes, enter the percentage of recycled post 
consumer waste in the stock. 

FSC Certified Select this check box if the stock is FSC certified. 

SFI Certified Select this check box if the stock is SFI certified. 

Green Seal 
Certified 

Select this check box if the stock is Green Seal certified. 
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Costing Units 
 

• For Envelope and Sheet Stock, enter the quantity in which the stock is 
priced. Usually this is 1,000 since most stocks are priced in lots of 
1,000. Envelopes often come 500 to a box and are priced that way. 

• For Roll Stock, enter units of weight instead of quantity. The costing 
unit is the weight by which the roll stock is priced, for example, 100 
pounds. Use the Weight Breaks fields to define the price for varying 
weights. 

• For Large Format stock, enter units of square area instead of quantity. 
The costing unit is the area by which this stock is priced, for example, 
36 in x 24 in. Use the Area Breaks fields to define the price for varying 
areas. 

• For Rigid Substrate stock, enter the square area, for example, 864 
inches for a substrate that is 36 inches by 24 inches. 

# Sheets/Set 
(Envelope and 
Sheet Stock only) 

This field is used to define carbonless stock in pre-collated sets. For 
example, if you have a 3-part carbonless stock, enter 3 in this field. The 
Estimator can then automatically make the correct calculations based on the 
number of sheets in a set. 

Cost is in Sets 
(Envelope and 
Sheet Stock only) 
 

This feature is intended primarily to enhance carbonless pricing. Select this 
check box to indicate that the cost entered is for sets, not individual sheets. 
The setting of this check box automatically changes the cost of the stock. For 
example, a 2-part carbonless set is priced at $200.00 per 1000 sets with the 
Cost is in Sets check box selected. If the check box is cleared, the prices 
changes to $100.00, because the price is now based on half as many 
sheets. The Estimator handles pricing for this stock correctly regardless of 
the setting you choose. EFI recommends setting it to match how each of 
your vendors specifies the stock. 

Qty Breaks 
(Envelope, Sheet 
Stock, and Rigid 
Substrate only) 
 

Enter the maximum quantity of parent sheets for each column in the price 
table. For example, if you enter 1000, 2000, and 3000 in the first three 
columns, PrintSmith uses the first column for the stock cost and markup for 
quantities up to and including 1000. The second column is used for 
quantities from 1001 to 2000. The third column is used for quantities greater 
than 2000. Enter a quantity in this field for any column you want to use or 
PrintSmith assumes that it is not used. 

Weight Breaks 
(Roll Stock only) 

Enter the maximum weight of the roll stock for each column in the price 
table. 

Area Breaks 
(Large Format only) 

Enter the maximum area of the of large format stock for each column in the 
price table. 

Cost 
(Envelope, Sheet 
Stock, Large 
Format, and Rigid 
Substrate only) 

Enter the cost of the stock and the number of pieces you can buy at that 
price. Normally this is the cost per 1000. Envelopes usually come in boxes of 
500. In that case, use 500 for the units. 
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CWT 
(Envelope, Sheet 
Stock, and Roll 
Stock only) 
 

CWT stands for Hundred Weight Price. Enter the cost for 100 pounds of 
paper regardless of size. CWT pricing is a convenient way to compare paper 
prices for different stocks in different sizes. Although there is some variation 
within a given stock family for different size stocks, the CWT price is 
generally similar. You can enter a cost in either the CWT field or the Cost 
field, and the other field is calculated provided there is sufficient information 
available in the stock definition to make the calculation. 
In order to calculate the CWT price, the Basic Size and Weight must be 
entered and be correct. 

Markup 
 
 

Enter the amount to mark up the cost of the stock. If the markup in the first 
column does not appear to be overridden (overrides are shown in underlined 
italic), you are actually looking at the standard stock markup defined in the 
Stocks and Sizes preferences panel. 
Normally you do not need to alter the standard stock markup in the first 
column. Only change it if you want a particular stock to be marked up 
differently from the standard stock markup you specified in the Stocks and 
Sizes preferences panel. Enter a markup rate in columns 2 through 6 when 
the markup you want to use is different from that in the first column. Leave 
the markup fields empty across the row unless the rates in columns 2 
through 6 are different from the first. 

Note  If you change the system default stock markup in your 
preferences, you change the markup for all stock definitions 
except those which you overrode. 

List/M 
(Envelope and 
Sheet Stock only) 

Enter an additional price per thousand sheets to use with the list pricing 
method because list pricing does not factor in the stock cost when 
generating a price. The amount (plus or minus) entered in this field is divided 
by 1000 and multiplied by the quantity ordered and added to the price of the 
job. 
Example: A price schedule is used for a stock, which costs $10.00 per 
thousand. You want to use it for a stock that costs $11.00 per thousand. If 
you enter 1.00 in  the List/M field, PrintSmith adds 1.00 to each thousand 
ordered. 

Price Expires 
 

This information is only provided when you import stock prices from a third 
party stock vendor. It tells you whether the price shown in the stock definition 
is valid. If the price has expired, you receive a warning message that the 
price has expired, but you can still use the stock. 
Although EFI defined this field as part of the generic vendor stock import 
data format, EFI knows of no paper vendors that have implemented it. This 
field is intended to support the idea that the paper price quoted by the vendor 
is honored until the expiration date of the price in the stock definition. If your 
paper vendor supports imports into PrintSmith, you may want to ask the 
vendor when they will support this feature. 

Comment Enter any notes related to the stock and ordering process. 
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Pricing Options tab 
Use the Pricing Options tab to set up specifications used by the Estimator to price jobs 
using this stock. The fields on this tab depend on the type of stock you chose. 

 
On this tab, fields that do not apply Envelope, Roll Stock, and Large Format Stock are not 
displayed when those stock types are selected. These are noted in the following table. 

Normal Run Size 
(Sheet Stock and 
Rigid Substrate 
only) 
 

Specify the most common run size when you create a job using this stock 
definition. This size is also used as both the run and finish size when you 
generate a price list (Pricing > Generate Price Book). PrintSmith 
automatically calculates the number of sheets that can be cut out of the 
selected parent sheet. If you do not specify a run size, PrintSmith assumes it 
is the same size as the parent size. 

Cut/100 
(Sheet Stock and 
Rigid Substrate 
only) 
 

Enter the cut charge for each 100 parent sheets. This charge is added to the 
stock cost and is useful when the vendor charges for cutting parent sheets to 
the size you entered in the Parent Size field on the Specification and 
Pricing tab. The cut charge includes estimated waste and is added to the 
cost of the stock after the stock is marked up. The cut charge itself is not 
marked up. 

Tip  For best results, add a pre press cutting charge to the stock 
definition instead of using the Cut/100 field since a charge is much 
more “intelligent” about how many cuts and lifts are needed. 

Min. Cut Chg 
(Sheet Stock and 
Rigid Substrate 
only) 

Use this in conjunction with the Cut/100 field to specify a minimum charge 
for cutting. If no cut charge is specified, the minimum is added to the stock 
for all quantities. 
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Select Press for 
Printing 
 

Select the press you want to use with the stock. If you do not want a preset 
press for the stock, select <use default>.  
When you select a stock definition that has a preset press, PrintSmith 
assigns the press to that job and adds any charges that are preset in the 
press definition. If you select a stock definition without a preset press, 
PrintSmith assigns the “default” press, the first press in the definition list. 
PrintSmith is designed so that you can use the press definition as a way of 
defining a production environment. If you know a stock is always used in a 
particular production environment, you can create a press definition and 
preset the press for each stock definition to which it applies. Good examples 
include carbonless forms and envelopes. 

Select Schedule  
 

Click this button to select the price schedule you want to use for the stock. If 
you select a stock in the Estimator which does not have a preset schedule, 
PrintSmith warns you and uses the default price schedule, which is the 
default list price schedule. 
When a price schedule is assigned to a stock, its name is displayed to the 
right of the Select Schedule button. To remove a preset schedule, click 
Select Schedule and then click Cancel when the schedule list is displayed. 

Pricing for Blank 
Sheets 
(Envelope, Sheet 
Stock, and Rigid 
Substrate only) 
 
 

Enter six prices for six different quantity breaks for blank sheets. Each price 
can be based on the cost of the stock at a different markup. As shipped, 
these quantity breaks are 1, 10, 100, 500, 1000, and 5000, but you can 
change the quantity breaks and markups to anything you like in each 
definition. You can also change the system default values in the Stocks and 
Sizes preferences panel. (See page 69.) 
PrintSmith calculates the price for blank stock at the defined quantities using 
the standard markups. If you change the quantities in the stock definition, 
PrintSmith calculates the price using the quantities you entered with the 
markups in the Stocks and Sizes preferences panel. 

Auto Calculate 
Blank Stock 
(Envelope, Sheet 
Stock, and Rigid 
Substrate only) 
 

The blank stock pricing style relies on pre-calculated prices that are based 
on the cost of the stock. Select or clear this check box to turn automatic 
calculation on or off for the stock. If you clear this check box and then select 
it, the current stock is automatically calculated. 
The Auto Calculate Blank Stock check box lets you control, for each stock, 
whether or not you want PrintSmith to maintain these rates for you 
automatically. EFI recommends that you leave this check box selected 
unless you have very specific pricing targets for blank stock that do not 
depend on the stock cost. 
Any change to the stock price triggers automatic calculation. The price is 
calculated for the run size based on the parent size. 

Note  A change to this check box does not recalculate blank sheet 
pricing. You can use Pricing > Change Prices to update prices 
for all stocks. 
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Adjust 
Copier/Digital 
Matrix and Select 
Default 
(Envelope, Sheet 
Stock, Large 
Format, and Rigid 
Substrate only) 
 

PrintSmith supports several pricing models for copying. One important option 
is the ability to specify how stock is priced. In some models, the price is 
taken directly from the cost of the stock. In others, each stock may need to 
have a stock price for copying that differs from its actual marked up cost. 
The Copier 1, Copier 2, and Copier 3 rates are provided so you can have 
different stock costs for copying with each stock definition. The rate that is 
used for pricing depends on the copier/digital definition used for the job. 
Because each definition can use either of these fields you should decide how 
each is to be used. For example, commonly Copier 1 is used for black and 
white, Copier 2 for color, and Copier 3 for large format copies. 

Note  Copier 1, Copier 2, and Copier 3 are actually based on the name 
of the copying pricing methods. These pricing method names can 
be (and often are) changed. You may therefore see different 
selections on your system. 

Each stock can have a preset copier for each of the three copier/digital 
pricing methods. To preset a default copier, select the copier from the list. 
When a stock with a preset copier/digital definition is selected in a copier job, 
PrintSmith assigns the copier to that job and adds any charges that are 
attached to the copier/digital definition. To remove a preset copier, select  
<use default copier>. 

Add Charges 
 

Each stock definition can have up to 10 preset charges. Click this button to 
edit the preset charge list. When charges are already assigned to the stock 
definition, the number of charges is displayed as (1) Charges…, with the 
number in parentheses indicates the number of preset charges. See “Adding 
charges to stock definitions” on page 215.  

Import One Stock 
 

Click this button to import a file containing a single stock definition, which is 
displayed in the Stock Definitions window for immediate editing. The data file 
must contain a single stock record that was exported from the xpedx 
Printer’s Product Guide or other paper vendor. The location of the file and file 
format must be set up with Pricing > Import Stock Catalog.  
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Inventory tab 
Use the Inventory tab to set up stock as inventory items.  

 

Stock is Standard 
Inventory Item 

Select this check box to activate the Inventory tab fields so that the stock 
can be entered as an inventory item. 

Stock on Hand Enter the amount of stock that is currently in inventory. (For large format 
stock, this is the length, not the total area.) 

Committed Shows the amount of stock committed to current jobs that were not yet run. 

Note  Committed stock can be manually entered or automatically 
calculated. As stock is selected and assigned to a job, the 
committed number increments. Stock committed prior to the stock 
being defined as a standard inventory item does not affect the 
inventory count. 

Available Shows the amount of stock that is available. This is the difference between 
Stock on Hand and Committed. You cannot edit this field.  

On Order Enter the amount of stock currently ordered. 
Target Level Enter the amount of stock you want to keep in inventory. 

Reorder Point Enter the “trigger-point” at which new stock should be ordered. 

Min. Order Qty. Enter the minimum amount that can be ordered at one time. 
Stock Expires Enter the expiration date of the stock, if applicable. The default is <never>. 

Bin Location Enter an identifier for the stock storage location. 

Shell Item If this item is a shell item created by the shop for use in another job, select 
this check box and optionally click Assign Customer Account. 

  

Recent 
inventory 
changes 
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10 Most Recent 
Inventory 
Changes 

Lists the 10 most recent inventory changes. Click Show Entire History to 
open the complete Inventory History window. 

Changing prices 
On the Pricing menu, click Change Prices if you want to increase or decrease prices 
across the board on all or some stocks. 

 
Enter the criteria to change prices. For example, you could auto update all stock records 
by 10% for the Mac Paper vendor in the Paper group.  
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Adding charges to stock definitions 
Charge definitions add a tremendous amount of flexibility to the PrintSmith Estimator. You 
can attach charges to a stock definition. When you then select a stock, the preset charges 
are automatically loaded. If you select a different stock, the charges that were attached to 
the old stock are discarded and the charges attached to the new stock are loaded. 

The biggest advantage to using preset charges is that it gives you the ability to generate 
complex quotes quickly in a more consistent manner. For example, in the case of stocks, 
you could add a pre press or bindery cutting charge so you always charge for cutting (as 
long as there was no minimum or setup charge in either definition). You could also add a 
carbonless padding charge to all carbonless stock definitions because carbonless stock 
rarely leaves the shop unpadded. In general, add a charge for an activity that occurs most 
of the time. You can also set up these types of preset charges as hidden charges, and 
they will not be printed on customer documents.  

To add charges to a stock definition, click Add Charges on the Pricing tab in the Stock 
Definitions window. The Charge Selector window opens. The process of selecting charges 
is the same as for presses. For details, see page 167.  

Tip  You can also use Pricing > Change Prices to add charges to groups of stock 
definitions automatically (on the Stock Definitions tab). 
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Other prices 
Select Pricing > Change Prices > Other Prices to raise or lower prices on presses, 
copiers, charges, and list price schedules. 

 

Importing the stock catalog 
You can import stock definitions and update prices from an electronic price catalog from a 
vendor. PrintSmith works best with xpedx, which has developed a Printer’s Product Guide 
that can be used to find and export stock definitions and prices for an individual stock. In 
addition, xpedx has developed an export utility that can export large groups of stock into a 
file that PrintSmith can read and then update all the xpedx stocks in the Stock file. 

The Import Stock Catalog (Pricing > Import Stock Catalog) window has three tabs. The 
first tab controls the overall process. The remaining tabs are used to verify the import 
process based on the selected interpreter. 
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Settings 
Use the Settings tab to control the import process. 

 

Use Xpedx 
Interpreter 
 

Select this option to import data from the xpedx pricing catalog. See the 
Xpedx tab for the expected file format. Generally, this file must be created 
using the xpedx Export Utility that creates a file named data.txt. Normally, 
the file is in the catalog folder although this can be changed in the xpedx 
utility. The export utility and documentation are available from an xpedx 
representative for both the Macintosh and Windows platforms. 

Use Generic 
Interpreter 

Select this option when importing data from any other pricing catalog. See 
the Generic tab for the expected file format. 

Verify Each Stock 
 

Select this check box to be asked whether you want to save changes to a 
new definition or to an existing one before adding or importing a stock 
definition. 

Import File 
 

Specify the location of the file containing the stock data to import. (Click 
Browse to locate the file.) Once set, this file name is remembered and 
should not need to be reselected. 

Note  You must specify the import file before doing anything on the  
Xpedx or Generic tab.  
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Adjust Bracket by 
Percent or 
Amount 
 

Indicate whether you want to change the bracket price being imported by 
either a percentage or a fixed dollar amount. Increase the price by entering a 
positive percentage or amount or decrease the price by entering a negative  
percentage or amount.  

Price 1…Price 5 
 

Select the price brackets you want to adjust. If you select just one bracket, 
for example, Price 4, the stock cost is placed in the fist price column in the 
stock definition. If you select two brackets, for example, Price 2 and Price 4, 
these brackets would be imported into the first and second price columns for 
the stock definition, respectively. 

Metric 
 

Select this check box to import metric information. This automatically selects 
the Metric check box in the stock definition, too.  

No Broken 
Cartons 

Select this check box to set the Min. Order field in the stock definition to the 
value of lot count when importing.  

Full update, not 
just Prices 

Select this check box so that all information about existing stock is updated 
when you click Update Prices, not just prices. For example, if the name of 
the stock changed, it will be updated. 

Update Prices 
 

Click this button to use the imported data to update existing stock definitions. 
Locate stock definitions by vendor name and stock number (Stock # in the 
Stock Definitions window). Stocks in the import file, which are not in the 
stock definitions, are not added. 

Import All 
 

Click this button to use the imported data to create new stock definitions. 
This is identical to updating prices except that stocks are added if they do not 
already exist.  

Testing pricing 
Testing is a key step before going online (“live”) with PrintSmith. After you enter your 
pricing definitions you should create estimates and generate price lists to ensure you are 
getting the prices you want, and that the specifics you entered work properly. A good way 
to verify your pricing is to take a sample of recent invoices and re-create them in 
PrintSmith. This process verifies your pricing is complete and makes you familiar in using 
PrintSmith. 

When you are ready to go live, you can reset your system to eliminate all test invoices, 
estimates, and so on. When you are starting out you might give everyone the ability to 
override prices. As you continue to modify your pricing and are confident that your 
assumptions are complete, restrict the ability to override prices. 

Printing price lists 
Now that you have completed your pricing assumptions you should test them by printing 
and reviewing printed price lists. PrintSmith provides several ways to print price lists. Price 
lists can be printed for all printing jobs, copy jobs, papers, and so on. Use the PrintSmith 
powerful price book generators to print price lists. On the Pricing menu, click Generate 
Price Book. 
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Customer Information 
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Overview 
Information about your customers, or accounts, is another key part of your PrintSmith 
system. PrintSmith manages a great deal of customer information. It identifies who the 
customers are; where they are; sales this year, last year, this month, money owed, cash, 
check, and charge; and so on. Before PrintSmith can manage the information, you need to 
enter your customer data. 

Tips  You only need to enter customers that have an outstanding account balance to 
get started; add other customers as needed. 

 If you have your customer list in ASCII format, PrintSmith can import that data. 
Contact Customer Support for information on conversions and imports. 

Prospect information can also be imported into PrintSmith. Use the Import Prospect 
Template button on the Settings tab. For information, see page 229. Once in PrintSmith, 
prospects are easily converted to customers. 

Note  PrintSmith can handle over 60,000 customers and prospects. You can search for 
customers by name, account number, reference number, phone number or part 
of a phone number, and master billing account. 

For more information about accounts, see the PrintSmith Reference Guide. 
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Accounts 
On the AR menu, click Accounts to open the Account Picker window.  

 
Note Your new installation of PrintSmith will not have any customers other than 

<<<WALK-IN>>>.  

To create a new customer  
1. In the Account Picker window, make sure that Customers is selected.  

2. Click New to open a blank Customer window. 

Note  You can also use the shortcuts Command+a on the Macintosh or Ctrl+A 
on Windows. 

3. Since no customer was selected in the Account Picker window, PrintSmith 
assumes you are entering a new customer. The window title reads Customer: 
New Account. Click the Address tab. 

4. Complete the Address tab and other tabs as described below. 

5. Click File to save the information about the customer. 

6. Repeat this process for all your customers. 

Tip You can enter customers at any point in time. It is a great exercise to spread out 
over several sessions when you are first setting up PrintSmith. 
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Address tab 
Use the Address tab to provide the customer’s name or title, external reference number, 
external accounting ID, invoice and statement addresses, and associated contact 
information. 

 
You need to enter information only in the Name field to create a customer account; all the 
other fields are optional.  

Acct # 
 

Shows the account number that PrintSmith assigned to the customer. The 
only place you might see account numbers without account names is in the 
Register Tape. To see a report of account numbers and names, choose 
Reports > Customer List.  

  

Drag to 
expand  
window 



Customer Information 

 

 
Page 223 

Name 
 

Enter a unique name for the customer account. This lets you track customers 
by their last name but still show the correct name on the invoice. For 
example, for a customer named Dr. John Smith, you might want to enter the 
account name as Smith, Dr. John so it is easy to find in the account list, but 
have the address as Dr. John Smith as that is what Doctor Smith will see on 
invoices and statements you create with PrintSmith.  
You cannot change the name of account 1; it is always listed as <<< WALK - 
IN >>>. You can change the name of any other account at any time. 

Tip  To find an account with a particular account number, enter / or ? 
followed by the account number in the Name field and press Tab. 
If an account with this number exists, it is displayed in the 
Customer window.  

External Ref # 
 

If necessary, enter an account ID for a system outside of PrintSmith such as 
a different accounting system. External Ref # is simply a text field into which 
you can enter anything you want. You can search the customer list for a 
reference number when selecting customers. You can also include the 
number on documents, job tickets, and statements. 

External 
Accounting ID 

For future use. If a third party accounting package is used, enter an external 
accounting ID. This allows synchronization between PrintSmith and the 
external accounting package. 

Invoice Address 
and Statement 
Address 
 

Each account can have two separate addresses: invoice and statement. The 
invoice address is copied to each document when the account is assigned. 
Documents can use either or both addresses when they are printed. 
Likewise, either address can be used when printing statements. 
The Address tab includes fields for the invoice address and contact and 
statement address and contact. When you tab from the Name field, 
PrintSmith automatically copies the name to the first line of the Invoice 
Address field on a new account. You can change it as necessary when you 
click the Invoice Statement field and complete the window that opens. 
Click the Statement Address field to provide the billing address where 
statements will be mailed. This address can optionally be included on the 
invoice or estimate. 
If the invoice and statement address are identical, leave the Statement 
Address field empty. PrintSmith copies the invoice address to the 
Statement Address field when you click File to save the account. 
When you create a new customer account, the information in the Invoice 
Contact and Statement Contact fields is used to automatically create 
contacts assigned to the account. This is the only time you can create 
contacts from the Customer window. If you change the contact data in this 
window, the contact record is also changed.   

Note  Include the contact e-mail address in the contact fields. The 
PrintSmith e-commerce system requires contacts to have a valid 
e-mail address so they can be Web-enabled (able to use 
e-commerce). 
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Contact List 
 

After you enter contact information, this field is available under the Invoice 
Contact and Statement Contact fields. Use the Contact List field to select 
the default contacts for the invoice and statement contacts.  
The last item in the Contact List field is always the Edit command. Click 
Edit to edit the default contact. Unless you need to modify marketing 
information for a contact, it is generally much easier to edit default contacts 
from the Customer window. 

- / + Click - to delete the selected contact. After you click Yes to confirm the 
deletion, the next contact becomes the default invoice and/or statement 
contact. 
Click + to add a new contact for the account. The Contact window opens so 
that you can provide information about the contact.  

Note You can create a customer account without an assigned contact. In fact, the 
“walk-in” account cannot have any contacts. EFI, however, strongly recommends 
always creating a contact at the same time as you create the customer account 
so that mailing lists, labels, reports and other marketing activities include contact 
information. Once a contact is assigned to a customer, the assignment is fairly 
permanent in the sense that the customer must have an assigned contact. You 
can change the default contact and you can select the same contact for both the 
invoice and statement contacts, but you cannot change an account so that it no 
longer has a contact assigned.  
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Credit Control tab 
Use the Credit Control tab to set credit limits, finance charges, account type, and account 
status. 

 

Credit Limit 
 

Enter the maximum dollar amount a customer can charge to his or her 
account. The system credit limit is used by default. (You set the system limit 
in the Credit /Defaults preference panel. See page 77.) If there is no system 
credit limit, and you leave this field blank, Unlimited Credit is displayed to the 
right of the field.  
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Due Days from 
Posting 
 

Enter the number of days PrintSmith should add to the current date to 
calculate a due date for an invoice that is picked up and posted in the cash 
register. If you do not provide a value here, PrintSmith uses the value in the 
Number of days due before field in the Estimator Printing preferences. The 
due date is included under the amount due in the totals section of the invoice 
if the Show payment due date check box is selected in the Footer document 
preferences. For information about document preferences, see the PrintSmith 
Reference Guide. 
shows the average payment period for the customer. The history detail shows 
the due date on items posted. 

Avg. Days to 
Pay 

Shows the average time it takes the customer to pay an invoice.  

Monthly Finance 
Charge Pct 
 

Enter the percentage for calculating finance charges during statement 
generation. If this field is 0, the system default finance charge rate is used (as 
defined in the Credit/Defaults preference panel). When the system default 
rate is used, it is displayed to the right of this field as shown in the figure 
above.  The system default rate is used unless you enter a different rate here 
or select the Never calculate finance charges check box. 

Note  This is the actual rate used each time you calculate finance charges 
when generating statements. It is not an annual rate. 

Finance 
Charges YTD 

Shows the total amount of finance charges posted to the account in the 
current year. 

Never calculate 
finance charges 

Select this check box if you never want to generate a finance charge for this 
account and there is a default system finance charge defined.  

Current Balance Shows the total amount owed to you by this customer, including merchandise 
charges or POS charges. 

Automatic 
Discount 
Percent 
 

Enter a percentage only if you want this customer always to be given a 
discount or a markup. To set up a markup, enter a negative percentage. This 
adds money to each invoice created for the customer. In contrast, a discount 
percentage provides customers with a percentage off each invoice.  

Automatic 
Discount Dollars 

Enter a discount in dollars. The discount is applied each time you create an 
invoice for the customer. 

One-time 
discount 

Select this check box to apply a one-time cash discount (Automatic 
Discount Dollars) to the customer, for example, if you are offering a special 
for first-time customers or promoting a new service. 
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Account Status 
 

Describes the current status of the account as of the last aging (although you 
can change it here on a case by case basis). Typically, accounts can be 30, 
60, or 90 days past due according to three aging classifications whose 
standard values are 30, 60, and 90. You can change these aging 
classifications as needed in the Aging Periods preference panel. See page 
78. 
• New . When an account is first created, and has never been aged, it is 

considered a new account. 
• Current. An account is current if all amounts owed are within the 

allowable limits. 
• Past Due. The account has open items picked up more that 30 days 

ago. (Aging periods can vary; see page 78.) 
• Delinquent. The account has open items picked up more than 60 days 

ago. 
• Inactive. As of the last aging, the customer had not ordered anything 

within the inactive period specified in the Credit/Default preferences 
panel. The system checks to see if the customer has had any activity. 
Estimates, invoices, or payments made cause the customer to be active. 

• Frozen. The account aging process can automatically freeze accounts 
with open items picked up more than 90 days ago. Once an account is 
frozen, no more invoices can be created and no charges can be 
accepted. An account is normally unfrozen manually or automatically 
during the aging process. 

You can choose the account status or allow PrintSmith to update and 
maintain the account status. All customers have a status of New  when you 
first create them. PrintSmith updates this information when account aging 
takes place. EFI recommends that you ignore the Account Status settings 
while you set up the system. 

Account Type 
 

Determines what types of transactions are accepted for this account. 
• Full Deposit. When an invoice is opened or filed with a balance due, a 

reminder notice is displayed to remind you that this customer must pay 
in advance. This notice can seem obnoxious but serves as a warning to 
proceed with caution. In addition, cash register transactions (POS) must 
be paid in cash. Deposits can be paid with cash, checks, or credit cards. 

• Cash Only. The customer must pay with cash. Checks and credit cards 
are not accepted. Charges are not permitted to accounts receivable. 

• Cash/Check/Credit Card. The customer must pay with cash, check, or 
credit card. Charges are not permitted to accounts receivable. 

• Charge Account. The customer may charge to his or her account. 
There are no restrictions on payment type. 

• Credit Card on File. For a trusted customer, a credit card can be kept 
on file and then used when picking up an invoice for that customer. You 
can only select Credit Card on File if you are using integrated credit 
card processing in PrintSmith. For more information, see the PrintSmith 
Secure Credit Card Processing Guide.  

When you create a new account, the Account Type automatically defaults to 
Cash/Check/Credit Card, but you can change this as necessary.  

 

 



EFI PrintSmith |  Setup Guide 

 

 
Page 228 

Specifying customer discounts 
You can give two types of discounts to your customers: 

• An automatic discount is expressed as a percentage or cash amount, and is 
calculated each time you create an invoice for the customer. 

• A one-time discount is expressed as a cash amount only. Use a one-time 
discount if, for example, you are offering a special for first-time customers, or 
featuring a new service as part of your business.  

To set up a one-time discount 
1. Create the customer account, if it does not already exist. 

2. On the Credit Control tab for the customer account, select Dollars under 
Automatic Discount and enter the cash amount of the discount. 

3. Select the One-time discount check box. 

When you create an invoice for the customer, you receive a message about the 
discount asking if you want to apply it. 

 
4. Click Yes to apply the discount or No to deny the discount. If you click No, the 

discount remains in the customer account. If you click Yes, the discount amount 
is cleared from the Credit Control tab. In addition, if you click Yes, and the 
discount amount is greater than the invoice amount, you are asked if you want to 
save the remainder of the discount to be applied to the next invoice. 
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Settings tab 
Use the Settings tab to control or modify how the account is used throughout the system. 

 

Select Master 
Account 
 

Click this button to select a master account for the account. Any account that 
is not a subaccount can be selected as a master account. Alternatively, enter 
the account number in the field next to the Select Master Account button.  
Master accounts are very useful for companies with multiple contacts. For 
example, you might have three departments at Xerox. All three do business 
with you, but payment comes from Xerox AP. In this case you would set up 
four accounts, with the three departments all having Xerox AP as the master 
billing account. 

Sales Rep 
 

Select a sales representative. (Use Table Editor to maintain the list of 
representatives in the Sales Rep table.) This information is copied to the 
Sales Rep field in the Account Info window in the Estimator when the 
account is assigned to a document. 

Name of 
master 
account 

Click to 
see 
format 
required 
in 
import 
file 

Click to 
import 
customer 
data 
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Business Type 
Code 
 

Use this four-character field to sort your customer list by SIC codes or ABC 
method of ranking. The Customer List report and Mailing Labels both provide 
options for sorting by business type.  

Ship Via 
 

Select the default shipping method for the customer. The label of this field is 
the same as the title of the Ship Via table. If you change the title of the table, 
the label of the field changes accordingly. This holds true on invoices as well, 
so you can use this for something entirely different if appropriate for your 
business. 

PO Number Enter the purchase order number, if required; it will be included on all new 
invoices. 

PO required on 
Invoice 
 

Select this check box if the customer requires a purchase order. When the 
check box is selected, PrintSmith warns you to enter a purchase order 
number when creating an invoice, but does not prevent the invoice from 
being created. The invoice cannot be picked up, however. Until you enter a 
PO number, the warning is also displayed when an estimate is converted to 
an invoice, as well as each time the document is opened. 

Do NOT generate 
statements 
 

Select this check box if do not want statements generated automatically for 
this account. (You can still generate a statement for any account by 
specifically indicating that account.) If a statement would offend a customer, 
select the Do NOT generate statements check box for the customer. This 
option is useful for sub accounts of a master billing account that never 
respond to a statement. 

Account Is 
commissioned 

Select this check box so you can generate commission reports with the 
Report Writer.  

Always file 
originals 

Select this check box so that invoices for the account indicate that you are 
filing originals (typically artwork). You can change this setting when you 
create an invoice. 

Default Invoice 
and Default 
Estimate 

Select the document preference to use when creating invoices and estimates 
for this account. For example, if you want to hide a markup, you can select a 
document preference that accomplishes that. 

Tax Table  
 

Select the tax table you want to use for the account. This tax table is known 
as the parent tax table and is automatically used on invoices for the account 
unless you change it at the invoice level. In addition, the parent tax table is 
used by default for charge definitions, unless you select a different tax table 
(in the Preset Info window). 

Tax Code 
 

Use tax codes to categorize sales for tax reporting purposes. If a particular 
customer must be coded in a particular way, enter the tax code here and 
PrintSmith copies it to the document when this account is assigned to the 
document. 

Note  There are no rules or requirements in using tax codes. The only 
function of a tax code is to create a separate line in the tax detail 
report within the same tax table. 

Resale 
 

Enter the customer’s tax exemption ID or license number. An entry in this 
field only serves to record the tax or license number in the account and on 
documents created for this account. 

Note  The only way to make an account tax exempt is to select the Tax 
Exempt check box. 
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Certificate 
Expires 

Enter the date (if any) the customer tax exempt certificate expires. 

Tax Exempt Select this check box so that documents created for this account do not have 
sales tax applied. 

Security level of 
this account 
 

Enter a security code to prevent access to the account by users who 
otherwise have access to AR > Accounts, AR > Post Payments, and 
Reports > Account History. Accounts are only accessible with these 
commands by users whose access level is equal to or greater than the 
access level in the account. 

Note  Accounts can be assigned to documents even if a user’s access 
code prevents him or her from viewing account history and the 
customer account. 

Import  
 

Click this button to build a database of customers based on criteria of your 
choice. It is useful for building lists of inactive customers, mass mailings, and 
special announcements about your shop. 

Import Prospect 
File 
 

Click to review the format required when creating an ImportProspectFormat 
file. The expected order of fields is: 

“Full Name”, “Street 1”, “Street 2”, “City”, “State”, “Zip”, “Contact 
Name”, “Phone Number”, “Fax Number”, “External Reference 
Number”, “Sales Rep. or Empty”, “Resale Number or Empty” 
<return> 

The file can be in comma-delimited format as shown above or in tab-
delimited format. 

Preset up to 10 
charges 
 

Click Add Charges to apply up to 10 preset charges to accounts for invoices 
and estimates and another 10 preset charges for jobs. The number of 
charges you add is displayed in the Add Charges button. 
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Sales Info tab 
The Sales Info tab contains sales statistics. You can use this tab to change the sales 
representative (which you can also do on the Settings tab) and to perform an instant 
aging of the account. 

 

 

Balance 
 

Shows the account balances as of the last aging. You can update these 
balances at any time by clicking Age Now . 

Account Status 
 

Show the current status of the account. Normally, PrintSmith sets this 
automatically as part of the aging or statement generation process. You can 
also change the status manually on the Credit Control tab. (See page 225.) 

POS Charges 
 

Shows the outstanding balance of Cash Register transactions charged to 
this account. Use POS > Post POS Charges to convert this balance into an 
open item. 
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Current Balance 
 

Shows the total amount (including merchandise charges) owed to you by the 
customer.  

Age Now 
 

Click this button to perform an instant aging of the account using the current 
date as the aging base date.  

Sales Ranking Shows the standing of the sales volume of this account relative to your other 
accounts based on the last time you ran and saved the Account Ranking 
report by sales for the year.  

Note  EFI recommends you print and save the sales ranking at the end 
of each year. 

Sales Rep. Enter or edit the sales representative. This information is repeated on the 
Settings tab and copied to the Sales Rep field in the Account Info window in 
the Estimator when the account is assigned to a document. 

Sales Statistics 
 

Shows the sales statistics for the customer. These include invoices picked 
up that do not include tax. 
• Sales. The total sales volume for this account in the current month, 

current year, and prior year. 
• # Orders. The number of invoices for this account in the current month, 

current year, and prior year. 
• Average Order. The average amount of all invoices in this account in 

the current month, current year, and prior year. 
• Quotes: Orders. The ratio of estimates to orders. This helps to identify 

accounts for which you are continually entering estimates but rarely 
getting jobs. The number of estimates may not be exact. PrintSmith 
counts an estimate only when you are filing a new estimate. If the 
account is in use in another window or Workstation, it will not be 
counted. Changing the account on an existing estimate is not included 
either. 

Created Shows the date the account was entered into PrintSmith. 

Last Billed Shows the date a statement was last generated for the account. 

Last Payment 
 

Shows the date the last payment was received for the account and entered 
with AR > Post Payments. 

Last Aged Shows the date the account was last aged. 
Last Invoice Shows the date the last invoice was created. 

Last Estimate Shows the date the last estimate was created. 

First Invoice Shows the date the first invoice was created. 
First Estimate Shows the date the first estimate was created. 

Estimates 
Won/Lost 

Shows the ratio of won to lost estimates. PrintSmith tracks this information 
automatically. You can change the ratio on a case-by-case basis if you are a 
member of the System Admin security group. To change the ratio, enter the 
number of wins, : (colon), and the number of losses, for example, 25:5. You 
can use Report Writer to generate an automatic success report at a regular 
interval, for example, monthly. 
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Log tab 
The Log tab provides access to the customer contact log.  

 
On the Log tab, you can record comments for the customer account. You can use this tab 
for anything you want. Just enter your comments and click Add. Entries are also 
automatically logged when text is entered in the Notify Customer window (in the Pending 
Document window). These entries also include the text (Notified).  

To delete an existing entry, click it and then click Delete.  

To print the log, click Print. 

Note  Only the last 500 entries per customer account are shown in the log. 
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Notes tab 
Use the Notes tab for notes that are displayed in different contexts. 

Important  These notes are all designed for small blocks of text (up to 2,000 characters) 
for statements. Avoid using these notes for lengthy messages or for record 
keeping; use the Log tab instead (see page 234). 
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Account selection 
notice 
 

You can display notes for a customer when creating an estimate or invoice. 
Additionally, these notes are placed on the invoice or estimate automatically. 
Enter notes for one of two purposes: 
• To notify the user of something special about the account whenever the 

account is assigned to a document. 
• To place these notes in the special instruction field of a document 
When you copy a document for an account or assign an account to a 
document, a window opens displaying this notice and asks if you want the 
text copied in to the Special Instructions field. 

Note  You can enter up to 2,000 characters in this field. 

Notes to insert in 
each job 
 

Enter text that you want automatically copied to job ticket notes whenever a 
new job is created in a document to which the account is assigned. It is not 
copied to job ticket notes for existing jobs so assigning the account to a 
document that already has jobs will not insert this text in the job ticket notes 
of those jobs. 
Notes to insert in each job are printed on all job tickets for this customer only. 
You can use these notes for accounts whose jobs are always handled in a 
certain way. For example, you may have a customer for whom you will not 
start production unless a proof was signed, or to whom you always return the 
artwork. You can make note of this here and PrintSmith automatically 
includes these notes on the job ticket. 

Notice to place on 
statements 
 

Enter text that you want to include on statements generated for this account 
(unless this feature is disabled in the Statement Generator). 
You can enter text to customize collection notices for an account or to 
remind a customer of upcoming repeat orders. 
Notes to place on statements are one of three custom notes that can be 
included on statements. This note would be specific to the customer account 
and would appear only on this account statement. 
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Marketing tab 
Use the Marketing tab to record useful marketing information. Much of the information 
can be used to design a marketing campaign any way you see fit and to generate reports 
with Report Writer.  

 

Customer 
/Prospect 

Indicate whether the account is a customer or prospect account. If a 
customer cannot be changed to a prospect, the selections are unavailable. 
The rules for changing a customer to a prospect are as follows: 
• The account has a balance or an open item in history. 
• The account has pending invoices. 
• The account is a master account or a sub-account. (Note that this 

relationship only works with customers.) 
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Personal Account 
 

Select this check box to identify an account for a person rather than a 
company. 
For example, if you have an account for Tom Jones, and Mr. Jones prints 
Christmas cards and personal stationery, the account should be a personal 
account. An account for a Dr. Jones would usually not be marked as a 
personal account as the relationship is probably a business to business 
relationship. This setting is used when creating mailing labels to segregate 
personal accounts for targeted mailings. It is also available in the Report 
Writer. 

Do Not Mail 
 

Select this check box to remove the account from labels or mail merge files 
generated with the Mailing Labels command. You can also use this setting 
to control the output of the Report Writer. 

Number of 
Employees 

Enter the number of employees in the company to help you target 
companies based on their size. 

Annual Revenue 
 

Enter the annual amount of revenue of the account or your annual budget 
target expected from the account. This information can help target 
companies based on their revenue stream. 

Business Type 
 

Select the type of business the account represents. This information comes 
from the Business Type table. The information stored comes from the ID of 
the table element, not the text. As a result, you can change the text in the 
table and immediately see this change reflected in all accounts. 

Marketing Dates 
 

Enter up to five dates for any customer-related purpose. The first date is 
identified as Follow-up, but  this is just a suggestion of how you might use 
this date. To make best use of the dates, label them accurately. The label for 
each date is stored in the Marketing Date Labels table. (Use Table Editor to 
maintain this table.) 

Marketing Tags 
 

Complete up to 10 fields that, like Business Type, store the ID of the 
associated table. The Lead Source fields both use the same table. The 
remaining fields each have their own dedicated table whose name matches 
the label of the field, for example, Mailer Type or Sport Interest. (Maintain the 
contents of these tables with Table Editor.) 

 



Customer Information 

 

 
Page 239 

Templates tab 
Use the Templates tab to associate certain shared templates with the account so they are 
available when you create an invoice, estimate, or job for that account. This saves you 
from searching through all the shared templates. 

By default, a shared template you associate with an account is available to all 
Workstations when they work with that account, but you can restrict a template to a 
particular Workstation if only that Workstation works with the account and particular 
template.  

Tip When you want to use a template that is associated with an account, select 
Invoice > Create from Templates > Invoice from Account/Workstation 
Shared Templates (or Estimate from Account/Workstation Shared 
Templates). 

 

Click to add a 
shared 
template to 
account. 

Enter a 
Workstation 
ID to restrict 
to certain 
Workstation. 
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To associate a shared template with an account 
1. Click +. The Select a Shared Template window opens. 

2. Select a template and click Select or double-click the template. The template is 
now listed on the Templates tab in the Customer window. 

To remove a shared template from an account 
1. Select the template on the Templates tab. 

2. Click -. The template is still listed on the Templates tab, but has a red line 
through it. 

To associate a shared template with a Workstation 
Each Workstation in a multi-user system is identified by an ID. This ID is shown in the 
Network Setup preferences panel (Admin > Preferences > System > Network Setup). 
This is the ID you must specify if you want to restrict a shared template used for a 
particular account to a particular Workstation. Normally, the templates associated with an 
account are available to all Workstations. 

If necessary, enter the Workstation ID in the Register ID# column. 
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WEB tab 
Use the WEB tab if you are using the PrintSmith e-commerce solution to register the 
account. For more information, see the PrintSmith Site documentation. 
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Contacts 
Although you can manage default contact information from the Address tab in the 
Customer window (see page 222), you may want to specify marketing information for 
default contacts or create additional contacts, perhaps with different addresses.  

To manage contacts 
1. On the AR menu, click Contacts. The Contact Picker window opens.  

2. To edit an existing contact, select it and click Select; to create a new contact, 
click New.  

 
Tip You can also create new contacts from the Account Picker window (AR > 

Accounts) by selecting Contacts and clicking New. 

Click New to 
create a new 
contact. 
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Address tab 
The Address tab of the Contact window is the main data entry area for all contact 
information.  

 

ID # 
 

Shows a unique identifier for the contact record. PrintSmith automatically 
assigns this number when you create the contact. 

Name 
 

Enter the name of the contact, typically last name followed by first name, for 
example, Jones, Amy. This is information is used to place the contact in 
alphabetical order in the contact list and to display the contact in the Contact 
List field on the Address tab in the Customer window. It is always derived 
from the last name and first name of the contact. You can change this name 
if you want, but EFI does not generally recommend it because if you change 
any of the contact data in the Contact window, the text in the Name field is 
replaced by the last and first name of the contact. 

Acct# Shows the number of the customer account to which the contact is assigned. 
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Account 
 

Shows the name of the account to which the contact is assigned. Below the 
name the type of the contact is displayed. If nothing is displayed, the contact 
is assigned to a customer but is neither the shipping nor the billing contact. It 
may also be <shipping contact>, <billing contact>, or <default contact>.  
A <default contact> means that the contact serves as both the shipping and 
billing contact. If the contact is not yet assigned to a customer or prospect, it 
is identified as --- not assigned---. You may also see -- MISSING 
CUSTOMER ACCOUNT --- if the account to which the contact is assigned to 
was deleted. Contacts not assigned to accounts cannot be used in the 
Estimator. 

Sales Rep 
 

Select the sales representative assigned to the contact. (This overrides the 
sales representative assigned to the account.) It is useful for report 
generation. 

Created Shows the date that the contact record was initially created. 

Last Used Shows the date the contact was last used in the Estimator. 

Change Account 
 

Click the button to change the account for the contact. This button is 
unavailable when a default contact is selected. PrintSmith always tries to 
ensure that each account has at least one contact so that marketing 
activities that are centered on contacts do not inadvertently leave out 
accounts because there is no contact. 
You can only change the default contact for an account on the Address tab 
in the Customer window. (See page 222.) Normally, you create a default 
contact when you create a customer account.  

Use Contact 
Address 
 

Select this check box so that you can enter an address that is specific to this 
contact. If you select a contact with a separately defined address in the 
Estimator, the contact address is used instead of the account address. 
Default contacts always use the account address, even if you set them up 
with a separate address. 

Shipping Address 
 

Enter up to 100 shipping addresses for the contact. When you create an 
invoice and select a contact, all of the shipping addresses for the contact are 
available from a list in shipping charges.  
To organize the Shipping Address list, simply drag the addresses in the 
order you want. Use the New , Delete, and Edit buttons to control the content 
of the list. 
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Marketing tab 
The Marketing tab is similar to the Marketing tab for a customer account, but applies to a 
contact. Use this tab to design a marketing campaign. The information on this tab, 
together with Report Writer, can result in some powerful reports.  

 

Personal 
Account 
 

Select this check box to identify a person rather than a company. For example, if 
you have an account for Tom Jones and Mr. Jones prints Christmas cards and 
personal stationery, the account should be a personal account. An account for a 
Dr. Jones, on the other hand, would usually not be marked as a personal 
account as the relationship is probably a business to business relationship. This 
check box makes it possible to segregate personal accounts for targeted 
mailings and in reports generated by Report Writer. 

Do Not Mail Select this check box to remove the contact from labels or mail merge files and 
to control the output of Report Writer. 

Marketing 
Dates 
 

Enter up to five dates that can be used for any purpose. The first date, Follow 
up, is just a suggestion to give you an idea how the date can be used. To make 
best use of the dates, label them accurately. The labels for each date are stored 
in the Marketing Date Labels table which you can edit with Table Editor. 
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Marketing 
Tags 

Use these ten fields to provide marketing information about the contact. The 
labels of the fields correspond to the names of the tables that include the 
relevant information.  

Campaigns tab 
Use the Campaigns tab to associate a contact with advertising campaigns that you have 
created. You can associate individual campaigns with a contact or associate a group of 
campaigns (known as a grade) with a contact.  

 
• To apply a campaign: Click the Apply column to the left of the campaign. A 

check mark indicates a campaign is associated with the contact. 

• To apply a grade: Click Apply Grade. In the window that opens, highlight the 
grade and click Select. A check mark is displayed in the Apply column for all the 
campaigns included in the grade. 

Note   If you apply a grade of campaigns, you can remove individual 
campaigns within the grade by clicking the Apply column so the check 
mark is removed. (This does not change the grade, just the campaign 
selections for the contact.) 
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• To view or edit campaigns and grades, click Edit Campaigns. The Campaigns 
window opens. 

Note For additional information on creating mailer campaigns, see the PrintSmith 
Reference Guide.  

Credit Info tab 
Use the Credit Info tab to save credit card information for a contact.  

Note To complete this tab, you must be using integrated credit card processing in 
PrintSmith. For more information, see the PrintSmith Secure Credit Card 
Processing Guide.  
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Web tab 
This tab is displayed when you use the optional PrintSmith Site e-commerce product. The 
information in this window is used to manage your contact’s e-commerce account. For 
more information, see the PrintSmith Site Administrator Guide.  

 

Adding Contacts to Accounts 
Here are three ways to add contacts to any account. 

While creating a document (invoice or estimate) 
1. While creating a document (invoice or estimate), select the customer account in 

the Account Picker window. 

2. In the Account Info window (that opens automatically), click New to the right of 
Contact List. The Edit Contact window opens. 

3. Enter the contact information and close the window.  

4. The contact list now includes **NEW CONTACT***. Click OK to create the 
contact and add it to the account.  
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In the Account window 
1. Select AR > Accounts. The Account Picker window opens. 

2. Double-click the account to which you want to add contacts (or click the account 
and click Select).  

3. Click the Address tab and click Add near the bottom of the window. The Contact 
window opens. 

4. Provide information about the contact and click File.  

In the Contact window 
1. Select AR > Contacts. The Contact Picker window opens. 

2. Click New. The Contacts window opens. 

3. Enter the contact information and click Change Account to assign the contact to 
the appropriate account. 

4. Click File to save the contact. 
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Searching for a Customer 
You may have hundreds of customers. To help you find a particular customer without 
scrolling through a very long list, you can search for a customer in the Account Picker 
window. 

 
1. Select Customers at the top of the window. 

2. Click the tab for the way you want to search, for example, by Name or Acct #.  

3. Enter the data you want to find and click Find.  

4. To find the next occurrence, click Find again. To find the previous occurrence 
hold down the Shift key and click Find Next. 

Found items are highlighted in the list above and the Select button is highlighted.  

5. Open selected items by pressing Enter, clicking Select, or double-clicking an 
item. 

Prospects 
In PrintSmith, customers are persons for whom you have created invoices. Prospects are 
persons who have not done business with you, but you want to turn into customers. When 
an invoice is created for a prospect, that prospect is moved from your Prospects list to 
your Customers list. This differentiation between customers and prospects helps to keep 
your customer database populated with only true customers. As customers become 
inactive, they can automatically be turned into prospects based on account aging. Your 
Customers list and Prospects list are both accessible from the Account Picker. 

When you create an invoice (Invoice > Create Invoice) you start by selecting a customer 
or prospect.   

Enter the data 
you want to find. 
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Glossary 
Account. A customer.  Multiple contacts can be assigned to the customer account, and a 
customer account can be assigned to a master account. Select AR > Accounts to 
manage accounts. 

Access group. A security setting that controls which PrintSmith commands are available 
to members of the group. Access groups are defined by selecting Admin > Security 
Setup and are assigned to users by selecting Admin > User Definitions. 

Bleed. The extension of a printed image beyond the final trim size of the page. 

Brokered. Jobs that are sent out for production. 

Caliper. Paper thickness in thousandths of an inch. 

Charges. The pricing associated with printing or duplicating a job. Charges can be 
grouped in different ways, for example, pre press, bindery, or production and are defined 
by selecting Pricing > Charge Definitions. 

Contacts. Individuals assigned to an account. Multiple contacts can be set for an account, 
and selected from the Contact List field in the Customer window. Select AR > Contacts 
to manage contacts. 

Costing method. One of four different costing methods (No Cost, 100% Cost, Unit Cost, 
or Time and Materials) that can be applied to charges from the Charge Definitions 
window. 

Cut/100. A cut charge for each 100 parent sheets. Select Pricing > Stock Definitions to 
set a cut charge. 

CWT. Hundred weight price. Select Pricing > Stock Definitions to specify the CWT. 

Document. An invoice or estimate. 

Folio edge. The amount of space reserved on an edge of the run sheet for a booklet 
maker. Used when folding signatures to offset the imposed image, leaving one edge of the 
folded signature overhanging the other. 

Global preference. A preference that is set on the PrintSmith Master computer that 
affects all connected Workstations.  

Gripper edge. The amount of space required on one feed edge of the run sheet for the 
press to pick up the paper. The size of the gripper edge normally comes from the press 
definition. If not specified there, the Paper Calculator preference panel is used. This 
amount can be changed on an individual job in the Paper Calculator window. 

Gutter. The space between multiple images on a sheet, most often used to add space in 
a folded piece. 

Impression. The set of images produced by one rotation of a plate cylinder. 

Interpolation. The estimation of a value between two known values. 
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IP. Internet Protocol address, a 32-bit value that is unique to each network device. 

List/M. Used in stock definitions to specify an additional price per thousand sheets for use 
with the list pricing method, since list pricing does not factor in stock cost when generating 
a price. The amount (plus or minus) entered is divided by 1,000, multiplied by the quantity 
ordered, and added to the price of the job. 

Local preference. A preference that only affects an individual PrintSmith Workstation, 
and which is not changed when the pricing system is updated.  

M weight. The scale weight in pounds of 1,000 sheets of paper of a given size. Select 
Pricing > Stock Definitions to enter M weight. 

Master account. An account that is used to link several sub-accounts. For example, if 
three departments within a company do business with you, but all payment comes from 
the Accounts Payable department, set up four accounts and set the Accounts Payable 
department as the master account. You set the master account on the Settings tab in the 
Customer window.  

Master. The main PrintSmith computer in a multi-user system. The Master can run 
standalone, or other Workstations can connect to it. 

Micron. A unit of measurement for the thickness of metric stocks. A micron is one 
millionth of a meter. 

On. The number of originals on a run sheet. 
Pending list. The list of new invoices and estimates. This window lets you manage recent 
estimates, work in progress, and completed jobs awaiting pickup or delivery. To open the 
Pending List window, select POS > Pending Document Window. 

Ply. Traditionally used to indicate thickness of card or chipboard. A sheet of 6-plyboard is 
0.024 inch thick (multiply the ply value by 3 and add 6 to that result). 

Point. A unit of thickness for paper equaling 1/1000 inch. 

Prospect. Someone who has not done business with you, but you want to turn into a 
customer. 

Sheets. For a non-book, the number of originals; for a book, the page count divided by 
two. 
Speed table. The speed of the press based on quantity produced. 

Stock. Material to be printed. 

TCP. Transmission Control Protocol. A transport layer protocol that is part of the TCP/IP 
protocol suite and provides a connection-based, reliable data stream. 

UP. The number of times an original fits on a run sheet. 
Washup. The process of removing ink from a press by washing the rollers and blanket. 

Waste chart. A calculation of the amount of spoilage based on run length. Select Pricing 
> Waste Chart to open the default waste chart.  
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White space. The unused part of the run sheet when the image area is smaller than the 
run size. White space is set in the Paper Calculator. 

Work and tumble. A technique in which, after one side of a sheet is printed, the sheet is 
turned over (from the gripper to the tail) using the same guides and plate for the second 
side. 

Work and turn. A technique in which, after one side of a sheet is printed, the sheet is 
turned over (from left to right) using the same side guides and plate for the second side. 

Workstation. In a multi-user system, a PrintSmith computer that connects to a PrintSmith 
Master.  
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